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WHILE YOU ENJOY this issue—filled with the latest
in portable media players, and the other goodies
that come with Digit each month, I would like you to
spare a moment to consider the security of our
country’s borders.

The US has just erected a ‘virtual’ fence along a
portion of its border with Mexico. The project cost
$20 million to complete, and consists of sensor
towers and advanced mobile communications. The
plan is to extend this ‘virtual’ fence to other parts of
the border as well.

This is the future of defence technology. Why
doesn’t India embark on a similar project to secure
its eastern and western borders? 

Because of its long and porous border, our
country faces the problems of illegal immigration
from the east and militant infiltration from the
west. High-tech surveillance would certainly help
solving these problems. Unmanned aerial vehicles
and computer-controlled radar systems would go a
long way in boosting security.

The question that might be asked is whether this
technology can justify its costs. To answer that, India
is already paying a heavy price for not being able to
keep illegal immigration and infiltration in check.
The benefits of securing our borders through tech-
nology would far outweigh the costs involved in
such a project.

A team from India should visit the US installation
and get a few tips from the American department of
Homeland Security to understand how the high-tech
system operates. Our government can then float a
global tender to invite bids from major players—like
Boeing in the US’ case—to set up this virtual fence.

The reason I brought this up is because tech-
nology fundamentally changes almost every facet of
a particular situation. Using technology lets you
think outside the box, and then ask crucial ques-
tions on a particular issue that might never have
been asked in the first place.

Remember, India is a prime target for terrorism,
and to fight this global war on terror, it needs to beef
up its technology arsenal first.  Several strategists in

the US are already welcoming that country’s
increased spend on security, going to the extent of
predicting that a refurbished, high-tech Homeland
Security could be the best thing to happen to Silicon
Valley in years.

Will India be able to get its tech security act
together? Being a global IT powerhouse, it is only a
matter of time—according to my opinion—before pol-
icymakers chart out a tech roadmap to prepare our
country against hostile alien attacks.

editor@thinkdigit.com

Editorial

Sujay Nair Editorial Director

Secure Our Borders!

“The benefits of securing our borders
through technology would far

outweigh the costs...”
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FREE
Quadratis
A simple and
straight-forward
Tetris remake
that features
something the others don’t—bombs

Vdrift (Ubuntu)

VDrift is a driving simulation game
made with drift-racing in mind,
powered by the Vamos physics engine

Zirconia 2: Battle
Zirconia 2: Battle is a 2D shooter in
which you battle
a computer
opponent
indirectly. The
screen will be
split: with you on
the left side and your opponent on
the right. When the match begins,
enemies which do nothing (except
move) will spawn. Players must
defeat these enemies and collect
coins that they drop, of three
different colors

DEMOS
Company of Heroes:
Opposing Fronts
This standalone
game features
two unique
armies with
full-length
campaigns.
Take command
of the tenacious British 2nd Army in
the vicious battle for Caen, France,
or lead the German Panzer Elite as
they struggle to repel the largest
airborne invasion in history

MOVIES
20,000 Leagues Under
The Sea
The first great special effects
spectacular of early cinema. Based
on the Jules Verne novel, the story
concerns a team of scientists
investigating a series of naval
disturbances who find the culprit—
Nautilus, a submarine piloted by
Captain Nemo, a hate-driven
renegade seaman.

TRAILERS
Tiberium Trailer

For 11 years, an alien tower has stood
dormant, looming like an unholy
mountain over a wasteland— once the
Mediterranean Sea. The tower thought
to be a relic of the Third Tiberium
War—a devastat-ing war fought for
control over Tiberium crystal.

Turok Trailer
Turok is an epic, story-driven FPS
set on a dark, mysterious planet in
the near future. Players take on the
role of Joseph Turok, a former Black
Ops commando, now part of an elite
Special Forces squad on a mission to
take down a war criminal on a
genetically-altered planet.

MULTIMEDIA
AM-Notebook 5.0

AM-Notebook is a multi-
featured tabbed note-
taking program that
provides an easy way to
save notes and formula-
supported spreadsheets
in a light weight tray icon
tool. Notes can be stored
at different locations and
also be shared in a
network. Other nice
features are the
integrated alarm clock
and the address book

AV DVD Player
Morpher 3.0.9

AV DVD Player Morpher is
a good call for home
movies entertainment.
With this one-stop video
tool, you can play and
morph audio-video
streams in real-time, add
effects to movies, convert
video files to AVI and
WMV, edit subtitles,
capture images, record
DVD audio, burn or erase
VCDs, and help design
DVD / CD Covers. It
supports most video

formats (AVI, MPG, MPEG,
MOV, QT, M1V, etc.) with
easy-to-use features like
bookmarking, editing,
deleting and navigating

AVI2ISO 2.08.06a

AVI2ISO is a all-in-one
tool that converts AVI /
MKV / RMBV / VWV /
FLV with just a single
click to an ISO format. It
uses only freeware tools
and can handle various
freeware encoders

PERSONAL
Celestia 1.5.0
Celestia is a real-
time space
simulation that
lets you
experience our
universe in three dimensions. Unlike
most planetarium software, it doesn’t
confine you to the surface of the Earth

ClipX 1.0.3.8
ClipX is a tiny
clipboard history
manager

Data Crow 3.1

Data Crow allows you to create a huge
database containing all your collected
items. You can use the excellent online
services to retrieve the information
instead of typing all the information

yourself. Don’t strain yourself in
maintaining your items and trying to
keep track of their location, start using
Data Crow today

eHour 0.7.2
eHour is an open source Web-based time
tracking tool for consultancy companies
and other project-based businesses. The
primary objective is to keep time
tracking as simple and user friendly as
possible, while still being very effective
at measuring and reporting the amount
of time your team spends on a project

GreenPrint
GreenPrint’s patent-pending software
eliminates unwanted pages saving paper,
ink, money, and millions of trees

Input Director 1.0.8
Input Director is a Windows application

that lets you control
multiple Windows
systems using the
keyboard / attached
to one computer. It is
designed for folks
who have two (or
more) computers set
up at home and find themselves regularly
sliding from one system to the other

� Natural Word 0.9.8
� NolaPro 4.0.2851
� GFI FAXmaker for Exchange/SMTP

Client 14.1.

PERSONAL
Ccount 1.2
Ccount is a PHP click counter which can
also be used as a download counter. With
its help, you can count clicks on any link
on your Web site. A great tool if you want
to know how many times a link has been
clicked, a file downloaded (“download
counter”) and similar. You can also hide
your affiliate links with PHP click
counter. As long as it’s a link—Ccount can
count clicks on it

Google Web Toolkit (GWT) for
Windows 1.4.61
Google Web Toolkit (GWT) is a Java
software development framework that
makes writing AJAX applications like
Google Maps and Gmail easy for
developers who don’t speak browser
quirks as a second language. Writing
dynamic Web applications today is a
tedious and error-prone process. You
spend 90 per cent of your time working
around subtle incompatabilities between
Web browsers and platforms, and
JavaScript’s lack of modularity makes
sharing, testing, and reusing AJAX
components difficult and fragile

Joomla 1.5
Joomla! is one of the most powerful
Open Source
Content
Management
Systems on the
planet. It is used
all over the world for everything from
simple Web sites to complex corporate
applications. Joomla! is easy to install,
simple to manage, and reliable

Gaming

Contents Interactive

Tools

Productivity

Entertainment

MOVIE
OF THE
MONTH
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Contents Interactive

PERSONAL

UltraMon 3.0.2
UltraMon is a utility for multi-monitor
systems, designed to increase
productivity and unlock the full
potential of multiple monitors. With
additional window buttons, you can
quickly move windows or stretch a
window across the desktop

� AM-DeadLink 3.2 Beta 1
� doPDF 5.3.249
� GSN SMS Notifier 0.0.1.7
� IsoPuzzle 1.7
� Personal Task Manager

DEVELOPERS
Adobe AIR Beta 3
Adobe AIR is a cross-operating

system runtime that allows Web
application developers to use their
existing Web development skills
(HTML, Javascript, Adobe Flash,
Adobe Flex, AJAX) to build and deploy
rich Internet applications to the
desktop

� Apache HTTP Server for Windows
� Arachnophilia 5.3 Build 2177
� Rapid Environment Editor 1.8

PODCAST
Introduction To Joomla
Hosting your own fully functional
and easy to maintain Web site is
simple with Joomla! In this episode
Nick, from ITIdiots.com
demonstrates the latest version of
Joomla, and shows you how to
quickly set up great looking Web site
in around 30 minutes

FREE
OpenTTD For Windows

OpenTTD duplicates the original game
feature-wise, but also has numerous
additions, including canals, revised rail

station construction and additional
airports. Perhaps the most significant
feature compared to the original game
is its multiplayer capability. It offers
LAN and Internet play via public, world-
wide servers for up to ten players

� Hedgewars 0.9.2
� Mad Truckers
� Onslaught

DEMOS
Jigsaw Butterflies
The butterfly is one of nature’s most
glorious examples of beauty and
transformation, and is now available

in a GameHouse Jigsaw collection.

Each of the fifty colorul images in
this collection contains a unique
image of an exotic butterfly. Analyze
the Anna Blue and wonder at the
West Coast Lady, each butterfly is
accurately named for those who
are curious

MULTIMEDIA
Scribus
Scribus is an open-source program that
brings award-winning professional page
layout to Linux / Unix, MacOS X, OS/2
and Windows desktops with a combina-
tion of “press-ready” output and new
approaches to page layout

Serif PagePlus SE

PagePlus is the award-winning desktop
publishing software that enables you to
create stunning documents for your
home, school, business or club—no
experience required! You need to be
online to register your free software

� 1by1 1.63
� ClrMamePro 3.109c
� ComicRack 0.9.75
� Desktop Picture Frame 1.0.1
� Fennec 1.2 Beta 1
� Inkscape for Windows 0.46
� K-Lite Codec Tweak Tool 2.2.4
� MP3Gain 1.2.5
� Nokia Nseries PC Suite 2.0
� Spider 2.2
� Subtitle Workshop 4.0
� Video Memory Stress Test 0.11b
� DipTrace 1.50
� DrmRemoval 3.2.0
� Power Mixer 2.4

SYSTEM
Belvedere Automated File
Manager
Keep your desktop or any other folder on
your hard drive organised and under con-

trol with Belvedere, an automated
Windows file management tool. Use

Belvedere’s friendly interface to create
advanced rules to move, copy, delete,
rename, or open files based on their name,
extension, size, creation date, and more

� Process Lasso 3.42
� SharpE 0.8 TD4
� SUMo 1.5.0.36
� Task Manager Free 4.9.1
� Winpatrol 14.0.2007.0
� XP-AntiSpy 3.96-7
� XFilesDialog 3.50.183 Beta
� Xplorer² 1.7.0.10

INTERNET
WWWinamp 4.2
WWWinamp is a simple Web server-like
application that allows remote control

of Winamp via any Web browser. It
manages a database of files and/or
URLs that can be queued into a running
Winamp. It supports most standard
Web browsers, and includes a special
mode (that conserves bandwidth and
screen space) for Windows CE devices.
It supports two optional levels of pass-
word protection. The first level lets you
control who can search the database

and queue files, and the second lets
you control who can do things like
remove files from the queue, pause
playback, and so on

� Blogger Backup 1.0.9.22
� Flickrdown 2.43
� Fresh Download 7.94
� gDocsBar 0.5.4
� SpeedBit Video Accelerator 2.2.1.8
� twhirl 0.6

LINUX
xVideoServiceThief for
Linux 1.4

xVideoServiceThief (a.k.a xVST) is
a tool for downloading your
favorite video clips from a lot of
video Web sites.

It also provides you the ability to
convert each video in most popular for-
mats: AVI, MPEG1, MPEG2, WMV, MP4,
3GP and MP3

Tools

Productivity Gaming

Infotainment



Digit Reader Poll

By Demand
You get to choose what goes
on Digit Interactive. This
month, you chose:

Windows XP Service 
Pack 3 Release Candidate
Size: 436 MB

LightZone (Linux) 
Size: 26 MB

taste technology at www.thinkdigit.com

This Month’s Question                                                 Vote at www.thinkdigit.com

What Web applications do you use most besides mail and chat?

File Storage
Multimedia streaming streaming (Video and audio)
Massively Multiplayer Online Games
Blogging, wikis, discussion forums

Subscribe
No more snail-mail! No need to visit
post offices! All you have to do is log
on to www.thinkdigit.com/subscribe
and use your Credit Card to make
sure you never miss another issue of
your favourite magazine!

Here’s everything you need to
know about BitTorrent
(Log on to www.thinkdigit.com)

Web Special
Connecting The
Masses

Last Month’s Question

Online

FEATURED REVIEW FROM THE DIGIT FORUM ((wwwwww..tthhiinnkkddiiggiitt..ccoomm//ffoorruumm))
This month we feature a member review from the forum.

One of the latest offerings among handsets of Tata
Indicom is the Huawei C2900i. Its a very feature-rich,
low-end phone, which packs in many features of mid-
range phones too. Like high speed Internet on the
phone, or PC connectivity for surfing on the PC. 

Internet Connectivity
This phone has an inbuilt modem that is capable of
speeds of upto 153.6 Kbps upload or download under
a CDMA 1x network.

It’s Rs 100 costlier than the C2900 which is the
same phone without an Internet modem. So for Rs
100 more, the C2900i is worth it. This phone uses
the Opera Mini browser for surfing the Internet and
you can surf any site on it. The sad part is you can-
not download anything on this phone, but while
surfing on the PC there is no such limitation. It
does not support JavaScript and audio / video play-
back. Browsing speeds and page rendering is simply
awesome, but the Opera Mini browser has some
bugs that cause the phone to restart if you are

browsing heavy pages—full of images for a long
time. But its very rare. The speed is much faster
than GPRS as well as EDGE on some service
providers. Tata indicom charges Rs 99 per month
for Internet on your phone.

Signal Quality
Signal quality and call quality are good, compared to
similar priced handsets. I had full signal strength all
the time, even though the tower is 4 km away from
my house

Phone Display
The display is 128x128, 64k colour CSTN display
which is great, despite the low resolution and there is
no problem reading even the smallest text size as the
brightness of the screen is superb.

For more visit:
http://www.thinkdigit.com/forum/showthread.
php?t=79253

29-01-2008, 
12:33 PM

utsav
HOD:- Hackers
Department
Join Date: Sep
2006
Location: inside
your processor
Posts: 1,041 
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Your thoughts about Fast Track:
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It’s perfect,
leave it

the way it is!
20.5%

A little colour and better paper
would go a long way 45%

Make it a Colour,
Interactive PDF

on the DVD
14%

Just end
it, I hate it
3.5%

Replace it with a
comprehensive

multimedia
tutorial on the

DVD 17%
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have not been significantly
affected by all the hue and
cry among the Blu-Ray and
HD-DVD camps. The average
Indian consumer, till now
has been happy with the
normal DVD format. With
significant certainty, now
emerging in the DVD
arena, Indians can now
decide purely by the deals
they get!

COME...PLAY

PS3 To Lead
In 2008

The gaming industry
had witnessed
phenomenal growth

last year, with major
players such as Nintendo,
Sony and Microsoft posting
massive sales figures.
According to research firm
iSuppli, the PS3 will pose
the strongest growth
figures among all video
game consoles. The
projected worldwide sales
figures this year are 10
million units for PS3, 12.2
million units for the Wii,
and 7.5 million units for
the Xbox 360. 

With strong sales, lower
prices and broader appeal
among audiences, the Wii

is all poised to be the
market leader with a
global installation base of
30.2 million units. On the
other hand, the Xbox 360
has struggled in Japan and
Europe, where the Sony
brand formerly dominated,
and is on course to
increase its user base to
25.7 million units by the
end of 2008.

In the light of all
conditions, the PS3, which
lagged due to its price and
lack of blockbuster games
for most of last year, would
double its installation base
to 20.3 million users and
by 2011 will be the
industry leader.

In India, however, the
Xbox 360 leads in terms of
market share. However,
with Blu-Ray getting the
upper hand in terms of
being the preferred DVD
format, Sony has a lot to
gain. What happens to
Xbox 360 users who use
HD-DVD drives with their
gaming consoles is still to
be seen. The users hit the
most, are those who
bought external HD-DVD
drives for their Xbox 360s.
How Microsoft
compensates them, is a
matter of concern and will
be closely watched in the
forthcoming days.

WHAT YOU MISSED

MS, Yahoo,
And Them

The world is going
abuzz with talks
between the two east-

coast companies—Yahoo
from Sunnyvale, California
and Microsoft from
Redmond, Washington.
Surprisingly, Google was

Toshiba
For being a sport,
and finally
surrendering to
the more
powerful forces

that drove  Blu-ray to
supremacy. They’re even
collaborating with arch-rival
Sony to manufacture NAND
Flash memory! Talk about an
amicable truce...

Toshiba
For promising the
world with the
HD-DVD format,
selling the players
really cheap,
getting over 750,000 people
to buy them, outselling Blu-
ray units for a while, and
then calling it quits! We can
hear the early adopters’
screaming even from here!
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Nick Desai, CEO, Juice Wireless
recently visited India to launch
JuiceCaster. Primarily targeted at
mobile users, users can upload,
download and share rich media
content using JuiceCaster.

What makes JuiceCaster
different from other online
photo/video service providers?
JuiceCaster aims to provide
seamless and synchronous
connectivity over any platform.
It is available as JuiceCaster
Player and is embeddable on
social networking avenues such
as MySpace, Facebook, Hi5 and
many others in addition to Web
sites and blogs. JuiceCaster
Mobile application (native) and
JuiceCaster WAP are available
for phones with WAP 2.0
browsers. Also, we’ve launched
JuiceCaster D for desktop, which
completes the seamless circle of
sharing rich media content. 

How is JuiceCaster going to be
accessible to the common
Indian man?
With camera phone prices
gradually dropping, India
already has a large number of
mobile phone subscribers. It is
indeed a potential market for
us. We’re in talks with various
cellular operators in India for
making the JuiceCaster Player
for mobiles and its services
available by the Q3 of 2008.
Individuals carrying camera
phones with active Internet data
connectivity can capture
images/videos to upload, and
share them straight away with
others without the need of a PC.

What comprises your target
audience in India?
Initially, in India, JuiceCaster will
be targeting the young, peppy,
tech-crazy and those up-to-date
with IT. Specifically, people
between the age group of 18 to
35 years would be our target
audience. As per our research,
we’ll also target people from
other age groups, since they too
are avid users involved in the
social networking phenomenon.

Indian Overclocker Beats World
Mumbai-based Harshal Tank hit the world’s highest 8800
GT 512 MB 3DMark 06 score in Taiwan this February. He
runs an Intel Core 2 Extreme 9650 processor with a dry
ice-cooling solution, on the soon-to-be-launched Gigabyte
GA-X48T-DQ6 motherboard.

Alliance Will Promote PC As A Gaming Platform
The newly formed PC Gaming Alliance, aims to create a
common platform for hardware and software creators,
developers, publishers and others committed to PC
gaming. This alliance comprises both software and
hardware giants such as Intel, Microsoft, AMD and Dell, among others.

The greatest war for
the next-generation
video format has

finally come to an end—
Toshiba’s pulled the plug
on its war with Sony’s Blu-
Ray. According to latest
reports, Toshiba has
formally announced
that it would not be
continuing its HD-
DVD business. This
race was definitely
fiercer than the
earlier video battle
over Betamax and
VHS. This time, it was
companies that were
deciding what the
consumer gets and
not the other way
round! With
companies such as
Sony and Toshiba
pitted against each
other, it was stiff
competition all the
way through. For
Sony, it was a
matter of prestige to
win this battle, as it
had already lost with
Betamax to JVC in the
VHS days.

On one side was the
Blu-Ray consortium led by
Sony, with Apple, Dell, HP,
Sharp, Philips, Panasonic,
Hitachi and eight other
companies on Blu-Ray’s
board of directors. On the
other hand, the HD-DVD
front was led by Toshiba,
followed by Sanyo, NEC and
Memory Tech. This time,
however, the battle was
prolonged, and there was a
host of factors that decided
the outcome. The most
significant decisive factor,

however, was the gaming
industry. Microsoft, the
makers of the Xbox 360 has
been a strong supporter of
the HD-DVD standard. In
contrast, Sony—the makers
of the PlayStation 3—have

understandably supported
the Blu-Ray format. As a
result, the soaring sales of
gaming applications have
yielded a significant rise in
the sales of Blu-Ray discs.
With half the battle won in
the gaming industry, the
remaining half of the
battle was decided by
Hollywood. Till recently,
Universal and Paramount
Studios were the only
Hollywood studios to back
HD-DVDs—the majority had
backed Blu-Ray. The most

significant of them was
Time Warner, which
switched totally from HD-
DVD to Blu-Ray, leaving
Sony with a virtual
monopoly in the DVD
format arena. So where
does Toshiba go from here?

And what about Sony?
The latest news says

that Sony is in talks
with Toshiba to sell
its PS3 chip
manufacturing
plant for an
amount to
supposedly in

excess of $ 858
million. Both
Toshiba and Sony

Corporation, have
reportedly partnered
with Sony Computer
Electronic
Entertainment Inc.
(SCEI) for the
production of high-
performance
semiconductors. The
whole DVD fiasco
doesn’t seem to
have ended on a

bitter note after all... 
Most technological

developments and gadgets
enter Indian shores after
they have been tried and
tested in Europe and the
Americas. For example, the
iPhone has not yet been
launched in India—the
average Indian consumer
normally complains about
this fact. However, this
time round we should be
thankful for the late entry
of the high-definition DVD
battle into India—actually
it hasn’t got here yet!
Overall, Indian consumers

Enter

Security Watch

IT’S OVER!

Toshiba Gives Up On HD-DVD

13
n LG to roll out Android phone in early 2009 n Microsoft helps nab $900 M piracy ring through large-scale investigation in 22 countries n n Nintendo and Microsoft unveil indie games services to tap into individual game developers n Google to store patients’ health records n

Nick Desai
CEO, Juice Wireless 

Adobe Reader might
be infected
The Problem
According to iDefense Labs, in
January banner ads have
actively been delivering
malicious files, and Adobe’s
Reader and Acrobat services
might have been the prime
target of malicious code. 

Symantec’s security
experts have commented that
the banners might’ve
redirected the users to
potentially harmful Web sites
by these files. On opening
these files, the Zonebac trojan
gets installed on to the system.
This trojan, then disables the
system’s antivirus software
and downloads additional
malware. So banner ads can be
dangerous, since the hacker
might’ve corrupted them with
malicious code by exploiting
Adobe’s Flash technology. 

The Solution
Adobe has issued patches by
addressing the vulnerabilities
as critical. Update to version
8.1.2 to prevent any malicious
code from adversely affecting
them. The update is available
at http://tinyurl.com/28z9qs.
Avoid clicking banner ads and
do not open any PDF
documents if you’re not sure
about its authenticity. 

Which type of Web application do you use the most besides mail and chat??
(You, too, can participate in this poll—at www.thinkdigit.com)

File Storage Multimedia streaming streaming (Video and audio)

Massively Multiplayer Online Games Blogging, wikis, discussion forumsDC

BA

(You, too, can participate in this poll—at www.thinkdigit.com)

Opinion Poll

I choose option B since I spend lot of time
watching online videos and listening to
music. Of course it is better
than reading irrelevant discus-
sions at some websites.  I listen
to the latest music on stream-
ing sites or radio stations.
Parin Sutaria
Baroda

I’ll go for option D because knowledge
sharing and public views on various sub-
jects are obtained. I enjoy
online debates by veterans as
well as freshers on any topic.

Sharlet Macwan
Mumbai

I choose D. Visiting forums and wikis
help me troubleshooting at my work.
Also, through interaction
with other people at these
places, I can broaden my
knowledge.
Dhaval Pancholi
Baroda

Option B is what I’d like to choose. At
work, I listen to streaming music to relax.
In my free time, I watch lot of
instructional and tutorial-
based videos online. 
Amit Shah
Mumbai

Illustration Harsho Mohan Chattoraj

Option D. I get a chance to express my
views and the whole world could be my
stage; they also give me a
chance to be introduced to a
rare and endangered species—
the practical intellectual.
Bijoy Yohanan
Bangalore

Option D. The objective behind the cre-
ation of Internet was information shar-
ing, wasn’t it? With a medi-
um like this, we know and
read different paradigms and
perspectives. 
Nidheesh P.K.
Mumbai
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also active in the media,
this time around playing
spoiler by claiming that
Microsoft would use the
deal to gain too much of
control over the Internet. 

We have also heard
reports about AOL talking
to Yahoo! for a likely deal.
We believe that’s not
coincidence, considering
the fact that Google owns a
5 per cent stake in AOL.
Rupert Murdoch’s News
Corp. also joined in the
league, by recently holding
talks with Yahoo!

The Chinese portal
Alibaba, however, is an
important factor in the
whole deal. For those of
you’ll who haven’t heard of
it, Alibaba is a Hangzhou-
based e-commerce / e-
auction company, and a
significant player in China’s
search engine and online
marketing industry after
Baidu. Yahoo! is a major
stakeholder in Alibaba.
Softbank, a Japanese
telecommunications
company, which bought out
Vodafone Japan, also owns a
3.9 per cent stake in Yahoo
US and 40 per cent of Yahoo
Japan. In addition to this,

both Softbank and Yahoo,
are common investors in
Alibaba. Being a dominant
player in China, this deal is
being closely watched by
Chinese authorities—
concerned over foreign
control of Chinese
businesses, especially with
Microsoft, considering its
monopolistic policies and
practices.

The deal between the
two companies has not yet
been signed, and it already
has effects on China and
Japan. But what are the
possible impacts in India?
As far as Indian surfers are
concerned, Google ranks
the highest, followed by
Yahoo! at a distant second
place, and then MSN.
Unlike other countries
where the competition is
stiff, in India, Google really
holds a significant lead
over the other search
engines. Could this
translate into a reduction
in PPC rates for online
advertising? SEO
professionals would surely
be watching this closely.
So, for India, things don’t
seem to be as significant
anyway. Surely services are

only going to improve with
the competition. They’ve
got to!

YOU’RE HIT!

The Great
Indian Virus

India and technology
seem to be in the news
quite often these days. A

few weeks back, it was low
browsing speeds due to the
cut in the Middle Eastern
optical fibre (FALCON)
belonging to FLAG Telecom,
under the flagship of the
Reliance ADA group. To add
to these woes, a recent
study on virus activity by a
web security services
company indicates that
India has the highest
incidence of virus attacks. 

As per the study
conducted by MessageLabs,
“Virus activity increased
across a number of
countries in January,
including India, which
takes the number one spot
with 1 in 30.5 emails”. As
compared to India, the Web
attack was far less in

western countries with
figures being one in every
191.5 emails in the US and
one in every 158.4 e-mails
in Canada. In New Zealand,
Web security levels were
pretty good—one out of 768
mails was virus infested,
while for Australia, the
figure was one for every
298.7 mails. The study goes
on to reveal that the global
spam ratio is 73 per cent.
This translates to one in
every 1.36 emails. This only
further reiterates the need
for us to be updated with
the latest anti-virus, anti-
spam, anti-spyware and
other proactive tools to
ensure safety. In taking
such measures, not only
are we safer as individuals,
but rather reduce the risk
to others, especially our
friends and close
associates.

SOMETHING INSIDE

Micro-buzz

After the series of
anti-trust battles
between Microsoft

and the EU, it now seems

A Round-up Of Technology News From Across The GlobeThe Digital World

GERMANY
Nokia's announcement to close down
its unprofitable cell phone plant in
Bochum sparks dispute with the
government. Over 4,000 people
protest outside plant premises

RUSSIA
As per the computer security firm
Sophos' survey, 8.3 per cent of the
world's spam or one spam in
every 12 junk mails makes Russia
a “spam superpower” after the
current leader, the US

DENMARK
Going anti-piracy, courts
order Danish ISP Tele2 to
block customers’ access to
the popular P2P file-sharing
site The Pirate Bay

ROMANIA
Nokia opens factory as part of their low-
cost locations program for production of
mobile phones and parts, for Europe,
Africa and Middle East. About 1,200
people will be employed on an average
salary of $318 (Rs 12,402) per month
(before taxes) by the end of the yearSPAIN

Cops arrest more than 76 people
nationwide, for Internet fraud. Some
suspects were involved in auction
fraud—they scarpered after
collecting the cash for plasma TVs
without delivering the goods

n Game consoles can model black holes, drug molecules n Software gets smart cars talking n MySpace opens to software developers n

CHINA
The first Cloud Computing Centre for
software companies of the country was
announced recently by IBM, along with
Wuxi Tai Lake Industry Investment &
Development Co. Ltd
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move, to do away with slow
pace of processing, bank
transactions that are
paperless or online should
be verified with a hard
copy as well. 

According F-Secure
Security Labs, the SVP
National Police Academy in
Hyderabad, had a Bank of
America phishing site
operating on one of their
servers.  After all, when it
comes to money, there is
no pride or tech-savvy
talks—it’s the money that
matters. With the rise of
social networking sites
such as MySpace and
Facebook, even this area of

the Web space is now a
prime target for exploits.
This justifies social
networking sites giving
cautious alerts to be aware
of phishing activity.

OPEN THE WINDOWS

Windows 7
Gets Touchy

With Vista having
borne tough
comments from

critics to the extent of
being regarded as the
biggest disappointment of

2007, Microsoft is all set to
slate a 2009 launch of a
successor. Named Windows
7, it will be more human-
friendly with increased
input options, as per Bill
Gates, Chairman Microsoft.
According to him, touch,
speech and written text
would be the significant
development in the latest
version of Windows. Gates
claims that technical
advancements in the areas
of touch and speech would
be incorporated into
Windows 7. In a recent
speech to Stanford
University, Gates said, “It’s
a big step forward in terms
of ink. It’s a big step
forward in terms of touch”. 

So what does that
mean? In two years, Vista is
no more? Was this all a
tactic to get people to move
out of XP and then force
them to switch to another
product? It started with
gamers who were literally
forced to upgrade to Vista
because of the DirectX 10
compatibility issues
springing up. 

In fact, Microsoft is
directly working with
manufacturers, and in all
probability computers
would come fitted with
touch screens and be able
to accept inputs in the
form of touch. Microsoft

has already hinted that
Windows 7 would be
“touchier”, similar to
Apple’s iPhone. On the
other hand, Microsoft plans
to do away with DirectX 11.
Apparently, with the
hardware requirements of
DirectX 10, and the
customer resentment as a
result of it, the software
giant seems to have become
proactive. We wonder
whether our cell phones
are becoming PCs or the
other way round. 

On the other hand, has
Microsoft just added up
features from their work
on the Surface PC, the
much hyped touch-enabled
computer. With focus on
touch, that is what it
seems to be. Yet another
bit of Microsoft hype... 
only the future will reveal
the facts.

ALL IN THE HEAD

Gamers To
Get Brain-
controlled
Headsets

With exponential
progress, even the
means for

entertainment are going
high-tech. The latest
development for the
gaming industry is from
the US / Australian firm
Emotiv. Scientists have
developed a neuro-headset
that interprets the
interaction of neurons in
the brain, which enables

Claimed as yet another iPhone killer by Tech evangelists
and bloggers, the Sony Ericsson XPERIA X1 has on
incredibly high-resolution (800 × 480), 3-inch VGA
touch screen display. With a unique arc-slider design,
the X1 features a new desktop GUI called ‘Experia
panels’, a nine-panel interface that’s eye candy on the
high-resolution display. These panels are finger-friendly
marvels that permit access to applications running on
the phone via the home screen. Navigation is possible
either by touch, arc-sliding QWERTY Keypad, 4-way
joypad and an “optical joystick”. 

The X1 also has loads of other features like quad-
band GSM as well was UMTS/HSDPA/HSUPA network
support, WiFi, aGPS, microSD (400 MB on phone
memory by default) and of course, Windows Mobile 6.
X1 aims for the Web convergence market since it runs
the Microsoft Windows Mobile OS for blending
multimedia with Web communication. All the hype
around the X1 leaves Sony Ericsson fans in
anticipation, and it is expected to hit markets over
the second half of 2008. There’s no way can you
expect it to be cheap. Nevertheless, keep drooling!

47% of men
would give up sex
for six months, for
a 50-inch plasma
TV, compared to

just over a third of
women

Roughly
68,000 servers
on the Internet
are returning

malicious
Domain Name
System results

according to
Georgia Tech
and Google

survey

2.1% of people have had a
virus in their handset,
11.6% know someone who
has had a virus and 86.3%
of people have never heard
of anyone with a mobile
phone virus—McAfee Survey

Nearly 40% of all phone
calls, fail to meet set industry
standards, even in developed
markets like the US and
Western Europe

n Doctors use Wii games for rehab therapy n Netscape officially dead; AOL says use Flock or Firefox n Google lunar challenge gets underway

XPERIA X1

X-force’s graph on Vulnerablities
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Photograph Ram Hari Koirala Each month Digit will carry a caption for a photo. Come up with something funnier, 

and beat the Digit team at their own game! Entries accepted by the 20th of this month.

Digit Caption

Look! Web access!

to be the turn of Intel, the
world’s largest chip
manufacturer. Some days
ago, the European
Commission raided the
Munich offices of Intel. To
add to Intel’s woes, the
Commission also raided
the retailers that sold
Intel’s products. 

These raids come in the
wake of charges that Intel
has slashed prices below
costs, and also offered huge
rebates in an effort to drive
AMD out of the market.
The Commission is already
investigating charges on
German retailer Media
Markt, surrounding its sale
of computers. Media Markt
sells Intel-powered PCs, but
none that run on AMD
processors. In response to
these raids, Intel’s
spokesman Chuck Mulloy
said “there has been a raid
on our offices in Munich.
As is our normal practice,
we are cooperating with
authorities.”

In the days of Core 2
Duo and Phenom, and the
combined market
dominance by Intel and
AMD in the microprocessor

business, venturing into
this area is as risky as a kid
attempting to eat the
juiciest burger in front of
the class bully.
Microprocessor start-ups
are a rare, if even extant,
commodity these days. The
available opportunities in
the form of server business
are pounced upon with all
might by the niche group
of companies such as Sun
and IBM. In the last decade,
a company by the name of
Transmeta Corporation—
which once had Linus
Torvalds on its payrolls—
had attempted to eat into
the microprocessor pie, but
seems to have fallen
miserably. 

Montalvo Perry, a
former CEO of Transmeta
Corporation, went on to
found Montalvo Systems, to
venture into the prime
zone of ultra low-power
microprocessors. Montalvo
Systems is once again in
the news for claiming to
have developed a multi-
core, energy-efficient CPU
for notebooks and “ultra
portables”. The Santa
Clara-based start-up—which

has a presence in
Bangalore as well—focuses
on processors with low
power consumption.
Although very secretive
about their plans, there
are speculations that
Montalvo will make public
announcements this year.
Among its workforce, are
former employees of
Transmeta, NexGen, AMD
and others. This name is
surely going to be under
the lens in the days to
come, and most definitely
by Intel!

ITALIAN JOB?

Thieves
Ahoy!

These days, most
account transactions
happen online. In

these e-banking days,
phishing refers to e-mails
that appear to be sent from
a legitimate source in an
effort to obtain sensitive
information from a user.
For example, the email
appears to be sent to you by

your bank, asking you for
your password, or any
other sensitive
information. According to
the IBM X-Force 2007 Trend
Statistics Report, of the top
20 companies targeted by
phishing in 2007, the
report says, 19 are in the
banking industry. With
widespread risk of online
transactions, we are all at
risk to the latest pestilence.
The X-Force collected and
analysed 410,000 new
malware instances in 2007,
which is approximately 30
per cent more than those
analysed in 2006. So, what
is the average user
supposed to do in the
midst of significant forgery
and phishing online? As it
is said through the days—
old is gold. What started
off as a revolutionary

Last Month’s Winner!
Abhishek Tiwari, New Delhi 
“What was the shortcut to
Connaught Place?”

n College Coders Working With IBM’s Project Zero n Nokia says it will incorporate Google search engine in cell phones n Net firms reject monitoring role

E-mail your caption with the
subject “Beat That”, and your
postal address, to
beatthat@thinkdigit.com
and win 

Fix Your Own PC
by Corey Sandler

Published by
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K-NFB READER
What's the K-NFB Reader?
knfbReader is a mobile phone
software for the blind,
developed by Ray Kurzweil (the
father of text-to-speech) in
association with National
Federation for the Blind. 

How does knfbReader work?
It’s a text-to-speech software
that takes its input from the
mobile phone’s camera and
then uses optical character
recognition technology and
text-to-speech capability to
read out text. It displays each
sentence and highlights each
word while it’s being read out
at a user-adjustable speed.
Thousands of pages can be
saved in text format using
memory sticks. Braille support
is available on request.

Which phone models can
sport knfbReader?
Currently, knfbReader is paired
with and designed for the Nokia
N82, Symbian Series 60, (3rd
Edition) platform with 
50 MB of flash storage. 

Who's going to benefit from it?
This technology will benefit the
visually impaired and those
suffering from dyslexia—
generally those who need
assistance for reading text. It
will make them more
independent and boost their
performance at professional
and personal fronts.

Why will it make a difference?
This mobile reader program is
expected to eliminate the need
to carry multiple devices and
ulitmately make the mobile
phone a unified solution. The
mobile reader can also function
with GPS programs and access
PDF files. Besides, accessibility
to other mobile functions can
be improved by using software
such as MobileSpeak and Talks,
developed specially for the
visually impaired.

When will the knfbReader be
available for purchase?
knfbReader was released on
February 15, 2008. Get it at
http://www.knfbreader.com/

gamers to interact with the
virtual world using their
thoughts and emotions.

Tan Le, President of
Emotiv says, “It picks up
electrical activity from the
brain and sends wireless
signals to a computer. It
allows the user to
manipulate a game or
virtual environment
naturally and intuitively.”
Although the concept of
reading neural activity is
not new, Emotiv claims that
the Epoc headset is the first
consumer device that can
be used for gaming.

Emotiv is also in talks
with IBM for developing the
technology for use in
“strategic enterprise
business markets and
virtual worlds”. According
to Paul Ledak, Vice
President, IBM Digital
Convergence, brain
computer interfaces such as
the Epoc headset are an
important component of
the future 3D Internet and
the future of virtual
communication.

Future 3D Internet!
Sounds interesting! India
has a perfect blend of the
crème de la crème in the
high rises of metros and
new-to-gaming kind from
mid-sized and small cities.
While the Internet evolves
towards 3D and games
increasingly tech-heavy, the
pricing and distribution of
these gadgets in the Indian
market is what we look
forward to.

LIGHT SPEED

Optical
Networks To
Blaze Faster

Researchers at the U.S.
Department of
Energy’s Ames

Laboratory have come up
with an ideal way to sort
and distribute data transfer
over optical fibres across
the globe. The new
technology, developed by a
team led by physicist Rana

Biswas, is called the Three-
dimensional Photonic
Crystal Add-drop Filter, and
enables enhanced trans-
mission over multiple
wavelength channels
(wavelengths of light)
travelling along optical
fibres. This is a significant
milestone in the
development of all-optical
transport networks to
eliminate electrical
components from optical
transmission links,
resulting in virtually
flawless data reception for
end users of the Internet
and other fibre-based
telecommunication
systems.

Biswas explains, “There
are up to 160 wavelength
channels travelling
through an optical fibre at
the same time. That means
a lot of dialogue is going
on simultaneously”.
Biswas, who is also an Iowa
State University adjunct
associate professor of
physics and astronomy and
electrical and computer
engineering, explained
that as information is
transported over these
multiple channels, it’s
necessary to periodically
drop-off individual
wavelength channels at
different points on the
fibre. At the same time, it’s
essential to be able to add
data streams into the
empty wavelength
channels. “When the data
being transported in
multiple frequency
channels over an optical
fibre comes to a receiving
station, you want to be
able to pick off just one of
those frequencies and send
it to an individual end
user,” said Biswas. “That’s
where these 3-D photonic
crystals come into play.”

To further prove their
finding, the researchers
used a three-dimensional,
microwave-scale photonic
crystal constructed from
layered alumina rods,
containing a full
bandgap—a wavelength
range in which
electromagnetic waves

cannot transmit. Just as
electronic bandgaps
prevent electrons within a
certain energy range from
passing through a
semiconductor, photonic
crystals create photonic
bandgaps that confine
light of certain wave-
lengths. The idea of using
photonic crystals for add-
drop filters is not new.
Since the mid 1990s, many
groups worldwide have
been working to develop
the technology with two-
dimensional photonic
crystals.

“It works,” Biswas said,
“but there is loss of some
intensity to the end user
because 2D photonic
crystals don’t confine the
light completely. For
example, in a phone
conversation, voices would
dim out. But with 3D
photonic crystal add-drop
filters, the communication
would be clear.”

Although Biswas and
his team have shown that
3D photonic crystals would
make highly efficient add-
drop filters, there are still
problems to address.
Getting the size of the
photonic crystals down to
1.5 microns to work at the
wavelengths used for
Internet communications
is a big challenge. The
Ames Lab group now has
some of these photonic
crystals working in that
range, but to make these
controlled structures with
one input, another output
and a defect, required
significant amount of
work. A future direction is
to simplify the design of
the add-drop filter by
reducing the layers in the
photonic crystal—perhaps
having all the action
happen in one layer.

This comes as a ray of
hope to the average Indian
surfer, and more so the
host of IT and ITES services
companies based in India,
where ISPs claiming to be
broadband providers are
not able to provide enough
throughput to keep the
customer content! 

n Microsoft SkyDrive no longer just a Beta n Microsoft warns on Vista update—third party drivers may not function normally
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Michael Browne

From the movies we watch to medical sciences
and imaging, educational simulations to
defence applications, and even manufactur-

ing processes (Computer Assisted Manufacturing)
the impact that 3D rendering has had on the world
is phenomenal. 3D accelerators (or graphics cards)
have acted as catalysts for the growth of 3D model-
ling, rendering, and animation. 

The year 1981 and the first PC video card from
IBM seems ancient history. We’ve gone from single
colour video cards to cards that can work with
millions of colours. The real graphics war for desk-
top PCs didn’t start till 1997 when 3dfx delivered
Voodoo to the world with (then) powerful features
like Mip-Mapping, Z-buffering and AntiAliasing.
Rivals NVIDIA came up with their TNT and TNT2
cards following the Voodoo 2, and these were the
first AGP-based cards. Though it may seem that
things have stagnated from those initial gigantic
steps, nothing could be further from the truth.
Enter NVIDIAs GeForce 256 graphics card (August
31, 1999). It essentially had 4 pixel pipelines that
could each handle a single, half precision (16 bit)
pixel operation in a clock. Core and memory
speeds were 120/166 MHz and with a peak output
of 480 million pixels per second and 15 million
triangles per second, the GeForce 256 was hard to
beat. November 8, 2006, seven scant years later and
the GeForce family’s eighth generation of graphics
cards were unveiled. Their latest 8800GT, which is
a very value oriented card, churns out 16.8 billion
triangles per second, a difference comparable to
the difference between the sun and the moon.
Regardless of the difference in specifications,
there are certain characteristics common to all
graphics cards which we’re going to look at. We’re
also going to see how all this comes together. Let’s
look at the individual parts of a graphics card, and
what they contribute to the whole.

Ever wondered what makes graphics
cards tick, and tick so well? 

Shrikrishna Patkar, Jiten Ghandhi 
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GPU Facts
At the heart of technology in a graphics card is
the GPU or Graphics Processing Unit. Think of the
GPU as a processor dedicated solely to graphics.
Just as a CPU slots into a motherboard, a GPU is
affixed on the PCB (Printed Circuit Board) of the
graphics card. However, unlike a CPU, a GPU can
never be removed from its PCB. Today’s GPUs have
the ability to number crunch enormous amounts
of data and are much more powerful, even than
the fastest quad core. NVIDIA’s 8800GTX GPU, for
example, has 128 stream processors inbuilt and
each is capable of handling one thread of data.
The constant need for speed has led manufactur-
ers to up transistor counts while technology
advances have ensured that the die size of today’s
GPU core has shrunk. ATI technologies has
already made the shift to 55 nm while NVIDIA has
gone to a 65 nm process, previously both vendors
were using 90 nm and 80 nm fabrication
processes. More transistors are being crammed on
a smaller GPU die, and the 8800GTX broke all
barriers by having 681 million transistors on its 90
nm die—the previous high was 276 million tran-
sistors, which was found on ATI’s X1950XTX. The
brand new 8800GT has crossed the 700 million
transistor barrier, and at this rate we could see a
billion transistors on a GPU die within a year.

So what increased with this increase in tran-
sistor count? For one, the number of Shader units
rose steadily, from 4 pixel pipelines (PPs) on the
GeForce FX series, to 16 PPs on the GeForce 6800,
to 24 PPs on the GeForce 7800GTX, and finally 128
SPs (Stream Processors) on the 8800GTX. Similarly,
the colour precision has gone from 16 bits on the
GeForce 4 to full 32-bit precision on the 8800GTX,
and double precision (64-bit) is on the way.
Increases in performance and precision have gone
hand in hand with increases in programmability
with DX 8.1 giving way to DX 9, and then DX 9.0c
(Shader Model 3), and finally DX 10.

The characteristic properties of a GPU mainly
depend on two variables:

1. The core speed: this is the rated frequency
(in MHz, GHz etc) of the processing unit. A general
thumb rule is the faster the core, the faster the
GPU. But performance doesn’t only depend on the
frequency. For example, the core on a GeForce
7900GTX runs at 650 MHz, while the core on a

GeForce 8800GTX runs at 575 MHz, in spite of this
the 8800GTX is more than twice as fast as the
7900GTX in terms of its processing performance.

2. Pixel and Vertex Shaders: A Vertex Shader
basically takes a 3D image made up of vertices and
lines and draws a 2D image out of it, which is
displayed in the form of pixels on the screen. A
Pixel Shader is a refinement of the Vertex Shader
and allows the addition of textures to the 2D
image on a per pixel basis. With the advent of
DX10 both major vendors NVIDIA and ATI have
done away with the concept of Pixel and Vertex
Shaders completely choosing to design their archi-
tectures on a Unified Shader model. These Shader
units are also called Stream Processors. The more the
Shader units aboard a GPU the faster it will
perform, since it can complete more operations
(on pixel and vertex data) in a clock cycle. 

So there are two ways to increase performance
of a graphics core—increase the clock speed, or
increase the count of Shader units. Current limi-
tations of silicon yield mean that increasing clock
speeds may not always be possible or even feasible.
Increasing the Shader unit count is easier to
achieve and the results are startling. Another
reason for unifying Shaders would be the move
towards making GPUs less graphics specific and
more towards general purpose computing engines.

How Does The Core Work?
Any GPU is tasked with creating an image from a
description of a scene, much like an artist. This
scene contains a variety of data one of which is
geometric primitives (vertices and lines) which are
to be viewed in the scene. Also present is the data
which contains lighting information for the scene,
as well as information about the luminance qual-
ities of the objects in the scene, (objects means the
geometric primitive data), i.e. the way that each
object reflects light. Finally, information of the
viewers’ perspective and orientation is also impor-
tant. This process of image-synthesis has always
been viewed as a pipeline process consisting of a
number of stages to avoid confusion, 

Stage 1: Input 
The GPU is designed to work simple vertices and
for this purpose every complex shape in a 3D scene
is first broken down into triangles—the basic

There are two
ways to increase
performance of
a graphics core—
increase the
clock speed, or
increase the
count of Shader
units
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* memory bus width)/8 = (1,800 *
384)/8 = 86,400 megabytes per second
or 84.6 GB/s (Gigabytes per second)

Just to compare this figure to the fastest
system memory based on PC8500 DDR2 RAM
(1066 MHz) we have Bandwidth =
(1066*64)/8 = 8528 MB/s or 8.5 GB/s

As you can see current generation cards offer
ten times the bandwidth that the fastest
memory offers and with DDR4 this bandwidth
is set to cross 100 GB/s. This enormous amount
of bandwidth is used to feed the data hungry
GPU with enough raw data to keep it busy,
which is no easy task considering that the GPU
has an internal bandwidth of over 180 GB/s, and
the latencies are minimal. Very simply, VRAM is
a buffer for the GPU. Data that is fed to the GPU
is fed via VRAM which holds such data till time
the pipelines of the GPU need feeding again.
While VRAM holds vertex data, perspective data
and lighting information, it can never actually
hold texture data which is held by the PCs main
memory. The GPU accesses these textures from
system memory directly through DMA (Direct
Memory Access) and there is no CPU interfer-
ence. The resultant output of the GPU is also
buffered in part of the VRAM which is utilised
as a ‘frame buffer’.

RAMDAC
The RAMDAC or Random Access Memory Digi-
tal to Analog Converter is a component of a
video card that is responsible for converting
digital images into analog signals that can be
displayed by an analog monitor like a CRT. The
RAMDAC may be a separate card on the graph-
ics cards PCB (for example like on the 8800GTX)
or could be integrated on the GPU die. The
RAMDACs ability to support greater refresh
rates depends on its internal data transfer rate,
(which depends on its speed, in MHz), and the
precision of colour bits used. However the
concept of flicker applies only to CRTs and with
the advent of the DVI (Digital Video Interface)
on most LCD monitors and graphics cards the
RAMDACs days are numbered. All LCD and
Plasma screens work entirely in the digital
domain and do not require a RAMDAC. In case
they have an analog input, the signal is simply
converted to digital again after the RAMDAC
has fed out an analog signal from the original
digital signal. This double conversion is lossy to
say the least.

Video BIOS
Like a motherboard’s BIOS the VGA BIOS is a
chip that contains the firmware (hardwired low-
level instructions) that controls the graphics
card’s operation and allows the computer’s
other components and software to interface
with the card. It contains essential information
about the graphics card such its core and
memory clock speeds, memory timings, volt-
ages, and even thermal thresholds (for warnings
and shutdowns). Most graphics cards these days
come with re-flasheable BIOS’ which may
improve performance for affect stability
favourably. If the BIOS is flashed incorrectly, the
card can be permanently damaged.

Outputs
Connectivity might seem a tiny part of a graphics
card, but without standards you wouldn’t see any
of that brilliance actually working. The following
three connects are common to nearly every graph-
ics card:
HD-515: Commonly known as a D-Sub, or VGA
connector. It is an analog connect and has 15 pins
and was designed for CRT displays. It has its
issues—electrical noise (being an analog signal),
image distortion, and sampling errors (due to
downscaling).
DVI: A digital standard developed for LCD and
Plasma panels. It uses the computers native reso-
lution without any compression of any sort and
avoids the demerits of the D-Sub connect.
S-Video: This interface was designed keeping in
mind other devices which may need to interface
with a display card such as DVD players, large
screens, game consoles, video recorders, etc.

Interface
Let’s face it—graphics cards wouldn’t be the speed
demons that they are today unless they could
interface with PCs using high bandwidth ports. A
GPU works in tandem with the CPU, Northbridge
(or Memory Controller Hub), and system memory,
and its only means of communication happens to
be that little slot it’s plugged into. The specifica-
tions of the same little slot have changed a lot too
over the past few years—so much so that the latest
specification is not backwards compatible. From
IBMs 16-bit ISA interface with a speed of 8 MHz to
the current PCI Express we’ve come a long way.
Currently graphics cards utilise the PCI Express
interface (also called PCIe or PCI-E). PCIe 1.1 has a
maximum bandwidth of 8 GBps, consisting of 32
parallel lanes each capable of a maximum
throughput of 250 MBps. PCI 2.0, which has just
debuted in the latest ATI Radeon 3xxx series and
NVIDIA 8xxx series, offers 16 GBps. 

The Shape Of Things To Come
DX 10 wasn’t the big affair it was said to be and
we’re not going to say “see we told you so!” Both
manufacturers NVIDIA and ATI have realised the
follies of developing a graphics card for a standard
that has yet to be properly implemented, and the
fact that hardly anyone uses Windows Vista as a
gaming platform doesn’t help. NVIDIA has just
released the first card of their new 9xxx series—
yes, the GeForce 9600GT has finally arrived. Based
on a 65nm manufacturing process it’s a mid-range
offering meant to take over the reins from the
capable 8600GT. Rumours abound of the presence
of a mighty 9800GTX, but the company them-
selves are tight lipped about specifications. One
thing we know is these cards support DX 10 which
is nothing new. ATI has already released a host of
products namely the 3xxx series comprising of
the high-end Radeon 3870 and the slightly lower
Radeon 3850, with the mid-range Radeon 3650.
But the specifications of these newcomer’s is
hardly revolutionary as the 8800GTX was a couple
of years ago. It seems we’ve reached another
plateau, and the real meat may arrive after DX 10
matures as a platform and application support
picks up. Till then we’re sitting pretty, literally. 

michael.browne@thinkdigit.com.comYe
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building blocks of any 3D model irrespective of
how complex. All shapes like rectangles, cubes
and even curved surfaces are broken down into
triangles. Here’s where the software comes in.
Developers will use either of the computer graph-
ics library software (OpenGL or Direct3D) to feed
each triangle into the graphics pipeline, but one
vertex at a time. The GPU can assemble vertices
into triangles as and when needed.

These days due to the infinite Shader program-
ming possibilities available, developers are able to
give advanced light-based properties to objects.
For example, the way water in a pond interacts
with light, the surface sub-scattering of light by
translucent materials of varying densities, like
skin and hair, and more.

Stage 2: Transformations
GPUs have their own localised coordinate system
and they can use this to specify the position of
each object in a 3D scene. For utilising their own
coordinate system the GPU has to convert all the
objects to a common tracking system. At this
point the GPU cannot perform complex modifi-
cations to the objects for fear of warping the trian-
gles, simple operations like scaling and rotation
can be done. By representing each vertex in a
homogenous coordinate the GPU can perform a
single operation on triangles en masse. At this stage
of the pipeline, the output is a stream of billions
of triangles on the basis of the GPUs common
coordinate system in which the orientation is the
viewers’ perspective.

Stage 3: Lighting
By now, each triangle is placed in a global coor-
dinate system and the GPU can now calculate
each triangle’s colour on the basis of the lights in
the scene. The lighting could be as simple as a
single source (a light bulb in a room), or as
complex as a street lit up by a row of streetlights.
In the latter case, the GPU is tasked with
summing up the effects of each light source and
computing their overall effect on colours and
luminosity of the triangles in the scene. Today’s
GPUs are also complex enough to colour surfaces
of the basis of their physical surface properties—
matte, gloss, etc. Advanced lighting techniques
like specular highlighting, and diffusion and
occluded lighting are also possible.

Stage 4: Getting Perspective
The next stage of the pipeline projects the (now)
coloured triangles on to a virtual plane, as viewed
from the users perspective. These coloured trian-
gles and their respective coordinates are finally
ready to be turned into pixels.

Stage 5: Rasterization
Rasterization is quite simply the process of
converting a vertex representation to a pixel
representation. Here, an image that is described
as a vector graphics format is converted into a
raster image consisting of dots or pixels. In this
stage, each pixel can be treated separately, and
the GPU handles all the pixels in parallel—one
of the reasons that manufacturers upped the
Shader unit count on GPUs to speed up this
parallel processing.

Stage 6: Texturing
While pixels are already coloured by this stage
sometimes additional textures may need to be
added for added realism. This is a cosmetic
process similar to the make up used by ramp
models, in which the image is further draped in
additional textures to add an additional layer of
detail and believability. These textures are stored
in the GPUs memory, where each pixel calcula-
tion can access them. This is where memory band-
width and the quantity of memory plays a vital
role which is why we see graphics cards with more
memory generally performing better.

Stage 7: Hidden Surfaces
In all 3D scenes, some objects are clearer while
some are obscured by others. Its not as simple as
writing each pixel to memory. In that case the
most recently written triangle would get written
first, in which case (for example) a chair placed
behind a table would be displayed while the table
itself would be hidden behind. This stage involves
sorting of triangles from a back to front view. This
is where a GPUs depth buffer comes in. The depth
buffer stores the distance of each pixel from the
viewer and before writing a pixel to the screen the
GPU does a check to see whether the pixel occu-
pying that position is the closest to the user and
if it is, it is sent to the monitor.

Memory
VRAM is present on the PCB of the graphics card
and is as important to it as system RAM is to the
CPU. Very basically VRAM feeds the GPU with raw
data and passes on the results after the GPU has
worked on the data. VRAM is also sometimes
called ‘frame buffer’. In the past three years or so
the importance of VRAM has sharply inclined,
mainly because whole visual revolution that is
taking place where users want as realistic an expe-
rience as possible while playing 3D games. In fact
games are the numero uno reason for advance-
ments in graphics cards’ performance over the
years. From 32 MB of VRAM on the GeForce 256
DDR, to 768 MB of VRAM on the 8800GTX, the
quantity of memory has increased more than 20
fold. This goes in tandem with the improvements
to the core of the GPU.

Not only has the quantity of video memory
gone up, but the type of memory has changed too.
Current graphics cards use DDR3 memory, and
although DDR4 memory is waiting in the wings,
it hasn’t seen much adoption yet.

The bus width of memory has also gone up,
from the 64 bits of yore to 256-bit and even 384-bit
bus width (GeForce 8800GTX). All this speed is
required too, as today’s games demand more than
50 times the resources than the games released
eight years ago. The ultimate goal of manufac-
turers is to up the memory bandwidth figure of
the graphics card. This is done to eliminate bottle-
necks which occur in the memory, as 90 percent
of the time the core has to wait for much slower
memory to supply it with fresh data. Here’s how
you calculate the memory bandwidth of your
video card (works for system memory too):

An 8800GTX has memory clocked at 1,800
MHz, and this memory is 384 bits wide, the
formula for total bandwidth = (clock speed

The importance
of VRAM has
sharply inclined,
mainly because
whole visual
resolution that
is taking place—
users want as
realistic an
experience as
possible
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Day 5:
My daily activities progress as usual, with onesignificant change: I spend a lot of time monitoringmy running tasks and services, and I open Defender atleast twice a day—the last time I ever opened it was tosee what it was, just after I installed Vista. I’ve turnedon UAC (User Account Control) again, just so I knowwhat’s going on in the system.All systems stable for now, but I’m biting my nailsmore, and I suspect some stress-related hair-loss. Thisneeds to pass. Soon.

Day 12:
It’s passed. Working like this has been uneventful sofar—my start-up list hasn’t changed, performanceremains the same and UAC hasn’t f lagged anythingsuspicious. The nail-biting has stopped, and my hairstays on with new resolve. I’m almost starting to believethis might actually work! I’ve even turned off UACagain—when it’s not protecting me, it’s just annoying.

Day 15:
This is starting to get boring. Here I am surfing theInternet, an open invitation to any Dark Force thatmight want to destroy my PC, and nothing. Don’t theylove me anymore? Is Vista really that secure? Or am Ijust not living dangerously enough?

Day 16:
Aha! My sister’s PC (Windows XP) seems to have beeninfected with some sort of worm. And my shared foldersare writable, too! Now let’s see what this thing’s made of.Any minute now...

Day 18:
That’s odd. My PC’s still bafflingly untainted. I’m notgiving up this easily, though. I have procured a Flashdrive which I’m told is infected with an Autorun virus.That ought to do some damage.Unlike XP, Vista doesn’t blindly execute autorun.inf—so when I attach the drive, I still get a dialog box thatasks me whether I want to open the drive or run“explore.exe”. Sharp knife that I am, I choose to open thedrive and delete the autorun file. It’s amazing how afeature as simple as this can thwart a virus.

Day 30:
Still clean. Of course, I haven’t actively hunted formalware to subject my PC to—nobody should—and I haveno doubt that I could infect this thing if I really tried. Butthat wasn’t why I did it—I wanted to see if I could goabout my daily business without an anti-virus, and itturns out that I can. The two times that I could havefaced infection are perfectly realistic scenarios—it couldhappen to anyone. I know there are viruses out there, butthe probability of a random infection like the ones Isometimes faced with XP seems to have gone downconsiderably. Until further notice, my PC is going to beanti-virus-free.

Then again, with my luck, I’ll get infected tomorrow...
nimish.chandiramani@ thinkdigit.com

Nimish Chandiramani
After reading a million white papers on how Vista implements security and, coming to the conclusion that it isn’t the virus-mag-

net the Windows-hating world would have me believe (on paper, at least), I decided to see if that holds good in the real world—

well, my version of reality, if nothing else. Out went the anti-virus; I left the settings for Windows Defender and Firewall at their

defaults—firstly, because that’s what you get when Vista is installed, and secondly, because I have a strict only-one-stupidly-brave-

thing-at-a-time policy.

An Unprotected Vista PC

Digital Passion l 30 days with...
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Vision Research
Phantom v12
6315. No, it’s nothing to do with the
resolution—it’s the frame rate that the
Phantom records at—with a resolution of
1280 x 800! Drop the resolution, and
they say it can go even faster—a
ridiculous million frames per second! It
comes with 8 GB of high-speed DRAM,
and there are 16 and 32 GB versions too.
Price on request, which really means that
twenty people in the world can afford it

General Dynamics
Itronix Duo-Touch II
The Duo Touch II is a Core 2 Duo powered tablet PC
that’s been beefed up to take a battering. It’s been
made to deliver a perfect computing experience

for the people working in hostile environments.
Connectivity options are plenty with everything
from Bluetooth to WiFi to GPRS and EDGE. It
comes with Windows XP Tablet Edition
installed, or you can opt for Windows Vista.
There’s a standard 40 or 80 GB drive you can
choose from or even a 16 or 32 GB solid state
drive. You can use your fingers on the 8.4-inch
touchscreen to control the Duo Touch II or use
a stylus. What’s even better is that it weighs
under 2 Kg, so you don’t have to be a body
builder to carry it around

Apple Macbook Air
It’s a laptop that’s thinner than any you’ve ever
seen! Get this—1.93 cm at its thickest, and 0.4 cm
at its thinnest point. Weight? 1.36 kg. It’s not like
they removed all the excess fat by removing vital
components either. It still has a Core 2 Duo, an 
80 GB hard drive, a 13.3-inch screen and 2 GB RAM
along with all the extras that you find on every
other laptop. Prices start from £1,199 (Rs 93,000)
and go well over £2,000 (Rs 1,55,000)

Bower and
Wilkins 800D
This sound setup which looks like they put a
bowling ball on top of a speaker, is one of the
most exotic speakers from the big names
Bower and Wilkins themselves. The 800D
weighs around 125 kg, and has been made
using silver and gold components to pre-
serve quality. Diamond tweeters are used for
the high frequency range. For such exotica,
you pay £13,000 (Rs 10,00,000)

Belkin
TuneStudio
The TuneStudio has a 4-channel
mixer that can be used to play, mix
and record tracks to and from iPods.
All recording is all done at 16-bit and
44 kHz, and there’s normalisation
built into the mixer to keep volumes
within acceptable limits. One of the
major plus points of TuneStudio has
to be its appealing looks and funky
design—with loads of knobs, LEDs
and dials all over the place

Garmin
Nuvifone
The Nuvifone’s got the whole
iPhone design going, with a large
3.5-inch touchscreen, MP3 /
MPEG-4 / AAC playback and
camera, and yes, GPS. Garmin
even has an online service that
works with the phone that’ll
notify you of traffic problems,
weather and local events—
perfect when you’re lost in bad
weather and need to rush to the
closest fast food joint. It’s
expected to be out in the third
quarter of this year
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Context-aware computing is the realist’s answer to ubiqui-
tous computing—it doesn’t approach the dream, but is far
better than current reality...

Starting Small
Think Hitchhikers’ Guide to The Galaxy—not the book, but
the book in the book (wrap your heads around that one)—the
single source for all the information you need as you travel
the galaxy—from how to deal with an irate Vogon to the
recipe for a Pan Galactic Gargle Blaster. We’ve got something
like it already in development—it’s called the Wikipedia. 

Now consider that right next to many places of interest on
Google Earth, you’ll see a little Wikipedia icon, which shows you
the Wikipedia entry on that place when you click on it. Not so
on Google Maps, and WikiMapia would fit the bill if it weren’t
full of landmarks created by people saying “Look, I live here!”

Finally, consider that GPS-enabled cell phones are readily
available in the market, and are getting cheaper with every
new model. Throw in the high-speed mobile connectivity we
yearn so much for—you see where this is going, don’t you? The
GPS in your phone will tell Google Earth (or Google Maps) what
position to centre on, and you can then read the Wikipedia
entries on important places in your area (not as helpful if
you’re not out sightseeing, but anything that gets rid of annoy-
ing guides prattling on can only be good). Bring the Wikipedia
overlay into Google Maps, and this will happen now—on the
iPhone and the N95, for instance, in countries where
respectable mobile Internet speeds are not too much to ask for. 

It’s started.

Being Polite
Remember when the cell phone first entered our lives? How
we’d cringe every time a phone blared out an ugly ring or a
cheap imitation of a song? Cellular etiquette is as important,
and as shamelessly ignored as it was back then, but there is
hope in sight. Researchers at Intel are working on software
for your cell phone that’ll make it more aware of your
surroundings, and even decide whether to interrupt with a
phone call or take a voicemail message instead. 

The software will analyse your speech—not the words them-
selves, but the tone, pitch, volume, and the time for which you
go on—and the speech of the people around you, and deter-
mine what sort of situation you’re in. For example, a conversa-
tion between you and your friend will have a casual tone, and
since you’re friends who don’t mind interrupting each other,
the conversation will have a lot of overlapping speech. If you’ve
told the software that it’s all right to interrupt casual conver-
sations, you’ll feel that familiar buzzing when you get a call. If,
on the other hand, you’re in a meeting, the phone will detect
the formal, subdued tones, and tell the caller to leave a voice-
mail message instead. At the very least, it could automatically
switch to Vibrate. The software will also be able to detect your
mood based on how you speak, and act accordingly—not inter-
rupt you when you’re ticked, for instance.

At this stage, social interactions are still being analysed to
help the software
make decisions
better—it isn’t particu-
larly accurate with
mood detection (and
we doubt it’ll go
beyond a point), and
hasn’t been tested on a
cell phone. Indeed,
even the most power-
ful phone today can’t
stand up to the punish-
ment of getting all
that data from a
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Nimish Chandiramani 

You’re bored. Quite understandable—it
happens to everyone. Worse still, you’re
in a city that you don’t call home. What

do you do? If you’ve got GPRS, you could whip
out your mobile phone and consult the
almighty Google—“leisure activities [your
current location]”, you’d type, and browse
through the results. It would do well to be
sitting down, because these things take time—
picking a worthy site among all that rubbish
can be tedious. Still, the information exists,
which is what matters in the end. 

But what if your phone would do that for
you, without your intervention? What if it
detected that you’re not in your home city and
would eventually feel the need to see the sights?
What if it told you that you’d just crossed the
city’s best pub, and almost missed out on the
experience? Call it Context Aware Computing
or Ubiquitous Computing or whatever name
that catches your fancy, the fact remains that
with some connectivity and a lot of informa-
tion, such scenarios won’t remain the product
of an over-active imagination.

Context?
In geek speak, context awareness is the ability of a
system (a nice, generic term for a piece of hard-
ware that runs software) to be able to recognise
its environment—location, temperature, alti-
tude, that sort of thing—and act accordingly. A
GPS device is one of the simplest context-aware
computer—it’s aware of your position, and
based on that, is able to tell you what time the
sun will rise or set where you are. 

Context-aware Computing is just another
piece in a much larger (and more Utopian)
jigsaw puzzle called Ubiquitous Computing.
The term was coined back in 1988 by Mark
Weiser, who was the chief scientist at Xerox’s
PARC (Palo Alto Research Centre). The idea is
that all technology around us—down to the
humble light-bulb—will connect to, and inter-
act with each other, and adapt to suit your
needs. Biometric chips in your clothes will tell
your air conditioner that you’re too cold, and
the AC will turn up the temperature to make
you feel better, for example. You could cook up
a million scenarios like this, and they’ll all be
plausible in a world with ubiquitous comput-
ing, and therein lies the catch—it’ll likely be
many years before this could happen. 

My Mobile,
My Guide

Think your PDAs
and cell phones
are essentials? 
They’re about to
become
indispensible

Intel used this unobtrusive sensor to collect
data about the wearer’s social interactions
in their trials 

Shrikrishna Patkar, Jiten G
handhi
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We anticipate
Magitti-like soft-
ware that will
integrate with
your Orkut,
Facebook or
other profile, and
prioritise activi-
ties that your
friends are
recommending

conversation in real time—all they’re capable of
is detecting when a person is speaking, and the
length of that speech. 

It’s also unlikely that the software will
know when to interrupt you and when not to—
some initial setting up will be required,
though it’ll be a small price to pay for a system
that’ll make up for your lack of cellular
etiquette, even though it’ll take years to come. 

And then, there’s the matter that started us
along these lines in the first place...

I’m Bored!
How’d you like a cell phone that told you what
you could do with all that idle time? Or if you’re
walking around in a new city without a clue?
PARC is working on a program called Magitti,
that uses what it knows about you to recommend
activities that you can enjoy in your vicinity.

What you’ll see on your screen when you fire
up Magitti is simple enough—a list of things to do
in the area. When you first use it, this list won’t
be prioritised according to your likes, but as the
software learns more about you, it’ll be able to
tell which recommendations are more likely to
pique your interest—much like recommendation
systems on sites like Amazon. For example, if
you’re a museum buff, historical landmarks will
find themselves at the top of your list. It’ll also be
able to tailor its recommendations based on the
time of the day—you can’t go museum-ing late at
night, so local pubs might be brought to the top

of the recommendation list. Magitti will use GPS
to infer what choices you make, and find out
more about your destination using an online
database (which may eventually turn out to be
the Wikipedia, for all we know).

In addition to learning from your choices,
Magitti will also analyse the data on your cell
phone—text messages, for instance—and like
Google AdSense, make recommendations. If a
friend messages you to meet for an inexpensive
Chinese dinner, for example, Magitti will
prioritise such places when you ask for recom-
mendations. Extrapolating a bit, we anticipate
Magitti-like software that will integrate with
your Orkut, Facebook or other profile, and
prioritise activities that your friends are
recommending. The software will go through
trials in Japan in the next few months, and
we’ll be watching eagerly.

Magitti may be able to learn from your
choices, but what if it could know you by sens-
ing your behaviour?

Sensors And Sensibility
The iPhone, the Sony Ericsson W910i, the
Nokia 5500 Sport and a host of soon-to-be-
released phones sport accelerometers that
enable various features depending on the
device’s movement. The iPhone and iPod
Touch use it to rotate movies when you tilt the
phone, the Sony Ericsson phones use shakes to
shuffle tracks, and the 5500 uses it to meas-
ure the distance you’ve travelled and in a
game where you tilt the phone to get a ball
out of a maze

The iPhone also has an ambient light
sensor that adjust the screen’s brightness
based on the brightness of its environment,
and an infrared sensor that can tell when
you’re pressing the phone to your face. But
why must we know this?

Nathan Eagle and Sandy Pentland of MIT’s
Media Laboratory lament that while new
mobile phones are loaded with more sensors,
they’re rarely used for anything beyond trivial
gimmicks. Collecting the data from these
sensors could yield a whole lot of information
about the user, and will enable software like
Magitti work even more like magic. The data
from an accelerometer in your phone, for exam-
ple, can be used to tell whether you lead an
active or sedentary lifestyle. It can also be used
to tell whether you’re walking, running, cycling
or riding in a vehicle. Combined with GPS and
Intel’s “polite phone” software, your phone can
collect data about where you go, what social
situations you’re in, who you talk to for how
long, and so on. Eagle and Petland have even
developed an algorithm that can predict your
future actions based on the data your phone
collects about you!

Give all that data (and the predictions) to
software like Magitti, and you’ve got yourself a
device that knows you so incredibly well that
the mind boggles.

Brakes 
Every great fantasy is thwarted by reality. In
this case, it’s the hardware—nearly all these
concepts demand a lot more processing power
than current phones can deliver, and even if
we see such a powerhouse within the next
year, processing all this data in real-time is
bound to be murder on battery technology
that’s already showing wrinkles. 

For now, we must content ourselves with
GPS and (ugh) Wikimapia.

nimish.chandiramani@thinkdigit.com

Beyond The Cell Phone

While the cell phone is the prime candidate for any experiment 
with context awareness, it isn’t alone. At CeBIT 2007, we saw NEC’s

Dew concept camera that you can wear around your neck while it
monitors your mood using the tone of your voice. If it detects
happiness, it takes a picture, saving your happy moment forever (or till
its memory runs out). 

Closer to the shelves, we see the Sony CyberShot T200, which has a
“Smile detection mode”, which, well, detects smiles. Switch the camera to
that mode, place it wherever you want, and it’ll take a photo every time a
smiling face is in its frame.

Magitti’s user interface on a Windows Mobile-based
phone
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Take a Crack 
and win
Developing Software
for Symbian OS
by Steve Babin

Published by

Rules and Regulations
Readers are requested to

send in their answers by the
15th of the month of
publication.

Employees of Jasubhai
Digital Media and their
relatives are not permitted to
participate in this contest.

Readers are encouraged to
send their replies by e-mail.
Jasubhai Digital Media will not
entertain any unsolicited
communication.

Jasubhai Digital Media is
not responsible for any
damage to your system that
may be caused while you are
trying to solve the problem.

Solution To Last Month’s Challenge
The method of making the cosmetic
modifications to the Desktop Settings is by
editing the Shell32.dll file, present in
the SYSTEM32 directory (usually
C:\Windows\System32). This file can be
edited by Resource Hacker. Make sure that
you backup the Shell32.dll file, because if
something should go wrong, you may not
be able to boot into Windows and will have
to repair or reinstall it. Also make sure you
exit any unwanted applications before 
you continue. 

Step 1:
Download
Resource Hacker
from
http://www.soft32
.com/download/63-
59509/
ResHack.zip. Just
extract it and
open the
ResHacker.exe
file.

Step 2: Go to File > Open >
C:\Windows\System32\shell32.dll

Step 3: Go to Dialog > 29952 > 1033

Step 4: In the right hand pane replace the
text with the following.

29952 DIALOG 0, 0, 252, 218
STYLE DS_MODALFRAME | DS_NOIDLEMSG |
WS_POPUP | WS_CAPTION
CAPTION “Desktop”
LANGUAGE LANG_ENGLISH,
SUBLANG_ENGLISH_US
FONT 8, “MS Shell Dlg”
{

CONTROL “Bac&kground:”, 30056,
STATIC, SS_LEFT | WS_CHILD |
WS_VISIBLE | WS_GROUP, 35, 1, 50, 8 

CONTROL “List Of backgrounds”,
30048, “SysListView32”, LVS_REPORT |
LVS_SINGLESEL | LVS_SHOWSELALWAYS |
LVS_NOCOLUMNHEADER |

LVS_NOSORTHEADER | WS_CHILD |
WS_VISIBLE | WS_BORDER | WS_GROUP |
WS_TABSTOP, 131, 3, 119, 212 

CONTROL “&Browse...”, 30049,
BUTTON, BS_PUSHBUTTON | WS_CHILD |
WS_VISIBLE | WS_GROUP | WS_TABSTOP,
35, 122, 50, 14 

CONTROL “&Position:”, 30055,
STATIC, SS_LEFT | WS_CHILD |
WS_VISIBLE | WS_GROUP, 37, 148, 50,
8

CONTROL “”, 30051, COMBOBOX,
CBS_DROPDOWNLIST | WS_CHILD |
WS_VISIBLE | WS_VSCROLL |
WS_TABSTOP, 37, 158, 50, 38 

CONTROL “&Color:”, 30057, STATIC,
SS_LEFT | WS_CHILD | WS_VISIBLE |
WS_GROUP, 37, 177, 50, 8 

CONTROL “”, 30054, BUTTON,
BS_OWNERDRAW | WS_CHILD | WS_VISIBLE
| WS_TABSTOP, 37, 187, 50, 13 

CONTROL “”, 30053,
“BackgroundPreview2”, 0x50020000, 4,
12, 125, 107 

CONTROL “Customize &Desktop...”,
30050, BUTTON, BS_PUSHBUTTON |
WS_CHILD | WS_VISIBLE | WS_GROUP |
WS_TABSTOP, 18, 200, 90, 14 
}

Alternatively, you can just use the mouse
to drag, place and resize the elements in the
preview window to make the changes.

Step 5: Now click on Compile Script

Step 6: Save and
replace the file.
You may be
prompted to
insert the
Windows XP CD;
ignore it. Close
the Resource
Hacker.

Step 7: Restart
Windows. Open the
Desktop Properties
and you will see that the changes that you
had made have taken effect. 

THIS MONTH’S CHALLENGE

Ankita Shalin
Patna

LAST MONTH’S WINNER

How would you modify your
Experience Ratings in
Windows Vista to reflect a
higher performance?

Send in your solution with
the subject “Take a Crack”,
and your postal address, to
takeacrack@thinkdigit.com

Fake Your
Vista Experience
Rating

Rearrange The Elements Of Your Desktop SettingsLAST MONTH’S CHALLENGE
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The Display Properties
window after modifications

The original layout of the
Desktop Properties window

Win!
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Rossi Fernandes

Photography is much more than setting that 
brand new camera of yours to “Auto” and 
going about clicking photos of anything or 

everything you lay your eyes on. Anyone can do 
that! Photography is an art—more so the camera 
is the brush when put in the right hands—yours. 
You don’t have to own a high-end camera to get 
those jaw-dropping snaps. Digital cameras are 
tools that need to be explored thoroughly before 
you can capture those Vogue shots. 

While fiddling with the camera, as most 
newbies do, get familiar with all the menus. 
Start off by using different settings, and taking 
random shots after varying each setting. 
Rome wasn’t built in a day, and you will not 
become the greatest photographer over-night. 
But remember, when those friends of yours 

Enhance

There’s more to photography than setting your camera to “auto”—
photography is an art—in fact it is the brush used by the artist—you

Know Your Camera

Technology For Personal And SoHo Productivity 

drool over that awesome snap you captured 
while on that trek or that memorable trip, 
it’s worth every effort! You’ll be surprised by 
some of the results you get from doing this 
and how better you can get.

Before you actually get out there and buy 
one, let’s brush up on what kind of camera you 
should go for if you don’t own one yet. You can 
always refer to our Digital Camera test in the 
October 2007 issue. 

The simplest cameras are the point-and-
shoot cameras, which make up for the largest 
chunk of cameras sold. SLRs are generally best 
for enthusiasts and professionals. When you’re 
selecting a point-and-shoot (P&S) camera, try 
and have as many manual controls and settings. 
That way, you have lots of settings to play 
around with, rather than the camera doing 
it for you. After all, you and your friends are 
going to cherish the photos, not the camera! A
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unrelated settings. Therefore, take some time 
out to go through the menus and set a suitable 
white balance before taking a shot... err... in the 
dark! D-SLR users on the other hand have the 
freedom to change the white balance of a photo 
after it has been shot—thanks to RAW—data 
which you can read about later in this story.

Focus Modes
Cameras today come with focus modes meant 
to improve on the autofocus features seen in all 
P&S cameras. Some cameras come with multi-
spot focussing features, which focus on multi-
ple spots or jump spots in a scene. This way, 
the user loses control over what’s constantly 
in focus. You should, therefore, ensure the use 
of the centre focus or the spot focus, which 
focuses on a small spot at the centre of the 
scene. This ensures that whatever you’re point-
ing the camera at, comes out perfectly in focus. 
If you want to focus on something that’s not 
at the centre, then point the camera at the 
subject and half press the trigger button then 
point the camera anywhere you wish. When 
ready, complete the click to take the shot. If 
your P&S camera has a manual focus, then you 
get increased flexibility and your shoots yield 
amazingly professional results.

ISO Rating
The ISO ratings in a camera are related to the 
sensitivity of the sensor. They’re considered simi-
lar to the film speed on film cameras. Changing 
the ISO ratings is useful for low light situations 
or to get the best quality images. Dropping the 
ISO number to the least possible value, say, 
ISO 100 or ISO 80 will get the best quality out 
of a sensor. However, this requires a well lit up 
scene and is best for studio light setups or broad 
daylight. On the other hand, for darker places, 
increasing the ISO number will help but images 
will turn out grainy. For best results in such 
cases, a good balance between the ISO ratings, 
aperture size and shutter speed is required.

Flash Settings
Cameras have some control over the intensity of 
the flash used. The Fill in flash mode is a moder-
ately powerful flash that is used to add some 
lighting in darker areas. This is useful when 
your subjects have a shadow cast on their face 
and the filling light can illuminate such areas. 
The other option for the flash that you might 
find is the Slow Sync mode. This mode is espe-
cially useful in poorly lit up areas, where the 
flash is required. The Slow Sync feature allows 
some detail to be added to the shot where a 
normal flash would result in sharp shadows and 
everything beyond the target to be completely 

Manual focus, manual settings for aperture 
size and shutter speed are some features you 
should definitely look out for. 

Introduction
There’s a fair share of terminologies you need 
to get familiar with, in order to get involved 
in digital cameras and photography. You will 
get a fair dose of it here. The aperture is the 
gap through which light enters the camera, 
and plays a major role on how much light is 
allowed. The aperture size is decided by the f 
number. The smaller the f number, the greater 
is the aperture size and vice-versa. Generally, a 
small aperture yields crisp images. The shut-
ter speed, also, goes hand-in-hand with the 
aperture size to allow an optimum amount of 
light to enter the camera. The faster the shut-
ter speed, the lesser the light that enters the 
camera and crisper are the resultant images. 
Some cameras even allow you to set a fixed 
aperture size or shutter speed while the camera 
adapts the other settings.

Exposure Metering Modes
Your digital camera senses light intensity in a 
scene and chooses the appropriate settings for 
it. In most cameras, there are multiple modes by 
which the camera can detect the surrounding 
light. This light measuring can be done through 
a single tiny spot in the centre or the entire 
screen. Sometimes, if only the centre of a scene is 
a bright colour—say someone’s white shirt, then 
the camera might be fooled into thinking that 
the entire scene is well lit-up—the image, as a 
result might turn out pretty dark. In such cases, 
switching the exposure mode to screen mode 
can help, so that the entire view is evaluated for 
the surrounding lighting conditions and a more 
realistic and natural photo is captured.

White Balance
Each lighting source—a bulb, tubelight or the 
sun, for example—has a colour temperature. 
White Balance is a neglected option in the 
camera (yeah... the term sounds familiar!) and 
most people unknowingly continue using Auto 
White Balance. AWB chooses a white balance, 
which it thinks suites the scene. The camera gets 
it wrong a lot of times and photos then end up 
with an odd colour tint. You can get awesome 
results by simply selecting the appropriate white 
balance for the type of lighting you are in. 
Selecting from among the pre-defined profiles 
given with your camera, changes a lot of other 

A RAW image is an untreated or uncompressed file that is usually found on 
D-SLR’s and many choose to call it the D-SLR’s equivalent of a negative 

film. Changes, if required, can be done through software that can handle 
RAW images like Photoshop for example. The unfortunate part is that P&S 
cameras don’t support RAW files. In general, these are much larger than 
JPEGs. RAW is of utmost most significance for the professionals.

What is RAW and why the fuss?

A higher ISO Rating adds a considerable amount of graininess to the photo



40 DIGIT march 2008

Digital Tools l Enhance

darkened out. The drawback in this is that you 
need to use a tripod or hold the camera really 
still while using this feature. Now you know 
why pros move around with those tripods!

Scenarios
Outdoor Photography
Outdoor locations are probably one of the 
easiest options to capture great snaps. There’s 
plenty of light and with cloudy skies, it gets 
even better. If there’s ample sunlight, then you 
need to crank up all the settings. The same goes 
with indoor shoots with decent lighting. Drop 
the aperture to the minimum—F8 or as high an 
f-number as your camera can go. Turn the ISO 
level to as low as possible and the shutter speed 
to the bare minimum. While you’re doing all 
this, keep an eye on the EV-rating number on 
the screen. Think of it as a reference value 
for getting the perfect exposure. Preferably, it 
should be 0, but if you see your images getting 
underexposed, you’ll find the number drop-
ping below 0. In such cases, you’ll need to 
compensate by either increasing the aperture 
size or turning down the shutter speed down a 
little, say 1/125th from 1/1000th. 

There are a few other things you need to 
keep in mind—avoid shooting directly towards 
the sun. An obvious problem is that the expo-
sure level will go completely off scale. By all 
means, you’ll mostly end up with a very bright 
afternoon sun and everything else underex-
posed. That would mean day and night all in 
the same photograph!

Indoor Photography
Shooting indoors can get a little trickier. During 
the day, there is a fair amount of ambient light 
and it’s a good idea to take photos near windows. 
Do refrain from using the flash at all costs—it 
ruins photo—you lose natural colours, and the 
photos get unnecessarily increased contrast with 
sharp shadows. There’s also the issue of back-
grounds going dark with only the closer objects 
getting illuminated. If possible, purchase a  
powerful flash that can be attached to your 
camera. This is very rare in P&S cameras.

The other issue is that without a flash, you 
will have to set the camera to use largest aperture 
size, the highest ISO number and a manageable 
shutter speed. A longer shutter speed will sadly 
result in very blurry photos which we all dread 
the most. If you’re shooting static objects and not 
people, then a tripod is a good investment. 

Action Shots
Action photography could be shots taken during 
a cricket or football match or maybe photos of 
vehicles zooming by. In such cases, it’s neces-
sary to keep the shutter open briefly but not 
too short because we want to capture the tiny 
bit of motion blur. If you’re trying to shoot a car 
passing by, then try and follow the car very accu-
rately by moving your hand sideways. Be sure to 
focus the car properly so the car itself appears 
sharp but the surroundings come out with some 
amount of motion blur as a result of your hand 
movement. Lower aperture sizes help too.

Low Light And Night Shots
Low light photography is tricky, and it’s a must 
to own a tripod. No amount of change to aper-
ture size and ISO levels is going to prevent you 
from having to use long shutter speeds. Shots 
of city skylines can be taken by mounting the 
camera on a tripod, or by using a table or stool 
as a stable base. As mentioned earlier, to get 
decent shots in the dark without the use of 
tripods, you must get a powerful flash that can 
illuminate larger areas.

Macro Shooting
Macro shots involve close-ups. Firstly, set your 
camera to the macro mode and then get as close 
as possible to your subject. Nevertheless, don’t 
get too close or your camera would lose focus 
of the subject. While taking macro shots, you 
can get that authentic look with some depth of 
field blurring. This has to be done by increasing 
your aperture size e.g., f 2.8 or so. Using manual 
focus if available, you can focus onto one specific 
region of the object and have the rest blurred. 
Zoom is generally a bad idea.

Portrait Photos
A larger aperture size blends better with 
portrait photos by giving great soft focus shots. 
In portrait shots, we generally want the subject 
to appear fairly sharp and the background to be 
blurred out. Set your aperture to as low as your 
camera can go. Your subject should be posi-
tioned a little away from the background. Too 
close and the background could get blurred. 

There are many more things that can be done 
with digital cameras—such as HDR Photography 
and Panoramic images—you can find them in 
our Tips & Tricks in the October 2007 issue 
of Digit. Once familiar with the settings, you 
should be able to set your camera as per the 
ambience and lighting available to you.   

rossi.fernandes@thinkdigit.com

Digital Cameras may be less mechanical and complicated, but they 
still ought to be handled with the same care. It’s a good idea to buy a 

compact pouch or case for the camera. Also, get a carry bag for your camera 
where you can dump all your batteries, cables and charger when you go out 
on vacations. A UV filter is a good way to prevent your lens from getting 
scratched and dirty. If you do get any dust on it, use a cloth as a last resort—
try blowing some air on it instead. To avoid any accidental physical damage, 
make use of the supplied hand-strap or neck-strap and wear it at all times. 
The screen on a digital camera is similar to your mobile phone, and requires 
some cleaning from time to time. Use a micro-fibre cloth to clean it. Avoid 
using any chemical-based solution for cleaning.

Camera Care

  Wrong white balance settings can give very odd colours
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After some delays the
EeePC was officially

launched here in India.
The EeePC is a laptop

with a 7-inch screen that’s
powered by a mobile Intel
Celeron 900 MHz processor,
512 MB of memory,
Xandros—a Linux distribu-
tion—as the OS. The interface
has been customised with
the most essential applica-

tions neatly sorted into cate-
gories. This makes the EeePC
extremely easy to use, even
for people who have never
used a computer before. 

The keyboard layout is
compact and the keys and
touchpad are smaller than
conventional laptops. Those
used to normal laptops and
desktops will find the ASUS
EeePC slightly painful to

use. The build quality of the
keyboard and the screen
hinge is a lot better than
we expected. The inbuilt
WiFi (802.11b/g) and
10/100Mbps LAN port take
care of connectivity. 

So what’s not to like?
There’s no optical drive, so
installing applications is
going to be a bit of a
problem. You can’t upgrade
the inbuilt memory either.
As for hard drives, we got the
4 GB version, but 2, 8 and 16
GB versions are available as
well. Windows versions of
the EeePC will be launched
soon. The laptop is silent, but
heats up after a while.

ASUS might promote the
EeePC as a children’s PC,
something like the OLPC, but
we’re thinking ultra-
portable! Since regular lap-
tops with 80 GB drives and
standard screens are avail-
able for around Rs 22,000,
and ultra compact laptops
cost over Rs 75,000, the ASUS
EeePC might fill a void here.
At Rs 18,000, it’s a steal for
something that weighs
under a kg—as long as you
don’t plan on playing games
or watching HD movies on it.

Specifications
Intel Celeron-M 900MHz, 512MB
DDR2, 4GB flash drive, 7-inch
screen (800x480), 10/100Mbps
Ethernet, 802.11b/g WLAN,

The eSys Sub 10K Fighter
PC is a minimal desktop

PC that is aimed at people
with the most basic of
needs. The configuration
of the PC isn’t hot—no
dual-core processors or
even an entry level
graphics card on it. The
processor is a 939-pin AMD
Sempron 3000+ on a VIA
K8M800-based
motherboard that has
everything integrated. 

The performance is as
low as we expected—
3DMark 2005 churned out
a score of 1618—pathetic.
Even a basic PCI-E graphics
card would have helped—
and the motherboard only
has an AGP slot for
expansion. HD (1080p)
videos were unwatchable,
and the lack of a dual-core
processor means that

video encoding
performance also takes a
big hit—almost double the
time of what an entry
level dual core processor
would take.

The cabinet is fairly
small, but sturdy. Still, it’s
quite obvious that quality
wasn’t the highest priority
when this PC was built. If
looks aren’t important to
you, you will be fine with
the cabinet, but the
monitor will still
embarrass you.

One could use the
“what do you expect

for that price” analogy,
but the bottom line is
that it could use a little
design love.

The low price tag of Rs
9,990 makes everything an
acceptable compromise,
especially for those who
do nothing but chat,
e-mail and surf all day,
or for schools and
educational institutions.

Specifications
AMD Sempron 3000+, 512MB
DDR400 RAM, Onboard VIA
S3G Unichrome Pro IGP, 120GB
Seagate Baracuda HDD, 15”
CRT monitor.

Contact: ASUS Technology Pvt. Ltd. 
Phone: 022-67668800
E-mail: media_india@asus.com
Web site: http://in.asus.com/ 
Price: Rs 18,000

We test the latest hardware
and software products 
available in the market

Feature  
Performance
Value for Money
Build Quality
Overall 

RATINGS

eSys Sub 10K Fighter PC
One PC Per Child Anyone?

ASUS EeePC
Tiny But Functional

BazaarBazaar

Contact: Esys Information
Technologies Ltd 
Phone: +91-9313890776
E-mail: ankurjain@esysmail.com
Web site: www.esys.in 
Price: Rs 9,990

Features
Performance  
Build Quality
Value for Money
Overall 

RATINGS

The Samsung NV8 is the
younger sibling of the

NV10 that we tested in
October 2007. This is an 8
MP camera with 3x optical
zoom, and looks and feels
exactly like the NV10. 

The interface on the
camera is simple to use,
and is controlled by the
touch sensitive buttons on
either side of the screen.
They’re easy to use, but
take a little getting used
to. The camera has a rough
matte finish with a 2.5-
inch screen.

Image quality is also
very similar to the NV10.
The clarity and crispness is
there, and higher ISO
levels give out a little grain
in the image. The colours
aren’t very vibrant, and
have a washed look to
them—especially in
outdoor lighting.

Indoor shooting is a
different story altogether,
and the NV8 seems to be

better indoors than
outdoors. You can get
macro shots from up to 4
cm away with good results.
The video quality is good,
and the same macro
feature works for videos
as well. Video resolutions
are 640x480 and 320x240,
and are saved as AVIs
using MPEG4 codecs. The
audio bitrate is 64 kbps,
though the quality is
nothing special.

Face detection and
image stabilisation are
present as features, but
image stabilization only
kick in when you turn the
mode knob to ASR
(Advanced Shake
Reduction). If you use ASR

for videos, a small area of
the capture is cropped.

This camera is pretty
much the NV10 with a
lower MP rating. This
average performing camera
is priced at Rs 13,990, and
to be frank, there are better
cameras available in the
same price range.

Specifications
8.1 Megapixel (3264 x

2448px), 2.5” screen, ISO
Rating: 100—3200, Shutter
speed range: 1/1500th sec—
15secs, Dimensions: 96.5 x 60
x 18.6mm, Weight: 151.7gm.

Samsung NV8
NV10’s Little Brother Is Here

Contact: Samsung India Electronics
Pvt. Ltd.
Phone: 011-41511234
E-mail: jitender.c@samsung.com
Web site: www.samsung.com/in 
Price: Rs 13,990

Feature  
Performance
Build Quality
Value for Money
Overall 

RATINGS

Every company has a touch
screen operated phone

and the KU990 is a 3-inch, 3G
touch screen phone from LG.
The metal plate and the
glossy front with chrome bor-
ders give the phone a stylish-
yet-sturdy look.

You will soon realise that
the main menu interface
looks and feels a lot like the
HTC / iPod Touch and
iPhone. You can use either a
finger or stylus to slide
through menus. There’s no
place to store the stylus on
the phone though. 

There aren’t too many
buttons on the phone, prima-
rily because of its touch
screen functionality. There is
a jog dial on the back of the
phone around the camera
lens which can be used to

scroll through items or
change sound volumes.
However, this is inconvenient
to use, and scrolling through
menus using it is especially
difficult. Scrolling using the
touch-screen is a little cum-
bersome as well—those with
shaky hands might acci-
dently launch an application
off and on. There’s a full key-
board on the touch-screen,
and it works well with either
your fingers or the stylus—
our only complaint is the
awkwardly-placed spacebar. 

There is a 5 MP camera
with a flash, and a standard
VGA camera for video calls.
The 100 MB internal memory
is paltry, but can be sup-
ported by the Micro SD card
slot. The earpiece is perfect,
but the microphone quality
is strictly average—expect
some minor crackling. The
speakerphone is fine, but
gives out a high shrieking
sound at times. The ear-
phones that are bundled
with the phone... err... just
get the job done.

Great looks, a fun UI
and ease of use make this a
good phone. The touch-
screen could have been
better, and the jog dial is
just bad. At a price of
Rs 21,900, it’s a good style
statement.

Specifications
3-inch screen (240x400), 5 MP
Camera, 100 MB memory,
MicroSD slot, Dimensions: 103.5
x 54.4 x 14.8 mm, GPRS, EDGE,
3G HSDPA, Bluetooth.

LG KU990 Viewty
LG Touch?

Features  
Performance 
Build quality
Value for Money
Overall 

RATINGS

Contact: LGEIL Pvt. Ltd
Phone: 91-120-2560900
E-mail: viveksingh@lgindia.com
Web site: www.lgindia.com
Price: Rs 21,900 
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Steelseries, like Razer, are
known as dedicated

professional gaming
hardware manufacturers.
One of their latest
contributions is the Ikari
Optical Mouse and the 5L
mousepad.

The mouse uses an
optical sensor that has a
resolution of 400 to
1600dpi. The mouse tracks
well, and is a little better
than the Logitech MX518. It
has four huge feet that
allow it to slide around
easily on any surface. 

The wide shape of the
mouse suites those of you
with larger hands, and
you’ll be able to rest your

entire palm on the mouse.
The finish of the mouse is
similar to the MX518—a
glossy plastic centre and an
anti-bacterial matte finish
on either side. It’s lighter
than the MX518, but more
reactive in-game.

Other than the 3
standard buttons, there is a
button on top that switches
the dpi. We did have some
problems with the
buttons—the left click kept
getting stuck. The dpi
toggles between two
settings that need to be set
using the drivers. There’s
not much of a choice
though—400/800, 400/1600
and 800/1600 dpi are the
only profiles you can
choose from. Switching
between DPIs takes a

second or two, so it’s not
something you can do

during a game. 
We used the

Steelseries 5L along
with the Akari
Optical and it
performed very
well. The surface is
very smooth and it

works well with any mouse.
The only issues with it are
that it does get dirty pretty
fast, and the edges around
it are a little sharp. It’s also
a hard pad so it’s not
something you can roll up
and carry with you. At Rs
2,849, only those who
consider themselves
professional gamers, or
those with money to blow
will buy it. For plain
performance, we give it a

rating of 4/5.
The Steelseries Akari

Optical is an expensive
mouse as well—Rs 4,249.
The tracking is excellent,
but the benefits of using
such a mouse might not
justify the price you pay 
for it.

Specifications
Sensor resolution: 1600dpi,
Polling rate: 1000Hz, 5 buttons,
2m braided cord

The Odyssey Internet
Multimedia Keyboard

Mouse is a wired optical
mouse and a multimedia
keyboard combo.

The keyboard has a
standard layout, and the
keys don’t offer good
feedback. It has
multimedia keys to control
your browser and other
multimedia applications,
though funnily, the volume
controls are placed near
the directional arrow keys.
The keyboard comes with a
detachable palm rest, but
attaching the palm rest
takes some doing, while
removing it is just
downright painful.

The mouse is a PS2
mouse, so tracking is
nowhere as smooth as

high-end gaming mice, or
even USB ones. The mouse
is sturdy though, and has a
glowing blue scroll wheel

that has a good feel, but
not enough feedback when
scrolling.

The shape of the mouse
is actually pretty
comfortable to use, and
bumping the refresh rate
to 200 cycles a second
improves the performance
a tad.

At Rs 400, this keyboard-
mouse combo is dirt cheap.

Unfortunately, that’s all it
has going for it. Bottom
line? An acceptable
keyboard but a terrible
mouse.

Steelseries Ikari Optical Mouse and Steelseries 5L
Steal-series It’s Not!

Contact: Compuage Infocom Ltd. 
Phone: +91-9212100193
E-mail: info@compuageindia.com
Web site: www.compuageindia.com 
Price: Rs 400

Features  
Performance
Value for Monery
Build quality
Overall 

RATINGS

Features 
Performance
Build quality
Value for Money
Overall 

RATINGS

Odyssey Internet Multimedia Keyboard-Mouse
Nothing Special

Contact: SteelSeries ApS / Vstreet
Netserve Pvt. Ltd. 
Phone: +91-79-40020127
E-mail: sales@v-street.net
Web site: www.v-street.net 
Price: Rs 4,249
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Zenith has launched three
affordable laptops for

entry-level consumers and
students: Admirale, Director
and Presidio. The cost cutting
is evident from the start—this
Santa Rosa laptop has a low-
powered Intel T2310
processor running at 1460
MHz. The 2 GB of RAM is a
pleasant surprise in an entry-
level laptop. The lustrous
grey body looks good and is
rugged; even the hinges seem
strong and the single latch
on the lid allows you to open
it with one hand.

The 14.1-inch display is
one of the dimmest TFTs we
have seen. Forget outdoors,
you may have difficulty
viewing it indoors if the
room is brightly lit. 

The keypad is spacious
and comfortable, and the
keys offer good feedback.
The touchpad is good too,
and we have no complaints.
Movie playback is good,
and the speakers produce

clear sound, though not
particularly loud. The dim
TFT subtracts from the
movie experience
obviously. TV-out and D-Sub
ports will let you show
your presentations on
bigger screens.

It’s obvious that the
laptop is aimed at the office
segment, and it does well in
this regard. The batteries
lasted for 2 hours 43
minutes in our battery
drain test, which is pretty
good. It should last a lot
longer if office applications
are all that you will use.

Windows Vista Starter
Edition is the OS loaded,
and it runs well thanks to
the 2 GB of RAM. If needed,

you can easily upgrade to a
more powerful version of
Vista. An integrated Web
cam would have been a
worthwhile and inexpensive
value-add, and could have
found use for office
applications such as video
conferencing. 

At just Rs 27,990, this
laptop strikes the right
balance between price,
performance and
portability, and we
recommend it for office
work. If you look hard
enough, though, you could
find better bargains.

Specifications
Intel T2310 Dual Core processor-
1460 MHz, 533 MHz FSB; 2 GB
667 MHz DDR2 RAM @533 MHz;
120 GB hard drive; DVD Writer;
14.1-inch WXGA monitor,
Resolution: 1280x800;
Connectivity: Gigabit LAN, 56
Kbps Modem, WiFi 802.11g; SD
memory slot; Bundled OS:
Windows Vista Starter Edition

Zenith Admirale
The Value Laptop For Office

Contact: Zenith Computers Ltd 
Phone: 022-28377300
E-mail: info@zenith-india.com
Web site: www.zenith-india.com
Price: Rs 27,990

Features  
Performance 
Build quality
Value for Money
Overall 

RATINGS

Transcend’s T.photo 710
is a 1 GB photo frame

that looks like any other
photo frame, but there’s
more to it.

The T.photo 710 is a
fairly stylish looking frame,
with a design that’s not too
modern or too classic. The
7-inch TFT display is sur-
rounded by a transparent
border with an accented
outline. It must be said
that the frame itself is
quite large. You can hang it
on a wall or place it on a
table or shelf. 

There is 1 GB of
onboard memory, and you
can also use SD, MMC,
Memory Stick,
CompactFlash or even USB
Flash drives, so there’s no
real limit to how much
media you can use on it.
You can also connect your
PC to the photo frame and
directly dump your media

on to it like you would
with any other drive. It’s
not just photos that you
can use the T.photo 710
for—it can also be your
music player. It has inbuilt
speakers for that, as well as
a headphone jack, should
you want to 
connect headphones or
your speakers to it.

The interface is
colourful, and using the
frame is simple as today’s
PMPs. The remote control
works fine up to a distance
of 10-12ft. The transition
from one image to the
other isn’t as reactive as
you’d want it to be espe-

cially when you’re using
manual controls on the
remote to browse through
large JPEG images taken on
your camera for example.
The quality of the screen
also is pretty good with
wide viewing angles.

There’s one issue with
the photo frame though—
there’s a thick power cable
that ruins its elegance—a
battery powered, thinner
frame and a larger screen.
At Rs 6,000, the price seems
just right, considering you

have a remote controlled
photo frame that’s also your
music player and your
alarm clock.

Specifications
7-inch TFT screen, 1GB internal
memory, D/SDHC/MMC/MS/CF
Cards/USB Flash drives
supported

Features  
Performance 
Build quality
Value for Money
Overall 

RATINGS

Contact: Supertron Electronics Ltd. 
Phone: 23881397/23881924
E-mail: info@supertronindia.com 
Web site: www.supertronindia.com 
Price: Rs 6,000

Transcend T.photo 710
The Photo Frame Just Went Digital
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Not everyone wants to
play games, and the

performance you can get
out of today’s PC is a lot
more than required for
basic office applications
and movie playback, for
example. AMD believes it’s
time for cheap and
quiet low-power PCs to
make their mark and
they’ve been pushing
hard for it. 

The DTX system
uses a dual-core
Athlon X2 BE-2350.
The machine that we
tested came with 1 GB
of RAM and an
onboard graphics
solution. The entire PC
was housed in a
compact case with all
the bells and whistles.
No PS2 ports on this
machine, so you will
have to use a USB
keyboard and mouse. 

To keep it quiet, the CPU
fan has been surrounded by
a thick foam packing. The
size of the motherboard
itself is a tad smaller than
the standard Micro-ATX.
Even the hard drive is
mounted vertically next to

the memory card reader
and optical disc drives.
Things do tend to get hot
because of the cramped
layout, though.

In encoding tests and
general synthetic tests on
SiSoft Sandra, results were
average. The advantage of
using a dual-core processor
was obvious as well—it ate
through the 1080p HD

clips that we threw at
it. This setup isn’t cut
out as a gaming PC at
all—Doom 3 struggling
at just 20fps at 800 x
600 and medium
settings. The
performance in Far
Cry was a little better at
40fps at minimum
settings, but gaming
really isn’t going to be
its forte.

As power efficient,
quiet and cheap
machine, it has
everything going for it
especially when there’s
support from a large
number of hardware

manufacturers. There’s also
a growing demand and
trend in compact form
factors as people start
moving their PCs into their
living rooms. If AMD is to
market this product as an
entry level PC or an HTPC, it
has everything necessary to
be a possible hit if they
keep the price around the
Rs 10,000 mark.

The ASUS 8800GT is like
any other 8800GT, except

this one has been filled to
the brim with a whopping 1
GB of memory. This isn’t
the only 1GB card to come
to our labs—the Palit
8500GT was another one,
but didn’t quite outperform
the other 8500GT-based
cards. Could it be a similar
fate for this card?

First things first—the
1GB card doesn’t come with
the standard NVIDIA cooler:
it’s been replaced by a
much more robust and
chunky cooler and an
equally good fan. There’s no
cooling for the memory,
though. Overall, it’s very
quiet and runs just fine

with temperatures hovering
around the 50º C mark.

Even with FSAA turned
up to 4x and Antistrophic
filtering to 8x, we were able
to very respectable frame
rates in Company of Heroes,
F.E.A.R. and Doom 3, but the
frame rate was only
fractionally more than the
standard 512 MB 8800GTs.

The ASUS 8800GT 1GB
comes with no bundled
games, and at a price of Rs
18,900. It’s evident that

there are no clear benefits
from using the much large
frame buffer. If you have set
a higher budget for a card,
then this 8800GT 1GB could
be worth it—if you can get it
for around Rs 15,000 in the
market. Anything over that,
and you’re better off saving
for a 512 MB 8800GTS.

Specifications
GeForce 8800GT, 1GB DDR3,
PCI-E 1 and 2 supported,
DirectX 10 complaint, Shader
Model 4.0 supported

ASUS EN8800GT 1GB
An 8800GT With The Ultimate Top-up Plan!

AMD DTX form factor
The Environment’s New Green Buddy

Contact: ASUS Technology Pvt. Ltd. 
Phone: 022-67668800
E-mail: Media_india@asus.com
Web site: http://in.asus.com/
Price: Rs 18,900

Performance  
Features
Bundle
Value for Money
Overall 

RATINGS
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The MP610 is the latest in
the PIXMA range of inkjet

multifunction devices from
Canon. Successor to the
feature rich PIXMA MP600,
the new device boasts of
significant upgrades to the
scanner unit. 

Like previous MFDs from
Canon, the MP610 has dual
paper feeding mechanisms—a
top-loading tray at the back
and the bottom cassette.
Both these trays can hold a
maximum of 150 sheets. The
paper-feed selector switch on
the top can be used for
selecting either tray.

On the front, above the
scanner unit, a fold up tilting
panel has a 65mm TFT
display and the button
console. The TFT display is
crisp and can easily rival any
high-end cell phone screen.
The control buttons are
logical, and the command
wheel is easy to use.
Browsing the menu is
intuitive, thanks to the

command wheel. The card
reader is located just besides
the output tray and it accepts
almost all types of memory
cards except for xD card; bad
luck if you own Fuji or
Olympus cameras. 

The MP610 takes five
cartridges and they clip on to
the head assembly. These
cartridges are illuminated
Red when clipped properly
into place. It features USB 2.0
and the port is located at the
back of the machine. 

The MP610 raced though
the speed test and delivered
the first print within 10
seconds. For the combi-
document, it took around 34
seconds on normal printing
quality and 50 seconds when

taxed with best quality. Our
photograph was printed in 70
seconds—relatively fast. On
the quality front, the MP610
is very similar to other
PIXMA printers—sharp text
and negligible feathering.
Photographs were stunningly
reproduced—colour rendition
was spot on. 

The scanner is fast—
preview times really amazed
us, and scanning is equally
fast too. The quality at 300
dpi was good, though details
have an over-sharpened feel
to them. Copying is fast
thanks to the brilliant
printer and scanner unit. 

At Rs 17,995, the MP610
is reasonably priced for the
features and performance
on offer. 

Specifications
Thermal Inkjet, 300 paper
capacity, 2400 x 9600 dpi print,
14 PPM, five separate ink tanks,
4800 x 9600 dpi scan, copy
without PC, SD/MMC,MS, CF
support and auto-duplexer. 

Canon PIXMA MP610
All-in-One With A Class

Everything seems to be
about saving the

environment these days,
and Western Digital’s latest
drive with the GP badge is
all about green computing.
GP stands for Green Power,
and WD claims these drive
are more energy-efficient.
The one we have for review
is a 1 Terabyte monster. The
drive has been developed to
give as much performance
as possible while keeping
power down, by making
optimum use of the cache
and spin speeds of the
drive. WD claims that the
power consumption for the
drive is 3-4 Watts less than
the others.

Considering this is a
RAID Edition drive, the
performance isn’t near the
best by any standards. Even
the desktop Caviar SE16
drives beat it in many
places. The only place

where the RE2-GP actually
catches up to the Caviar
SE16 is in the SiSoft tests
with data rates sequential
and random file transfers
differentiated by just 1 to
2MBps. HD-Tach also
recorded similar data
transfer rates. In real-world
tests where files were
copied to and from the
drive, the RE2-GP fell
behind other drives.

The temperatures tell
the entire story, though.
Just by feeling the drives
we were using, it was clear
the RE2 GP drive was
considerably cooler. At
around 40 degrees C, the
WD RE2 GP ran some 7

degrees
C cooler
than the
others after some
intensive
benchmarks—which is
a lot. It is also very quiet,
and the sound of the drive
itself is drowned out by
any fast fans that may be
running—such as the
graphics card fan.

The RE2 series isn’t
aimed at the desktop
market. The price for the
drive is Rs 17,000, which is
a whole lot more than a
standard 1 TB drive. The
performance is above
average, but if low
temperatures, reliability
and low noise emissions are

necessary, it’s something
you would want to buy—but
it’s still is too costly to
consider for home use.

Specifications
Capacity: 1 TB, 16 MB Buffer,
SATA-II Interface, Perpendicular
recording

Western Digital RE2-GP WD1000FYPS
Going Green Is Costly!

Contact: Western Digital
Phone: 9321029204
E-mail: amarjeet.singh@wdc.com
Web site: www.wdc.com
Price: Rs 17,000

Contact: Canon India Pvt Ltd
Phone: 1800-345-33-66 
E-mail: info@canon.co.in
Web site: www.canon.co.in
Price: Rs 17,995

Features
Performance
Ease of Use
Value for Money
Overall 

RATINGS

Features
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Value for Money
Overall 

RATINGS

Samsung’s SCX-4500 is a
multi-function device

(MFD) that doesn’t look like
one. The paper cassette has a
miniscule 100-sheet capacity;
this eliminates the of SCX-
4500 as a shared office
resource. The detachable
output tray can hardly hold
any pages. There are very few
buttons on the top, and all of
them are touch operated. The
LED display offers limited
information, and general
errors such as paper empty,
paper jams are indicated via
red glowing icons. 

Installing the toner car-
tridge is simple—a catch
below the scanner deck
opens the cartridge bay and
the slim cartridge fits in with
hardly any effort—good for
non-technical consumers.
Samsung’s ScanThru applica-
tion takes care of setting the
printer on the PC side. It also
has additional features for

built-in OCR, colour correc-
tion, etc. 

Performance-wise, the
SCX-4500 delivered 14 pages
in a minute. Our taxing
combi-document was printed
in 16 seconds—not the fastest,
but not slow at all. Print
quality is typical Samsung—
dark, sharp and crisp. Text is
immaculately reproduced,
ditto with reversed text. The
printer unit reproduced all
hues in the grey scale spec-
trum—quite good from a
laser printer. The copier unit
also performs admirably—the
speed is fast, but quality isn’t
among the best we’ve seen.
The quality of the copy

largely
depends
on the
source—
coloured pages
are copied perfectly,
but black-and-white
pages aren’t reproduced
that well—especially news-
paper clippings etc. The
scanner unit does a decent
job at acceptable speeds.
Edge-to-edge sharpness is
excellent, and details are
well-preserved.   

At Rs 10,999, the
Samsung SCX-4500 is sweetly
priced. This stylish printer
strikes the right chords—you
get a beautiful-looking MFD
that delivers where it mat-
ters. The SCX-4500 is more 

suitable as a
personal MFD or for a

very small workgroup.

Specifications
Mono laser, 600 dpi print, 16
ppm, flatbed scanner, 600 x
2400 dpi scan, copy without
PC, USB 2.0 and Samsung
SmarThru driver

Samsung SCX-4500 
The Black beauty

Features  
Performance 
Build quality
Value for Money
Overall 

RATINGS

Contact: Samsung India Pvt Ltd
Phone: 011-41511234
E-mail: anupam.k@samsung.com
Web site: www.samsung.com/in
Price: Rs 10,999

The Canon PowerShot
SX100 IS is the first ultra-

zoom camera boasting 10x
optical zoom in its compact
body. Touted as the perfect
camera in the hands of any
family member, we found it
to be true—the SX100 IS is
simple to use, and delivers
superb photographs with
minimum tweaking.

The SX100 is relatively
bulky and can only be car-
ried around in a pouch—too
large for any pocket. Similar
to other A-series cameras
from Canon, the SX100 has a
plastic body, however it is
well put together and exudes
a built-to-last feel. Instead of
a five way rocker, the SX100
IS has a rotating click wheel
for browsing the menu—
quite intuitive to use. 

The SX100 IS an 8
Megapixel camera with 10x
optical zoom, face detection
and image stabilisation. The
camera has other features
typical to the A series of
cameras—scene modes,

manual focus, colour swap-
ping, panorama mode and
so on. The 10x optical zoom
combined with an excellent
image stabilisation works
wonders taking distance
shots. The flash on this
camera is simply superb—in
fact, the best flash we have
seen on any point-and-shoot
camera. The SX100 IS uses
AA size batteries—on an
alkaline pair, we got around
120 photographs; using Ni-
MH, batteries we got 400
shots—terrific. The down-
side to the use of AA bat-
teries is the flash recycle
time—painfully long, and
becomes noticeable when
batteries are low. 

Colour rendition is accu-
rate and natural. The camera

performs admirably even in
low ISO settings—we got
excellent photographs even
at 80 ISO.  Higher sensitivity
ISO setting such as ISO 800
and 1600 are completely use-
less—grainy images. 

Working with manual
focus and macro was fun,
and it delivered some really
good shots. The best part
about SX100 IS is the ease
with which anyone can take
good photographs. Video
capture is excellent. A 20-
second video requires 30
MB of space.

Priced at Rs 19,000, the
PowerShot SX100 IS is cer-
tainly expensive in
India. At less than
$300 (Rs 12,000)
abroad, the
camera is a steal
for the features
and performance
it offers. If you
have any friends
coming from

abroad, ask them to get you
this camera.

Specifications
8 MP, 10X optical zoom, Image
stabilization, 2.5-inch display,
Manual focus, Scene modes,
Video capture, SD memory card
(512 MB included)

Canon PowerShot SX100 IS
Easy Snapper!

Features  
Performance 
Ease of Use
Value for Money
Overall 

RATINGS

Contact: Canon India Pvt Ltd 
Phone: 1800-345-33-66
E-mail: info@canon.co.in
Web site: www.canon.co.in 
Price: Rs 19,000

Digital Tools l Bazaar

DIGIT MARCH 200850

Digital Tools l Bazaar

MARCH 2008 DIGIT 51

Bazaar Mar_08.qxp  5/13/2008  11:35 AM  Page 50



The Palit N73PV is a
micro-ATX format

LGA775 motherboard for
Intel processors. It’s based
on the nForce 610i chipset
and uses the GeForce 7100
as the graphics solution. It
has native support or 1333
MHz processors, so the
Core 2 Duo E6x50
processors will run
without the need to flash
the BIOS.

The focus is on being an
entertainment board—it
features a DVI-D port and a
7.1 channel Realtek HD
audio onboard sound card. 

The onboard graphics
solution isn’t great, with
Doom 3 giving frame rates in
the 20s on medium settings
and low resolutions. There
is a PCI-E 16x slot and two
standard PCI slots for any

upgrading that you might
want to do. There are only 2
DIMM slots, which means
you can’t plug in more than
2 GB of RAM.

The layout of the board
is compact, and there are
no major flaws with it. A
graphics card with a large
cooler could render the
adjoining PCI slot useless
leaving only 1 slot for
expansion—a TV tuner card
for example. Luckily, the
SATA ports have no such
issues. The bundle is
extremely basic, and there

is no supplied software
other than the necessary
drivers for the board.

For users who are
looking for performance in
a gaming machine, there
are cheap P35 based
motherboards available
starting from around Rs
4,500 which would make a
better buy than the Palit
N73PV. The price for this
motherboard is a mere Rs
2,950 which makes it ideal
for anyone building a HTPC,
or maybe just a PC for

regular use with an
extremely tight budget.

Specifications
NVIDIA MCP73PV, Upto 1333
MHz FSB, Socket 775, 4 SATA
ports, Realtek ALC883 7.1
Channel Audio, Realtek Gigabit
network controller

Palit N73PV
Aged nForce Powered Entry Level Board 

It’s all afterburners on at
Intel with their

aggressive assault by
releasing the Wolfdale line
of processors. It’s an
unexpected release, and
there hasn’t been enough
action from the AMD
Phenoms that released at
the end of last year. Things
have definitely not gone as
planned. The E8500 is the
spearhead processor of this
new attack early in the
year. One of the biggest
changes in these processors
is the move to 45nm
fabrication process, which
means cooler processors.
The other changes in the
E8500 are the 6 MB L2
cache (up from 4 MB) and
the core speed—a dizzying
3.16 GHz. 

All the synthetic
benchmarks showed the
expected boost in scores.
The real-world rendering
benchmark—Cinebench—
also gave a fairly large
increment in performance
in rendering but the
benefit of the two

additional cores on the
quad core cannot be
matched with a dual core
processor just yet even with
such a fast core. This means
even the low-end quad core
Q6600 shoots ahead in the
rendering and video
encoding tests. For gaming,
the quad core is no match
for the E8500 because
games hardly exploit the
four cores. The
temperature, despite higher
ambient temperatures, was
just around 50 degrees C
after some heavy
benchmark bombardment.

The performance
increase throughout all the
benchmarks from the
E6850 is more or less 10-15
per cent, while the
processors are all priced in
the market at pretty much
exactly the same as the
earlier Core 2 Duos. The
new processors then
become better value for
money. Anyone planning
on upgrading to an E6850
should switch tracks and go
for the E8500 or the other

E8xxx processors—they’re
faster, cooler and much
better bang for the
buck. The games that
make proper use
of quad cores
processors are
still
awaited,
and
until
they
arrive,
the E8500 is
an excellent
choice for gaming
rigs. Prices for the
E8500 should be around
Rs 13,000.

Intel Core 2 Duo E8500
Leader Of The Wolf Pack 

Contact: Tirupati Enterprises
Phone: 09339207519
E-mail: abhishek@tirupati.net
Web site: www.palit.biz
Price: Rs 2,950

Features
Performance  
Bundle
Value for Money
Overall 

RATINGS
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IE 7 AND ADD-ONS

The latest version of Internet
Explorer has significantly evolved
from its earlier iterations with

enhanced features, improved security
and crispier looks.

In terms of extending the features
of the basic browser, IE 7 can be coupled
with add-ons, which though not as
numerous as Firefox, still does a pretty
good job. 

Favourites
IE 7 has newer features and more

options when it comes to organising
your favourites. The Favorite items
represented by a bright yellow five-
pointed star.

Bookmarks
The bookmark toolbar is very

useful for obvious reasons, but there is
no such toolbar enabled by default in IE
7. To enable it, hit the [Alt] key and go
to View > Toolbars > Links. Drag
and drop the icons from the address bar
or even a link from a Web page. The new
links are visible once you click on the
arrow at the extreme right of the
toolbar. Deleting the bookmarks is as
easy as right clicking and then clicking
on the Delete button.

Search
Similar to Firefox, Microsoft has

thankfully ditched its Windows Live
Search functionality by allowing users
to use other search engines. To use this
function, click on the arrow labelled

Search Options, which is located at
the right of the search box. A drop down
menu will appear, with options for
adding other search engines. Click on
the Find More Providers. Select
from a list of search engines comprising
Google, Ask, Lycos, Wikipedia and
Amazon. Click on any of these to install
them. Although the list is long, in case
you don’t find your favourite search
engine, enter the URL in the text field to
install it to your browser.

If you have disabled the Google
toolbar, you can search for any item
without typing it in the search box. Just
type your search string in the address
bar itself. If it consists of more than one
word, the Google search page will be
displayed automatically with all the
results. Depending on the string, if an
exact match is found the browser
redirects you to the first result,
otherwise accessible by the “I am feeling
lucky” button.

Manage Add-ons
Apart from third party add-ons,

which you can install for productivity,
IE comes with add-ons such as Java and
Adobe Reader. Whenever you notice a
reduction in browsing speeds, check the
memory consumed by IE in the Task
Manager. In case it’s extremely high,
disable all the add-ons installed from
Tools > Internet Options >
Programs > Manage add-ons.
However, you need Windows XP Service
Pack 2 installed for this. Look through
the list and disable all add-ons such as
Browser Helper Objects and Browser
Extensions. You can enable these later, if
you want to. Also, be a little more wary
while installing add-ons that are ActiveX
objects. These have the nasty reputation
of triggering security holes. 

Editing The Registry 
There are certain hacks in the

registries that can make IE 7 look more
like IE6 in terms of the positioning of
the menu bar. Proceed with care: the
usual statutory warnings when it comes
to registry editing apply here. 

Go to Start > Run and type

TIPS
IE 7 And Add-ons  . . . . . . . . . . . . . . . . . 53
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SECRETS THAT KEEP YOU AHEAD IN THE RACE

Go back to the last page
Go forward to the next page
Focus the Address Bar 
Add site to favorites
Open the right click context menu for selected item
Open links in a background tab 
Close current tab 
Switch to the last tab
Close other tabs 
Open quick tabs
Go to the search box
Open search query in new Tab 
Bring down the search provider menu
Open Favorites Center to your favourites 
Open a new tab
Zoom the page 
Display classic menu items

[Alt] + [Left Arrow]
[Alt] + [Right Arrow]
[Alt] + [D]
[Ctrl] + [D]
[Shift] + [F10]
[Ctrl] + [Click/Middle-click]
[Ctrl] + [W]/Middle-click on the tab
[Ctrl] + [9]
[Ctrl] + [Alt] + [F4]
[Ctrl] + [Q]
[Ctrl] + [E]
[Alt] + [Enter]
[Ctrl] + [Down Arrow]
[Ctrl] + [I]
[Ctrl] + [T]/Double click on the tab bar
Ctrl + [+],[-] / [Ctrl] + scroll whell
[Alt]

Now use search engines of your choice

Shortcuts

Keyboard shortcuts make your job easier, especially when you use heavy software. IE
has its own long list, and recalling them will do you good. 
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offered, they also offer a 30 day free
trial—get it on this month’s DVD.
Whenever you open a file in
Soundforge, the track is displayed in a
series of waves and troughs, resembling
seismograms. From the graph, you
could figure out regions with either a
high pitch or, say, low bass.

Effects
You enjoy a particular soundtrack,

but don’t want to hear the applause at
the start and end of the track? Just open
the track from the Open menu and hit
the play button. Once you encounter
the regions in the soundtrack where the
clapping and whooping takes place, use
the cursor to select them and hit the
delete button. On the other hand, if you
want to retain only a particular part of
the file, and cut the rest out, go to Edit
> Trim/Crop.

The Effects menu has additional
options to manipulate files. All these
effects, when used sensibly and
combined together, can mean the
difference between a professionally
edited track and an amateur recording.
Each option has several sub options,

and detailing them would exceed the
available space. Take, for instance, the
Envelope option (Effects >
Envelope). Envelope is a tool used to
make the soft parts sound louder and
lower the volume of the louder parts.
You can adjust the volume depending
on some preset parameters. It is used
when you need to give different types
of “fade” effects. You have custom
effects provided, however by using the
graph you can create your own effects.
The waveform changes when the
envelope effect is applied as you can see
from the screenshots here.

Hush
Many audio tracks, which would

otherwise sound awesome, remain
unheard and unappreciated because of
an unfortunate problem during
recording. Now with noise reduction
tools available, you don’t need to bury
your recordings of that baby talk
because of honking in the background.
Use the noise reduction tool from
Tools > Noise Reduction to get rid
of all external noise. There are options
such as Noise bias, Attack speed
and Windowing overlap. All these
options reduce the external noise. The
best way to edit, for newbies, at least, is
by trial and error—tweak around the

sliders and preview the effect each
time. When you are satisfied with the
output, hit the OK button.

Mix And Match
What’s the difference between DJs

and us? They mix music, we don’t.
Mixing audio tracks may sound a bit

significantly improve your Internet
browsing experience.

In the Registry editor, go to
HKEY_LOCAL_MACHINE/Software/Mi
crosoft/Windows/Current
Version/Explorer/RemoteCompute
r/NameSpace/{D6277990-4C6A-
11CF-8D87-00AA0060F5BF} and
delete the key named Printers. That
ought to do the trick. 

For opening up to 16 simultaneous
connections with the remote server,
and hence pushing your speeds up
considerably, you need to modify (or
create, if they don’t exist) two values in
the registry. Go to HKEY_CURRENT_
USER\Software\Microsoft\Windo
ws\CurrentVersion\Internet
Settings and check these two
DWORD values:
MaxConnectionPer1_0Server and
MaxConnectionsPerServer. Change
their values to 0000010 and
00000010 respectively. After doing the
customary restart you will notice
increase in browsing speeds.

Normalizing The Size Of A New
Window

IE 7 has this annoying behaviour where
clicking on a link in sites causes
another window to open in the middle
of the screen. Most people maximise
this window by clicking on the
Maximize button. However, the next
time you open a link the same
behaviour is repeated.

There is a simple tweak to get rid of
this behaviour. Whenever you open a
new link in a new window stretch the
window so that it covers 100 per cent of
the desktop. Restart IE again and click
on the links. You should see the new
window open full size. 

SOUNDFORGE

Soundforge, a proprietary audio
editing package by Sony, is used by
professionals as well as amateurs to

insert audio effects to sound tracks,
repair damaged tracks, master and mix
them and perform encoding tasks.

Costing between US$299.95 to
US$319.95 (approximately Rs. 12000 to
Rs. 12800), depending on the packaging

Options in the edit menu

This was the waveform before the envelope
was applied

This tool provides options for removing
external noise 

Soundforge graphically displays music

…and after.
Notice the
difference in
the wave-
form

Mixing two or more tracks in Soundforge

regedit. Navigate to
HKEY_CURRENT_USER\Software\Micr
osoft\Internet Explorer\Toolbar
\WebBrowser and click on it to view
the contents on the pane. Right click on
the WebBrowser item and use Select
> New > DWORD. Name the DWORD
ITBar7Position and hit [Enter].
Double click on the new value and
assign a value of 00000001. Make it a
hexadecimal value. Close the editor, and
restart IE 7 to see this view when you
enable the menu bar.

Printing
When you need to print a Web

page and you have to adjust the settings
for headers, footers and margins, click
on File > Page Setup. Click on
Page Setup with the [Alt] key
pressed. In the pop up, type in your
measurements for the page setup,
which are in inches. For changing them
to millimetres, go to Control Panel
> Region and Language Options.
You can also change the size settings to
A3, A4 and A5 and also choose between

Portrait and Landscape options. In the
Header and Footer section, there are
some operators such as &w, &b and &p. A
complete list of the variable is given
above. These variables can be also
combined in the header and footer
fields. Finally, use File > Print
Preview to view the changes.

Add-ons For IE
In our past articles we have talked

about add-ons for IE 7. Here, we are going
to touch on a few nifty ones:

IE7 Open Last Closed Tab: This is a
common problem for users of IE 7 who
savour the Tabbed windows. Clicking
on the X and all your open tabs close.
This add-on will come in handy for
such accidents. It creates a shortcut

[Ctrl] + [X] that lets you undo the
closed tab. This is a free extension and
can be downloaded from http://tinyurl.
com/3yzhlv

Inline Search: This add-on mimics the
find as you type functionality of Firefox.

Press [Ctrl] + [F], and a toolbar will
appear at the bottom of the browser
window. All the instances of your search
string are highlighted in the window.
There are still some important shortcuts
to remember: Esc closes the search pane,
[F3] or [Enter] takes you to the next
occurrence while [Shift] + [F3] or
[Shift] + [Enter] will take you
back. This add-on is free. Get it from
www.ieforge.com/InlineSearch/HomePage

GooglePreviewIE: This add on is a
boon for product and image searches.
Also present in Firefox, this toolbar
shows image previews of Web pages
when you run a Google search. This is
not an official Google offering like
Google Toolbar. Get it from
http://ackroyd.de/googlepreview/

WOT for IE:
With
incidences like
online fraud
and phishing
on the rise, it
is very
important to
know the
reputation of a
site
beforehand.
WOT (Web of

Trust) is such an extension that
constantly checks any Website you
open, against a community submitted
list and displays its appropriate ratings.
This is based on a colour code, with
green being highly reputed and red
being potentially dangerous. After
installing this add-on from

http://www.mywot.com/en/ download/ie,
check the top right corner of your
browser window. Monitor the colour of
the ring as you keep browsing. In case
you come across a Website that you
suspect is harmful you can also submit
the link for potential inclusion into the
list of malicious sites.

IE’s Compatibility Issues
IE 7 has started to adopt Web

standards for rendering HTML elements,
in contrast to the previous versions that
had a plethora of standard-related issues.
However, due to an almost 90 per cent
share of the browser market, most Web
developers had to hack their source code
in “illegal” ways so that their rendering
would not be broken. Many sites you will
visit on the WWW have still not updated
their code, and will be rendered horribly,
with fonts and links askew. A registry
hack can allow you to display such sites
in IE7 with IE6’s default behavior.

Go to Start > Run, type regedit
and press [Enter]. Go to
HKEY_LOCAL_MACHINE\SOFTWARE\Mi
crosoft\Windows\CurrentVersion
\Internet Settings\5.0\User
Agent. Right-click on the white space
and select New > String Value.
Name the string Version. Right-click
on the new value and select Modify.
Insert MSIE 6.0, close the registry
editor and restart IE. All sites will now
be rendered properly.

Speed Up IE
Like Firefox, IE is very slow to load

pages. There are various reasons for
this: the number of simultaneous
connections that IE makes with the
server is limited and it also keeps
searching for network shares and
printers. There are some registry
tweaks to get around this problem and

Window title
URL
Date in short format (as specified by Regional and Language Options)
Date in long format (as specified by Regional and Language Options)
Time (as specified by Regional and Language Options)
Time in 24-hour format
Current page number
Total number of pages
Right-aligned text (following &b)
Centred text (between &b&b)
A single ampersand (&)

&w
&u
&d
&D
&t
&T
&p
&P
&b
&b&b
&&

Old look in the new browser

The different colour codes in WOT

Now mimic Firefox’s [Ctrl] + [F]

View image previews of search results with
GooglePreviewIE
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intimidating, but it’s as easy as a copy-
paste operation. Open all the tracks that
you want to mix in the main window. Hit
the File > New button for opening a
new workspace where the final mixed
track will appear. For further
convenience, go to the Windows menu
and choose either the Align Horizontally
or Align Vertically option that will align
all the windows. After you have decided
on the particular sections of the tracks
that will go into your mixed track, use
the cursor to select them and paste them
in the empty workspace. Finally, use the
Mix option to combine the tracks, and
you’re done! 

Replicate
For some specific purposes, the

Replicator function is another nifty tool.
If you need to extract a specific portion
of audio, say about 10 seconds from a 5
minute clip the Replicator is precisely
the tool you need. Or say you need to
replace certain sections of the audio with
repetitive sounds. Copy the audio that
you need to replicate, and go to Edit >
Paste Special > Replicate. Select
either Copy Partials, if you want to
fill the selected region completely with
effects. Whole Copies option means that
only an integral number of replications
will occur. 

Burning
Sometimes you need a reference

CD for a quick sampling of how your
final effect sounds. A third-party CD
burning tool such as Nero can be quite
inconvenient for a quick burn. Go to
Tools > Burn Track-at-Once
Audio CD and select the options like
burning speed. The Track-at-Once is
similar to a multi-session disc, where
more tracks can be added later.

Limit Yourself
When you are mastering or editing

a digital soundtrack, you need to take
care of distortions. It might not sound
very bad when you are wielding the
scissors, but it will sound chalk-
scratching-the-blackboard bad if you
don’t pay attention and get the final

result burned on a CD. This can be
prevented by monitoring and limiting
the amplitude of the audio signal. From
Effects > Wave Hammer, click on
the Volume Maximizer tab. There are
a host of presets to choose from, while
the sliders would enable you to
manually adjust settings such as
selecting the maximum and minimum
sound levels in decibels. After you are

done, click OK and you have the perfect
track—nice and tidy within the limits
you’ve specified.

Mono Sound
While stereophonic sound is all

well and good, sometimes you might
need to know how your fantabulous
track sounds in the Mono mode. This is
needed in certain applications,
especially broadcasting where there are
plenty of TVs and radios running on
mono speakers. The stereo sounds can be
changed to mono by using the Process
> Channel Converter option. Apart
from converting from stereo to mono,

you can perform other tasks such as
reversing the left and right channels and
inter-mixing them. 

Batch Work
In some cases, you might need to

apply the same effects to multiple
tracks. Such tasks call for the use of the
Batch Converter. Go to Tools > Batch
Converter and select the files that
need you to apply the effects. Select the
effects to be applied, the format in
which the files are to be saved and
finally hit the Run Job in the Status
window to start the conversion.

Conclusion
Soundforge is among the best sound
editing software out there. Even though
it is incredibly complex, it can be used
from the absolute amateur to the
polished professional. You need to
practice a lot in order to master sound
editing. However, with tools such as
Soundforge and slight added effort, you
no longer have to run to an audio
parlour for your home-made videos 
and audio. 

WINDOWS VISTA

Here is another round of Vista tips,
served piping hot. As usual,
backup your registry before trying

any of the registry hacks.

Defrag Faster
We have talked about the

importance of defragmenting your hard
drive earlier, but the fact remains that
defragmentation takes up too much
time. However, a free tool bundle is

Volume control effectively adjusting the 
sound levels

Channel converter presets 

Different formats available for saving

Selecting the section to be replicated 

The final effect

The waveform before using the volume 
control function

Options for defragmenting

Wings3D
Take Free Flight into the 3D world with Wings3D

Rossi Fernandes

The entire CG scenario has evolved
since the late 90s and world class

results can be achieved from pretty
much anyone’s computer. Open source
and free 3D modelling tools such as
Blender have closed the gap with com-
mercial software. Today, we look at
Wings3D, which is a 3D modelling soft-
ware similar to Blender, but easier to
use. You can download it from
http://www.wings3d.com or get it from
our DVD in this month’s issue. There
are Windows, Linux and Mac versions
of Wings3D. 

Handling The Viewport Easily
The biggest issue when you’re so com-
fortable with commercial software
such as 3ds Max or Maya is that a tran-
sition to completely different software,
be it free or paid, becomes very
annoying. One of the most significant
changes is that you need to get used to
be the way you handle the viewport
and manoeuvre the camera. By default,
Wings3D sets the mouse controls to
invert which makes working on
Wings3D even more confusing than
some others. 

Click on Edit > Preferences
and go to the Camera tab. Click the
dropdown for the Camera mode and
select 3ds Max if you are comfortable
using it. Click OK. Now you can use
3ds Max’s keyboard and mouse config-
uration to handle the scene. You can
also choose from any other software
in the list. 

Using Third-party Renderers
Contrary to popular belief, Wings3D is
not a plain modelling software,

without any renderers. It has a basic
default OpenGL-based renderer along
with it. To render a scene, click on File
> Render > OpenGL. To change the
quality settings click on the block sign
next to OpenGL. 

You can also install custom renderers
such as Povray. For that you first down-
load and install Povray (www.povray.org).
Install it into the default location. Then
in Wings3D, click on File > Render
> Povray to use this renderer.

Object Management
Wings3D, like
any other 3D
modelling
software has a
resource man-
ager, which
gives a single-
window view
of all the
objects in a

scene with decent control. The
Geometry Graph in Wings3D does
just that. Click on Window >
Geometry Graph. You will see a small
window all the objects listed. There are
three tiny icons to the right of each
object. The eye icon is used to hide or
unhide the object. The lock icon locks
or unlocks the object being interacted
with, while the last icon toggles the
wireframe view for the object.

Customising Views 
Another obstacle with Wings3D is the
lack of side views from different axes.
Instead of those views, you just have one
big perspective view window. Wings3D
allows you to create as many windows as
you need. You can resize a window by
clicking and dragging the right bottom
tip of the window. Each one of these win-
dows can be set to an axis. First, create a
new window by clicking on Window >
New Geometry Window. Drag and drop
the window to the location of your

choice. Now to set a view, click on View
> View Along and select the axis you
want to set the camera to.

Unwrapping The Model
One of the steps involved in creating a
model is the unwrapping of the model
where the object is spread open, by cre-
ating cuts on key edges. The unwrapped

model is used to create a texture for it.
There are many ways to unwrap a
model, and it depends on the way the
model structure has been made. 

First, select the faces you want to
unwrap by selecting the face mode and
clicking on multiple adjoining faces.
Right click and then select UV
Mapping > Direct. In the window
that opens, once again select the faces
and right-click, choose Continue >
Unfolding. Throughout these steps,
you can choose different kinds of map-
ping to unwrap the model. Your selec-
tion will now be unwrapped. 

To export the unwrapped model,
right click in the UV Mapping window
and click on Create Texture. Click on
Window > Outliner, to enable the
Outliner window. In the outliner, look
for the map with the outline, right click
on it and click on Make External.
When prompted, enter a name for the
image you want to export. Click Save.

Once you’re done with creating a
texture in a different application, you
need to import the image by clicking on
File > Import Image. Choose the
image and click Open. You can see all
imported images here. You can even drag
and drop images into the UV Window.

Finally, it may be a bit difficult and
needs a different approach to get used
to, but there’s no denying that in the
end, you can get the same results model-
ling in Wings3D that you expect from a
suite costing several thousands! 

rossi.fernandes@thinkdigit.com
Customised renderers can be used with
Wings3D

The unwrapped model can be used to create
a texture in an image editing software

Objects can be hidden or
locked and also put into
wireframe mode using the
object manager—Geometry
Graph

Additional views can be added and positioned
within the Wings3D window
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going to change that sad story.
Download Power Defragmenter from
http://tinyurl.com/z74l3. It is a user
interface for a powerful disk utility
named called Contig, which lets you
defragment single files instead of
blocks and sectors. Run the Power
Defragmenter GUI and you will arrive
at the screen shown.

The Defragment File(s)
option lets you defragment up to four
files, while Defragment Folder(s)
lets you defragment up to four folders.
You can also choose to defragment your
entire hard drive. The process is very
fast—the 82-minute defragment time
for 25 GB in Vista Ultimate is cut down
to just six minutes!

Resize Partitions
You can resize partitions in Vista

without losing any data; start by backing
up important data: it pays to be careful.
Right-click on Computer and select
Manage. Go to Disk Management
under Storage and right-click on the
partition you want to shrink. Click on
Shrink Volume in the menu and voila:
you have shrunk the disk. 

Tweak Search Options
Windows Vista’s search is

completely revamped, and looks
different when compared to XP. It also
has more search options—different from
the vanilla ones provided in XP. Right-

click on Start > Properties >
Start Menu and click on the
Customize button. A window pops up
where you will be able to select the way
searches can be made in your Vista Start
box. The Search Communications
option searches the files in Windows
Mail and Contacts. Search
Favourites and History searches
the IE favourites and history. Search
Files has further options: you can
either choose to search the whole
computer, or only files that you have
created yourself. The final option is
Search Programs. Depending on
your preferences, searches will be done
faster, or might even take more time
than usual.

Trim The Control Panel
The number of control panel

items that we have to access regularly is
miniscule. There is no sense in
displaying all the icons as this slows
down the loading time before you get
to access the panel. The unused icons
can be hidden by using the Group
Policy Editor.

Go to Start and type gpedit.msc
in the search bar. Go to User
Configuration >
Administrative Templates >
Control Panel > Hide
Specified Control Panel Items
/ Show Specified Control
Panel Items. After enabling it, click
on Show and type the name of the icon
you want to hide or show. That has to
be done exactly as written, with proper
attention to case.   

Make ReadyBoost Default
ReadyBoost is a disk caching

technology that kicks in when you
attach USB flash drives. This optimises
your system performance and is should
be automatically switched on if you’re

short on system memory and want to
use a flash drive. However, no software is
that intelligent, and in some cases this
feature is not enabled automatically. A
registry hack can, however change the
way Vista deploys this feature. Proceed
at your own risk.

Go to Start > My Computer >
Right click on device >
Properties > ReadyBoost. Select
Stop retesting the device when
I plug it in. Remove the device and
open the registry editor—Start > type
regedit in the search box. Navigate to
HKEY_LOCAL_MACHINE/SOFTWARE/
Microsoft/Windows-NT/
CurrentVersion/EMDgmt and change
these registry values: Device Status
to 2, ReadSpeedKBs to 1000 and
WriteSpeedKBs to 1000. Restart the
machine, and ReadyBoost should be
enabled every time.

Get Widgets From The Net
Widgets and Google Gadgets can

liven up a Web site. If you are a fan of
any particular widget and you want to
use it in Vista, you can now install these
widgets in your Sidebar. For that, first
download the Amnesty Generator from
http://www.amnestywidgets.com/Generato
rWin.html (or get it off our October 2007
CD). After you have installed the
program, get the source code of your
favourite widgets and paste the HTML
code in the space indicated by Step2. 

You might also want to tweak with
the HTML code a little to optimise the
size parameters. Besides, you can also
input the size in the boxes provided.
Select an image for your widget and
click on Generate. The Widget will be
placed in your sidebar, and you will be
able to check the daily weather, play
games, get the latest stock quotes etc. In
case you want to further fiddle with the
gadget click on Start and type

Tweaking the Control Panel   

Use Amnesty Generator to get your favourite
widgets off the InternetVarious options in search   

Shrinking disk space in Vista

Windows Batch Files
Automate some mundane tasks in Windows using batch files

Rossi Fernandes

Batch scripts were an easy way to make
tiny software necessary for drivers

back in the days of DOS. DOS batch files
can still be run in the same way in the
Windows operating system through the
command prompt. A few of the com-
mands present in the DOS days don’t exist
anymore, but most are still intact. Batch
files have the extension .BAT, and any text
editor can be used to create them. 

Automate Your Net Connection
A lot of us use the dial-up method to con-
nect to our ISPs—yes even the broadband
users amongst us usually have to use
PPPoE (dial-up broadband). The problem
occurs often enough to be irritating—
connections drop, for whatever reason,
and downloads fail, transfers are
restarted...you know what we mean. To
automate the redialling process, make
sure you have the account set up by
going to Start > Control Panel >
Network Connections. Open
Notepad, and type in the following: 
RASDIAL <Connection Name>
<username> <password>

You have to be careful to ensure that
you type the connection name exactly as
it shows in Network Connections. Now
just hit [Ctrl] + [S], and save the file
as <filename>.bat—here filename is
whatever you want to call it. Now you can
add a scheduled task to set the connec-
tion to dial automatically. Go to Start
> Control Panel > Scheduled
Tasks > Add Scheduled Task. Click
Next and then click Browse and select
the BAT file you just created.

Next, set the schedule for the appli-
cation, so, say, you want to run the BAT
file every day, after every half hour, just
choose Daily and click Next. Fill in
other details such as starting time,
entering your user account information,
and completing the schedule creation. To
make this a repetitive schedule, right-
click on the task, select Properties,
click on the Scheduled tab and then on
the Advanced button. Check the
Repeat Task checkbox, and enter a
value for the interval. You can be sure
that your PC will, more or less, stay 
connected as long as it’s on.

Start Your Favourite Programs
As soon as you walk into office, you may
launch Outlook to get your mail, open IE

to start browsing and perhaps launch
your RSS reader. Designers may start work
by launching another set of programs.
Whatever your job, you’re bound to have a
few rituals like these, and instead of going
through the motions every day, you can
let a Batch file do all the work for you.

Start Notepad and create entries (as
shown below) for all the applications you
want to run one after the other.

CD “C:\Program Files\
wings3d_0.99.00b”
Start Wings3D.exe
CD “C:\Program Files\
Adobe\Adobe Photoshop CS3”
Start Photoshop.exe

CD is used to switch control to the
directory of the application and the
Start command runs the application
itself. Once again, save the file with a .bat
extension, and all you have to do is
double-click this file when you want to
start working. 

Start And Stop Services On Demand
Not all of us are blessed with fast com-
puters, and even if you are, you might not
like too many services running in the
background. Normally, you could go to
Start > Run and type net stop
<Service> to stop services individually,
but if you want, say, 10 services stopped
when you’re about to begin gaming, this
would be painful. 

With a Batch file, all you would need
to do is create one that contains all the
net stop commands in the following
format:
NET STOP <Service 1>
NET STOP <Service 2>
...and so on

This way, you can add all the services
you want stopped, and just double-
clicking the Batch file will stop them all.

You can even do the reverse, and use the
net start command to restart the same
services using another Batch file. To find
the exact names of the services, go to
Start > Control Panel >
Administrative Tools > Services;
double-click a service and note down the
name given under Service Name. 

Killing Tasks
Tasks can be shut in the same way services
are stopped. The Taskkill command can
forcibly shut applications from the com-
mand line. This can be used in a batch file
to shutdown multiple applications
together. This is especially useful in case
you’re usually goofing off and the boss
walks in! In the batch file, create entries
in this format: Taskkill /im
Processname.exe /f.

Quick Shutdown Or Reboot
There are commands that can be used to
shutdown the computer and these can be
customised as well. The command is
shutdown -s -t 0. Create a shortcut

with this command and you can shut-
down your PC without having to go to
Start > Shut Down. This will force the
PC to shutdown immediately without any
confirmation dialog boxes. To set a time
before the shutdown commands replace
the value 0 with anything else. You can
use this same command along with
schedules to automatically shut down the
computer. At any time if you want to
abort the shutdown, use the command
shutdown -a.

Similarly, the command for
rebooting the computer without any
alerts or confirmation windows is
shutdown -r -t 0. 

rossi.fernandes@thinkdigit.com

Use the list of services to get exact names of
services running on your Windows 

Creating shortcuts for the shutdown command
is a quick way to shutdown and restart your PC
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%userprofile%\Appdata\Local\
Microsoft\Windows Sidebar\
gadgets in the search box. This will
take you to the folder where the widgets
are stored.

Registry Hacks
Here are some useful hacks for

Windows Vista. As usual, back up your
registry before you try them. 

To change the name of the registered
user or company, browse to
HKEY_LOCAL_MACHINE\Software\
Microsoft\Windows NT\
CurrentVersion and look for
RegisteredOwner and
RegisteredOrganization. Double
click on them and change the values 
If you have a sufficiently powerful
machine and love the animations in
Vista, you might want to slow them
down a bit. Navigate to
HKEY_CURRENT_USER\Software\
Microsoft\Windows\DWM. Once
there, create a new key by right
clicking on the space below existing
keys and choose New > DWORD (32
bit) Value. Call it
AnimationShiftKey and enter the
value as 1. After rebooting the
machine, whenever you want to slow
down the animations, press the
[Shift] key before it starts. 
Encrypting and decrypting files in
Vista is a multi-click process which
takes a fair bit of navigating. With a
registry hack, this task can be done
with a simple right-click. Navigate to
HKEY_CURRENT_USER/Software/
Microsoft/Windows/CurrentVe
rsion/Explorer/Advanced and
create a new 32-bit DWORD. Call it
EncryptionValue and use the
value as 1 there. After the system is
restarted, you can get encrypting
with just a right-click. 
Speeding up Flip3D: Eye candy is well
and good, but not all of us have top-
of-the-line graphic cards to render all
the slick effects. This hack will limit
the number of windows that are
rendered in 3D, which will hopefully
let you have your cake and eat it too.
Navigate to
HKEY_CURRENT_USER\Software\
Microsoft\Windows\DWM and
create a new DWORD value called
Max3DWindows. The value should be
set to a number between 4 and 9:
higher the number the more muscle
your graphics card needs to pack. Try
it out with different number values
by opening multiple windows and
checking out the difference.

Enabling Detailed Status
Messages

Vista has a verbose mode which informs
the user of what is going on behind the

scenes when you are either logging in or
shutting down. Click on Start and enter
gpedit.msc in the search box. Navigate
to Computer Configuration >
Administrative Templates >
System and locate the Verbose vs.
Normal status messages. Right-click
and enable it. 

Enable NAS Devices In Vista
Vista is still not compatible with

many regularly used peripherals, and
network storage boxes are one of them.
This trick will let you use NAS boxes
without downloading any new drivers. In
the Start search field, type secpol.msc.
In the Local Security Policy editor, expand
the Local Policies and select the
Security option. Locate the item titled
Network Security: LAN Manager
Authentication Level and select
Properties by right-clicking on the
setting. The settings should be changed to
Send LM & NTML—use NTLMv2
session security if negotiated.
The incompatible NAS box will work now. 

Get Detailed Statistics
The Windows Experience Score

indicates how well your system is running,
but it is at a superficial level. Advanced
users need to use Microsoft’s Management
Console to find out the state of the OS. To
access this tool, right-click on Computer
and select Manage > Reliability
and Performance > Reliability
Monitor. The detailed graphs show
stability indices that determine how stable
your system is at any point. Red circles
show stages where failure has occurred,
with a detailed description on which
process had gone belly up. As a
troubleshooting tool, this is pretty neat.

Quickly Transfer Photos
Transferring photos from a digital

camera involves quite a bit of mouse
clicks. Even if the photos are copied to the
computer, they remain on the camera’s
memory card. The Windows Photo Gallery
can do this transfer-then-erase function in
one go. After the camera is detected and
before you start to transfer your photos,

select File > Options > Import >
Always erase from camera after
importing. This will clean out your
camera memory, essentially completing a
cut-paste operation. 

Set Core Priority
In machines with multiple cores,

most tasks are divided amongst the cores
so that the computer can run multiple
operations at the same time. There is a
performance lag to this system, as
running on multiple cores can cause
processes to slow down a bit due to data
transfer issues between the cores. This is
particularly true for programs that make
heavy demands on the CPU. In effect the
whole computer slows down to a crawl as
this affects other programs too. However
in Vista you can set a process to run on a
single core. Go to the Task Manager and
select the process which is hogging all

system resources. Right-click on it and
select Set Affinity. You can now
restrict the process to one of the cores and
improve the overall speed.

Get Multiple Clocks
Vista can display more than one

clock—a total of three clocks actually. To
enable this feature from the Control
Panel, click on Date and Time and go

to the Additional Clocks tab. You can
set different time zones along with a
display name for each. After you click OK
these clocks will be visible when the
cursor is placed over the default clock. 

The Reliability Monitor provides detailed
system diagnostics 

Restrict processes to specific cores 

Get multiple clocks in the System Tray

Easily transfer photos and manage 
camera memory
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reminders forever. Assuming that you are
running Windows XP Professional, click on
Start > Run, type gpedit.msc and hit
[Enter]. This will launch the Group Policy
Editor. Select Local Computer Policy >
Computer Configuration >
Administrative Templates > Windows
Components > Windows Update. Double-click
on Re-prompt for restart with scheduled
installations. Change the value to 1440.
Close the Group Policy Editor. Click on Start >
Run, type gpupdate /force and press
[Enter]. This will stop the repeated reminders
for this and all future Windows updates.

Twice Isn’t Nice
Help! My Outlook Express sends two copies of
any mail I try to send.

Sarika Choudhary

This problem occurs if you have config-
ured Outlook Express Read options to

Read all messages in plain text, but are still
sending messages in HTML format. Outlook
Express creates a dummy attachment with the
formatted (HTML) copy of the message, so that
you can easily view it if needed and it does so
for incoming messages as well.

To solve this problem, configure Outlook
Express to send messages using plain text—go
to Tools > Options and navigate to the Send
tab. Deselect Reply to messages using the
format in which they were sent. Set
Mail Sending Format to Plain Text.

Spyware Attack!
I had installed a 3-day trial of moviepass.tv, but
now that the trial has expired, I am unable to

remove it and am continuously bombarded with

pop-ups demanding that I sign up for a monthly
subscription. Please help.

Amit Lakhani

You can attempt to remove moviepass.tv in
one of the following ways:

1. Use System Restore to roll back to the state
before you downloaded this adware. Go to
Start > Programs > Accessories >
System Tools > System Restore, select
Restore my computer to an earlier
time and click on Next. Select a checkpoint
date before the moviepass.tv software was
downloaded and click Next to continue with
the restore. Download, install and scan using a
good spyware such as Spybot to remove any
residual occurrences of this adware.

2. If the above method does not help, or if you
don’t use System Restore, you can do a manual
uninstall. Start your computer in Safe Mode.
Open the Control Panel, and go to Add or
Remove Programs. Uninstall any program
with names starting with or similar to the
following: AltBill, AltPayments, AltPayV2,
DownloadManager, FileGrabber, FSupport,
ITBills, License Manager, MediaPipe,
MoviePass, MovieLand, MPNotifier,
MyAccessMedia, MyWaySA, Notify, Notifier,
Notification Utility, OptimumOnline, and
P2PNetworks.

Now open Windows Explorer, and go to the
Program Files folder. Delete any subfolders with
names related to the items you just uninstalled.
Go to Start > Run, type msconfig and hit
[Enter]. Go to the Startup tab. Disable any
items with command names related to the items
you just uninstalled by clearing the associated
check box. Click on OK and restart the computer
when prompted to do so.
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Coffee-cup Holder?
My Samsung CD writer keeps ejecting when I
put a CD in it, and only after 5 or 6 attempts, it

manages to read a CD. What could be the problem?
Do I need to reinstall Windows?

Srinivas N.

Your CD writer keeps on ejecting the media
because it finds it difficult to read it. The

most common reason for this to happen is due to
the laser head power deterioration over a period
of time, or due to the lens getting dirty. You can
try to clean it by using a lens cleaning CD, which
you can get at any stationary store. Another
possible reason could be that your power connec-
tor or data cable is bad, so you should try replac-
ing these with new ones. If all fails, then it is
time to get a new optical drive.

Find What You Need
My friend has just bought a new hard drive and
installed Windows XP. But she does not know

what drivers are required. Please tell me how to find
the drivers without opening her cabinet.

Vineeth Pooppada

The best and the easiest way to approach
your problem is to call up the place from

where the computer was bought and ask them
the system configuration. Note down the names
of the individual components—motherboard,
graphics card, network card, etc. and search for
their drivers online. You can also download,
install and run Everest (any edition) from
www.lavalys.com. In the Summary module, you
will be able to see all the components of the
computer without having to open it. Once again,
you must note down the names of the compo-
nents and search for their drivers online.

Indirect Memory
I had read about setting the DMA mode for an
optical drive in your older Q&A section, and

have been able to do that with success. But the
problem is that I find that my drive keeps going back
to PIO mode again.

Shruti Saxena

To set your device to DMA, go to Start >
Run > devmgmt.msc to open the Device

Manager. Expand “IDE ATA/ATAPI controllers”.
Double-click on Primary IDE, go to Advanced
Settings tab and set the Transfer Mode to DMA if
Available. Do the same for Secondary IDE as
well. Restart Windows, and if you still see the
mode as PIO, you should uninstall the Primary
IDE and Secondary IDE channels and restart
Windows to redetect them. This should solve
your problem.

In your case, the drive keeps switching back
to the PIO mode, and the reason for this is often
attempting to read scratched media. Another
reason could be that your IDE cable may be
faulty or too long. Use only IDE cable with 80
conductors as are commonly available today, as
against the 40-conductor cables available earlier.
There may also be certain power management
issues that may cause this problem when the
computer wakes from the Standby mode, but
this can be solved by installing the latest chipset
driver for your motherboard.

ME No Work
I have recently reinstalled Windows ME and the
problem is that System Restore no longer

works. I sometimes get a blank window or the
following error:
An error has occurred in the script on
this page
Line: 14
Char: 9
Error: Object doesn’t support this
property or method
Code: 0
URL: res://rstrui.exe/start.htm
Do you want to continue running script
on this page?

Priyank Bhanushali

It seems that your computer did not create
a restore point during the first boot of

Windows ME. You should therefore create one
manually to get rid of this issue. Run the follow-
ing command at the command prompt:
C:\Windows\System\Restore\rstrui.exe
/makefirstrestorepoint
Now restart the computer and System Restore
should work fine.

Stop That Nag!
I want to know how I can stop Automatic
Update from nagging me repeatedly to restart

the computer after installing an update.
Mahesh Joshi

There are two ways to get around this issue.
We will first tell you how you can do this for

just the current update. Click on Start > Run,
type net stop wuauserv and hit [Enter].
This will stop the Windows Update service until
the next time you restart your computer. The
second method describes the way to stop these

E-mail us your computing
problems along with your
contact details and
complete system 
configuration to
ssooss@@jjaassuubbhhaaii..ccoomm, 
and we might answer
them here! Since we get
many more mails per day
than we can handle, it
may take some time for
your query to be
answered. Rest assured,
we are listening!

Get Help Now!

I Can’t Do That, Dave
My computer was working fine, but one fine day, it
started displaying a message that said something like

“Windows could not start because the following file is miss-
ing or corrupt: /system32/hal.dll” and Windows does not
start. Please help.

Sathish Rajan

This problem can be attributed to a missing or
corrupt Hal.dll file and / or Boot.ini. Here is how you

go about with the repair process. Boot from the
Windows XP CD and press [R] to start the Recovery
Console when you see the “Welcome to Setup” screen.
Press the number corresponding to the correct location
of Windows you want to repair (this is typically 1). Type
bootcfg /list to view the current entries in the
Boot.ini file. If you get a message that this file does not
exist, you should type bootcfg /rebuild, to repair it.
This will automatically scan your hard drive for installa-
tions of Windows XP, 2000, 2003 and NT and display the
results. Now follow these instructions:
1. Total Identified Windows Installs: 1
(1) C:\Windows
Add installation to boot list? (Yes/No/All)
Type Y and hit [Enter]
2. Enter Load Identifier
This is the name of the operating system. When you

receive this message, type the name of your
operating system, and then hit [Enter].
3. Enter OS Load options
After receiving this message, type
/fastdetect, and then hit [Enter].
Eject the CD and type exit.

Now to repair (or replace) hal.dll. You must once
again, boot through the Windows XP CD and enter the
Recovery Console. Press the number corresponding to
the location of the Windows installation to be repaired.
Type the following command at the command prompt:

expand X:\i386\hal.dl_ C:\windows\
system32\hal.dll

(Replace X by the drive letter of your CD/DVD drive
and you can specify the actual drive letter of your
Windows installation instead of C: as in the case above).

Select Yes if you are prompted to overwrite the
existing hal.dll. Type exit and restart your computer
normally. In very rare cases, the above procedure may
not help you. In such cases, you may need to make a
temporary installation of Windows in another partition
of the drive. Now (assuming that your original
Windows installation is in the C drive and your tempo-
rary Windows in D), copy hal.dll from
D:\WINDOWS\ServicePackFiles\i386 to
C:\WINDOWS\ServicePackFiles\i386 and
C:\WINDOWS\System32. Overwrite, if prompted.

Question 
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All your computing niggles and nags
are dealt with here!
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Rossi Fernandes

FL Studio (formerly Fruity Loops)
is an audio creation tool that
works by creating sequence of

sounds. It’s been around for years
now, and generally gives the impres-
sion that music creation is easy.
Sure, anyone can randomly go about
clicking to add beats and get a
respectable sound, there are a few
features and steps that need to be
understood first.

Creating A Suitable Base Project
By default, an empty file is created
when you start, but you can create a
new project based on a few bundled
templates. Some of these templates
are set for certain genres of music or
types of tasks such as surround sound
panning and recording. Go to File >
New from template and select a
template that best suits your plan.

Set The Tempo
The tempo for the track is the speed
at which your track plays. Most
newcomers will leave the tempo—
which is denoted in beats per
minute—at the default value. It
should be set to suit the style of the
track you’re composing.

The tempo value can be changed
by clicking on the BPM value next to
the playback buttons. Click and drag
the mouse cursor upwards or down-
wards, to change the value. You can
also enable a metronome to get the
idea of the tempo by clicking the
Metronome icon from the toolbar at
the top.

Adding Items To The Playlist
The playlist is one of the most impor-
tant windows and is centric to FL
Studio. It contains the entire track,
and is where all the loops and
patterns come together to create a
proper song. Most people end up
creating a random loop and adding
sounds and effects to it, but audio
tracks can be added to the playlist as
well. This is useful in places where
you want to add vocals to your track.
Like image or video editing software,
multiple tracks and effects can be
arranged in layers. The lower section
of the playlist window is where these
recorded sounds can be added. The
browser tab on the left contains all
the sounds and tools that can be used
to create tracks—simply drag and drop
sounds from there on to the playlist.

If you have a long playlist, then
navigating through it using the
scrollbars is a pain—use middle click
instead. Hold down the middle click
button and move the mouse to navi-
gate through the playlist window.

Creating Loops Using Step Sequencer
A step sequence is to be created,
because in the end, your entire track
will be made up of many such steps.
There are a few things that can be
done in the Step Sequencer. The

length of a step can be increased in
a similar manner to the tempo of
the track. On the top left of the Step
Sequencer window, click on the
empty text box and drag it up to
increase the number of beats per
bar. You can now put in more steps
per beat. Here again, you can drag
and drop new effects from the
browser. The view can be filtered to
show just drum beats or recorded
sounds—use the drop-down menu at
the bottom left of the Step
Sequencer window to do this. To
make any changes to the properties
of a channel, click on the channel
name and a new window should
open which lets you do that.

Using the Piano Roll
The Piano Roll feature allows you to
give each note a characteristic sound—
you can set the velocity at which the
notes are hit and make very minute
and accurate notes on the sheet.

Right-click on any of the channel
buttons and select Piano Roll. Here,
you can plot beats, and the bottom
section of the window can be used to
change the volume of the beats—so
every individual beat has its own
intensity. To further customise beats,
click on the Graph Editor icon on the
right top of the Step Sequencer
window. Use the scrollbar to switch to
a different property. 

Using Scratching And The Mixer
An interesting feature to use in FL
Studio is the Fruity Scratcher, which
allows you to create the same sounds
that you hear from DJs scratching
discs. To add a scratcher to Fruity

Loops, click on the View Mixer icon
on the right of the upper toolbar.
Click the drop-down there and go to
Select > Fruity Scratcher. Load
a music file using the folder icon on
the left. When that’s done, click Play
and you can click and drag the
mouse over the disc on top or the
status bar below. There are controls
on this window for the speed and
sensitivity of the turntable. 

The Fruity Loop Mixer is a feature
that allows you to plug in multiple
processors and generators in a loop.
The Fruity Loops Scratcher is one
such add-on. Similarly, you can add
many other plugins in a chain. The
volume for each plugin can be
controlled individually as well.
Instruments and items can be
excluded from being affected by the
added plugins, if required. The Fruity
Loops Mixer is a great way to make

fine tweaks to the track in real time.
It also works fine with the recording
feature that we will talk of next.

Live Recording 
When you’re comfortable with the
software and you’ve created a basic
tune, you can also record small clips
in real time. We’ll try using the
scratching feature in FL Studio as an
example. Before we start the record-
ing itself, we first load the scratcher,
and click the Record button next to
the playback buttons. If you click the
321 icon on the same toolbar, you
will be given a countdown before
recording starts. Click the Playback
button to start the recording itself.
All your loops and tunes will play as
usual—if you want the recording to
loop, then click the Loop record /
Enable Overdub icon in the main
toolbar.

Adding Audio Samples To the library
FL Studio has loads of audio presets
and sounds that will keep you busy
for a very long time. When things do
turn a little dull, you can also choose
to use downloaded or self-created

sounds, which can be added to
the browser. Go to Options >
File Settings and click on
the folder icon to the left of the
empty field and choose the
folder where you have the
custom sounds. When done,
close the window and you will
find the newly added folder in
the browser. Like other tracks,
left click and drag your clips to
the step sequencer. Keep in mind
that large MP3s will hog up the
system resources and signifi-
cantly slow down FL Studio.

FL Studio also has a very
versatile inbuilt audio editing
plugin called Edison that can be
enabled by clicking on the Open
New Audio Editor icon on the
top toolbar. This is useful to
create your own samples.

Tweaking FL Studio
Fruity Loops might seem opti-
mised when you’re working on
a few channels, but it becomes a

completely different beast when you
go large-scale. It then becomes neces-
sary to make a few adjustments to
the audio settings to optimise the
program a bit. Go to Options >

Audio Settings.
If you haven’t
made use of ASIO
yet, enable it by
selecting it from
the dropdown
menu for Output.
ASIO4ALL is a
driver, which
gives very good
latency on most
sound cards—it is
installed along
with FL Studio.
Changing the
sampling rate
using the drop-
down menu can
also help. If you
choose the sound

driver itself, you can then set a
buffer length to it. A shorter buffer
length will reduce latency, but will
hit performance. If your sound is
already stuttering, you should try
increasing the buffer length.

Exporting The Final Result
Encode.tif—Completed tracks can be
exported as MP3s and other formats
without any dramas

When you feel your track is
ready, and it’s time to export—go to
File > Save As or File >
Export > MP3 File. Select the
format, and if you choose MP3, you
can choose from quality settings
such as bit rate and depth of the
song. The approximate resulting file
size is also displayed, so you are free
to make any changes. Click Start to
start the encoding process.

That’s it, then! It is pretty obvious
that there’s a lot of that can be done
with FL Studio, but it’s only a matter
of messing around in the software to
know the best ones. 

Shortcuts For FL Studio
Some helpful keyboard shortcuts
that’ll make working with FL Studio
much easier:
Toggle Step Sequencer — [F6]
Toggle Mixer — [F9]
Send to Piano roll — Alt] + [P]
Toggle Piano Roll — [F7]
Toggle recording countdown —
[Ctrl] + [P]
Next pattern — [+]
Previous pattern — [-]
Solo step—[Ctrl] + [1] to [0]

rossi.fernandes@thinkdigit.com

Create Your First Track In FL
Studio
Create Your First Track In FL
Studio

The loop step sequencer is one of the most
basic, but vital, starting points for a song

Your very own personal turntable for disc
scratching in Fruity Loops

Downloaded or custom made audio samples
can be added to the Fruity Loops library

Fruity Loops can be unforgivable if loaded
with too many tracks—so tweaking is
necessary

Completed tracks can be exported as MP3s and
other formats without any problems

Edison is an audio editor built into Fruity Loops
The Piano Roll feature allows accurate
notes and beat plotting

Become a DJ with your own virtual turntable and mixer
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Dream Come True
I have put together my dream gaming rig after
quite a lot of research:

ASUS P5E3 Deluxe, Intel Q6700, Corsair
TWIN3X2048-1333C9 G, ASUS GeForce EN8800GT
512MB, Samsung SpinPoint T166 HD321KJ, Lite-On
DH-20A3S DVD writer, CoolerMaster eXtreme Power
600W PSU, Antec TX1088AMG cabinet, Logitech G5
Laser mouse, Microsoft Natural Ergonomic Key-
board 4000. But all this performance comes down
to the screen I’m using. Please suggest the one with
the best performance in the 20 to 22-inch size cat-
egory. My budget is Rs 15,000 to 16,000. Also, com-
ment on the above configuration and suggest any
improvements.

Reuben “Re. J” James

Firstly, your system is very good, and a
true gaming rig—congrats! Secondly, I

suggest a 22-inch monitor for that budget. Look
at Dell’s E228WFP or BenQ’s FP222W—two of the
better panels I’ve come across. If you must go 20-
inch then the Dell SP2008WFP is a very good buy.

Reviving An Ancient Rig
I want to buy a new motherboard which supports
an old 478-pin Intel Pentium 4 processor, and 512

MB DDR RAM at 333 MHz. I also want a 256 MB graphics
card and an SMPS (for gaming) in same budget even if
the performance increment is mediocre. Help!

Sumit Lal

An upgrade would still leave you well
behind the hardware curve, and enjoying

most year-old games would be well beyond your
setup. DDR memory is still available, but the price
would be around double the price of DDR2
memory, simply because nobody is manufacturing
DDR anymore. Assuming your motherboard even
has an AGP slot you’re out of luck, unless you
manage to find an older GeForce FX5200/5500 or
a 6200 graphics card. What I suggest is a complete
upgrade after some saving up. Invest in a DDR2-
based rig and a Core 2 Duo processor and you’ll be
well set for another two years or so. You’ll also have
a plethora of powerful and affordable PCIe
graphics cards to choose from.

Beyond Onboard
Hi, I have an AMD Athlon 64 X2 4000+
Processor with an MSI K9N6GM (NVIDIA

GeForce 6100) motherboard, 2 GB of DDR2 800 Mhz
RAM and Windows Vista Home Premium. I am not
satisfied with the graphics performance. I can’t run
games like NFS Pro Street or Call Of Duty 4. Can
you please recommend a good NVIDIA GeForce
graphics card? My budget is Rs 4,000 to 5,000.

Sumith Mohan

I suggest you save up a bit more and
invest in an 8600GT-based card—its per-

formance far surpasses the 8400GS and 8500GT
chipsets which are priced around your budget.
The 8600GT is a real mid-range offering, unlike
the 8400GS and 8500GT which are meant more
for powerful HTPCs rather than gaming setups.

The ASUS EN8600GT costs around Rs 7,000, and
is terrific for the price.

Sight And Sound
I need a PCI Express graphics card, and my
budget is Rs 10,000. I am also planning to buy

a good set of headphones for Rs 1,000. What can I
get for that budget?

Anonymous

For Rs 12,000, you can swing a sweet deal—
an 8800GT-based card which will satisfy

all your gaming needs. A whole lot cheaper is the
8600GT (Rs 7,000) chipset but this is also around
250 per cent slower. Creative’s EP630 are in-ear
plugs available for Rs 900 and deliver out-
standing sound for the price. Among the larger
circum-aural sets, the Sennheiser HD201 is avail-
able for around Rs 1,400. 

Finally!
I have saved a little bit, and finally want to go
for the long-pending dream—my own desktop

PC. My budget is about Rs 40,000 (keeping away Rs
5,000 for Windows Vista). This includes everything,
literally (what I mean is, the motherboard, processor,
graphics card, DVD writer, cabinet, monitor, mouse,
keyboard, SMPS, UPS, speakers). My main purpose
would be movies and games. Although I know the
budget does not suffice for the aforementioned,
please suggest whatever you can. I want to play Far
Cry, Prince of Persia—The Two Thrones, etc. But, if
somehow Crysis runs on it, I’ll be thrilled!

After taking into consideration the Zero1
Awards I have zeroed on the following:
1) Hard Drive—Western Digital Caviar SE16

WD3200AAKS 320 GB
2) Graphics Card—ASUS EN8600GT

Please, don’t tell me to expand my budget
much. The reason is simple, I can’t. Also, I can wait
for another month or two if necessary. So, if there
is a probable price slash looming ahead…

Koustav Bhattacharya

Rs 40,000 is a good budget, although
keeping in mind you also want to buy

Vista you’ll have just 35,000. Why not keep your
hardware budget at Rs 40,000?

The ASUS EN8600GT is a very good card, and
you can’t go wrong there. For the hard drive, I rec-
ommend the new Seagate 250 GB 7200.10 series,
which is a single-platter drive and costs Rs 2,800
now. It’s a superb buy and is blazingly fast, too. 

Want a tech product, but
don’t know how to go
about buying it? E-mail
agent001@thinkdigit.com
with your complete 
contact details, and he
might answer them here!
Please note that
Agent001 only answers
purchase-related
questions in this space.

Ask Away!

Ask Agent 001

Processor
Motherboard
RAM
Graphics Card
HDD

Monitor
Keyboard + mouse
Cabinet
SMPS

Price
Rs 6,400
Rs 4,800
Rs 2,200
Rs 7,000
Rs 2,800

Rs 11,000
Rs 500
Rs 2,000
Rs 2,000
RRss 3388,,770000

Core 2 Duo E6550
Galaxy 650i LT
2 x 1 GB Transcend DDR2 667
ASUS EN8600GT
Seagate 7200.10 250 GB—single
platter disk
Dell E198WFP 19” LCD
Logitech
Zebronics / VIP
VIP 500W 
TToottaall

Agent 001’s Recommendation
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Computing For Everyone

right? A multimedia keyboard and optical
mouse from Logitech was available for Rs 550—
sweet! Next, I went cabinet shopping. I saw a few
cabinets from the likes of iBall, Zebronics, VIP
and Intex, but didn’t like any of the designs.
After browsing a couple of catalogues at a few
vendors, I came across a value series cabinet
from Zebronics called Krish—a neat-looking box
decked in black with cooling features like a PCIe
vent and CAG duct. Best of all expansion, is good
with three external 5.25-inch bays; at Rs 950, this
was a must-buy.

For the power supply, I couldn’t find any-
thing decent below Rs 1,000 till I came across a
450-watt Adcom power supply for Rs 700. I’ve had
good experiences with Adcom power supplies in
the past—one of my old download rigs used
Adcom power for over three years.

My DVD writer (yes, budget PCs get to burn
DVDs too) was a Liteon LH20-A1H, a 20X burner—
very reliable, very cheap, and just Rs 1,350. My
last remaining component was a set of speakers;

I decided on a non-woofer setup,
since speakers can always be
upgraded if better music perform-
ance is needed later. Creative’s
Inspire 245 is a gorgeous looker, and
at Rs 750, a good deal.

Finally, after six hours and three
shops, I’ve got a PC that will happily
run all essential applications, and
will even allow moderate multi-
media usage—all for just Rs 15,000!

A genuine copy of Windows XP
Home OEM costs Rs 3,900. I recom-

mend an original copy for the tech sup-
port you can avail of if things go wrong.

Instead of shelling out for more software,
you can find free essential software like

Avast! Antivirus on our CDs every month. 
agent001@thinkdigit.com

This is for the reader who e-mailed me
recently—he was finally building his first
PC after a number of years of reading Digit.

He had a very modest budget, and wanted some-
thing that would work—allow him to use MS
Office, and run Windows XP. I decided to build
a good PC from scratch, for those on a very tight
budget. At the same time, I want some sort of
future-proofing—after all, we all know how most
users expand their applications for the PC after
a few months of use.

I took a trip to Lamington Road last week to
check what I could come up with. I was surprised
to find single-core processors totally out of stock
with most vendors. Dual-cores have well and truly
gone mainstream, with the best deals being
combo packs. I was faced with two options—the
Intel E2140 processor and Intel D945G mother-
board is available for Rs 5,350, while AMD’s 4000+
CPU is available on a Jetway GeForce 6100 for 
Rs 100 more. Both processors have comparable
performance, but the AMD 4000+ is a little snap-
pier than the E2140, which is a severely cut down
Allendale core (Core 2 family). I went for Intel,
mainly because the E2140 (1.6 GHz stock) is a
very cool product, and overclocks very, very well,
and runs very cool at stock. The 945G comes
with onboard graphics—a boon for a value PC
that doesn’t require a graphics card. There is an
x16 PCIe slot for future upgrades, however, as
well as two PCI slots. For as little as Rs 700, I
could get myself 1 GB of generic DDR2 667 MHz
RAM; Transcend’s 667 MHz value RAM comes for
Rs 850. I was thinking 512 MB for price reasons—
Transcend (667 MHz) was priced at Rs 500, but I
decided not to be too skimpy and went with the
1 GB. For a hard drive, I decided to go with
80 GB, since basic browsing and
office work will rarely
require significant space.
Seagate’s ST380815AS 80
GB, 7200 rpm SATA drive is
priced at Rs 1,500 and
comes with a three
year warranty, with
doorstep replace-
ment—hassle free.

With my core
components chosen,
I was at a loss
deciding between a
CRT and an LCD. Cheap
LCDs aren’t very clear, and a
value CRT is a much better option. I
chose a 15-inch LG 500E, which after
bargaining a bit came for Rs 3,000. It’s a
nice screen, and better than a lot of the
cheaper CRTs around—just because you’re on
a budget doesn’t mean your eyes should suffer,

Agent 001

I’m looking for the cheapest (respectable) PC configuration I can get my hands on

DIGIT MARCH 2008

Want more of Agent 001? Turn over to read his
answers to your buying questions

Component
CPU +
Motherboard
RAM
HDD
Monitor
Keyboard +
Mouse
Cabinet
Power Supply
Optical Drive
Speakers

Price
Rs 5,350

Rs 850
Rs 1,500
Rs 3,000
Rs 550

Rs 950
Rs 700
Rs 1,350
Rs 750
RRss 1155,,000000

Model No
Intel E2140 (1.6 GHz) + Intel
D945G
1 GB Transcend Value DDR2 667
Seagate ST380815AS 80GB SATA
LG E500 15” CRT
Logitech multimedia combo with
optical mouse
Zebronics Krish
Adcom 450 watts
Liteon LH20-A1H 20x DVD Writer
Creative Inspire 245 2.0
GGrraanndd TToottaall

Here’s my Ultimate Value PC:

Chaitanya Surpur
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Bhaskar Sarma

Most of you know that the most compact 
memory type is called Flash memory. 
Currently, Flash memory is most popu-

larly available as USB drives, cell phone or cam-
era memory, portable media players (PMPs), 
handheld consoles, and even laptops—basically 
anything that’s built to be portable. There’s even 
talk of Flash replacing the bulky and power-hun-
gry hard drives that have been around for ages. 
Flash too, is not very young, and was invented by 
Dr Fujio Masuoka in 1964, while he was working 
for Toshiba.

Gates And Stacks  
At the most basic, microscopic level, flash 
memory is composed of an array of floating gate transistors 
called cells. These cells are of two types: NAND (Not A ND) 
and NOR (Not OR). The cells are also classified in two ways 
depending on how they store data—binary 0s and 1s: SLC 
(single level cells), which are older, can store only one bit at 
a time, while MLC (multi level cells) store more than one bit 
per cell by varying the electrical charge. Obviously, M LC 
devices will be able to store more data per unit area than the 

legacy SLC devices. Such devices are already in 
the market, and though they cost more than 
SLC ones, research is on to cut costs and make 
them more available. 

Unfortunately, the laws of physics set a limit 
on the amount of miniaturisation possible—too 
much, and leakage of electrons causes data loss. 
Multi-level cells are created by stacking two 
“dies” of the same size, hence doubling the 
capacity. This is the type of memory used in 
iPods. However, though MLCs double the capac-
ity, they also reduce access speeds. 

NAND vs NOR
NAND and NOR  flash drives have considerable 
differences. Those with NOR gates provide high 
speed and random access to data. This means that 
data can be read and written to any location in 
the memory without having to access the memory 

blocks sequentially. The minimum information that can be 
retrieved from a NOR flash is 1 byte. This makes NOR suitable 
for use in BIOS chips and for storing mobile phone firmware, 
where high-speeds and minute data transfers take place. 

NAND, on the other hand stores and retrieves data sequen-
tially, one block at a time. It also has a fixed lower limit below 
which it cannot transfer data. This data is usually what resides 
in an individual block, also known as pages. NAND flash mem-
ory is used for data storage and can be found in external hard 
drives, pen drives, memory cards and the like. NAND drives 
typically have higher capacities, and are cheaper.

Formats
For use as a data storage medium, NAND flash comes in 
several formats. The oldest is SmartMedia, with other newer 
standards like M ultiMediaCard and C ompactFlash. 
MultiMediaCard (MMC) has a new avatar in the form of the 
Secure Digital format, which itself has several component 
formats such as SDHC  (Secure Digital H igh C apacity). 
MicroSDHC, microSD and miniSDHC. Most of these cards are 
used in consumer electronic devices such as cameras and 
mobile phones. Besides, there are several proprietary stan-
dards like Memory Stick (Sony) and xD Picture Card (Olympus, 
Fujifilm) that are used in products made by specific manu-
facturers. A newer standard, UFS (Universal Flash Storage) is 
being developed by a consortium for release in 2009, and 
will be backward-compatible with present formats. 

New Hope
Manufacturers are aggressively working to increase data 
densities and reduce costs. A  3D flash technology is being 
developed that inserts silicon columns between layers, 
instead of trying to stack multiple layers. A lthough not 
immediately available on the shelves, you can hope to see 
such flash cards and devices in a year or two. 

bhaskar.sarma@thinkdigit.com 

So how does Flash Memory really work?

Memory Matters

A flash cell is made up of two transistors separated by a thin 
oxide layer. These transistors, either NAND or NOR, are called 
floating gates and control gates. A floating gate is connected to 
the array by a link called the wordline, which passes through 
the control gate, as shown in the figure. When the link is con-
nected, the value of the cell is 1, which is the default state. To 
change the value to 0, a process called tunnelling is used. The 
process is simple—apply enough charge to reverse the direction 
of flow of electrons. Data is erased when a voltage of about 12 
to 15V is applied to the blocks. When the charge of a block is 
over 50 per cent of this value the bit state is 1; less than 50 per 
cent means the bit state is 0. 
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Wi-Fi Access Points
Linksys WAP54G

Great performance
None in particular

Contact Ingram Micro India Pvt Ltd
Phone +91-9323112279
E-mail sunil.z@ingrammicro.co.in
Price Rs 3,816

5.1 Speaker Sets
Artis S6600R/FM

Good performance, radio
None in particular 

Contact Kunhar Peripherals Pvt Ltd
Phone +91-22-66345758
E-mail mail@kunhar.com
Price Rs 8,500

Processors
Intel QX6850 Core 2 Extreme

Extreme performance
Expensive
Contact Intel Tech India Pvt Ltd
Phone +91-9833823474
E-mail saranya.rustagi@intel.com
Price Rs 52,000

Projectors
Acer PD726W

Great overall performance
Lacks remote sensor at rear

Contact Acer India Pvt Ltd
Phone +91-9880544226
E-mail alankar_s@acer.co.in
Price Rs 1,35,000

MP3 Player above Rs
10,000
Cowon D2

Very good performance
Slightly bulky 
Contact Lipap Systems P. Ltd
Phone +91-9819917440
E-mail iaudio@lipap.com
Price Rs 11,000

Digital Cameras
(High-End)
Canon PowerShot A570 IS

Good overall performance
Lacking in macro 
performance 
Contact Canon India Pvt Ltd
Phone 1800-345-3366
E-mail info@canon.co.in
Price Rs 13,995

LCD Monitors (19-inch)
AOC 197S

Good looks and performance
Gloss finish catches smudges

Contact AOC India
Phone 1800-425-4318
E-mail info@in.aocmonitor.com
Price Rs 12,000

LCD Monitors (17-inch)
AOC 177V

Good performance
None in particular

Contact AOC India
Phone 1800-425-4318
E-mail info@in.aocmonitor.com
Price Rs 9,800

MP3 Players up to Rs 5,000
Apacer Steno A4351

Good performence
Tacky build, Screen quality

Contact Apacer Technology
Phone +91-80-25702208
E-mail   suraj_raina@apacer.com
Price Rs 1,720

MP3 Players up to Rs 10,000
Samsung T10

Good music quality, nice
screen
Tacky exterior

Contact Samsung India Ltd
Phone +91-11-41511234
E-mail jitendra.c@samsung.com
Price Rs 6,600

Internal DVD-Writers
Samsung SH-S203

Performance, inexpensive 
None in particular

Contact Samsung India
Electronics Pvt Ltd

Phone +91-11-41511234
E-mail c.serrao@samsung.com
Price Rs 1,200

Internal SATA Hard Drives
WD Caviar SE16 WD5000AAKS

Fast transfer speeds
None in particular

Contact Champion Computers 
Pvt Ltd

Phone +91-11-26214751
Web site www.championindia.com
Price Rs 7,500

Digital Tools l A-List

Graphics Cards (High-End) 
Galaxy GF8800Ultra

Sheer performance
Heats up
Contact Technology and Gadgets
Phone +91-22-23823331
Web site technologyandgadgets 

.com
Price Rs 35,000

Graphics Cards 
(Mid-range) 
ASUS EN8600GT 

Well priced, fast
None in particular
Contact Asus Technology Pvt Ltd
Phone +91-22-67668800
Web site http://in.asus.com 
Price Rs 8,800

External Portable Hard
Drives
WD Passport Portable (Black)

Excellent performance, good
value
None in particular

Contact Champion Computers 
Pvt Ltd

Phone +91-11-26214751
Web site www.championindia.com
Price Rs 6,500

Internal SATA Hard Drives
WD Caviar SE16 WD3200AAKS

Value for money, 
performance
None in particular

Contact Champion Computers 
Pvt Ltd

Phone +91-11-26214751
Web site www.championindia.com
Price Rs 4,500

Multimedia Cell Phone
above 20,000
Nokia N95 8 GB

Great all round performance
Slightly bulky

Contact Nokia India
Web site www.nokia.com
Price Rs 28,000

Below Rs 12,500
Sony-Ericsson W910i 

Great sound
Flat and clumsy keypad
Contact Sony Ericsson Mobile 

Comm. India Pvt Ltd
Web site www.sonyericsson.com
Price Rs 19,000

Intel P35-based
Motherboards
ASUS P5K Premium

Excellent enthusiast solution
Expensive

Contact ASUS Technology Pvt Ltd
Phone +91-22–67668800 
E-mail media_india@asus.com
Price Rs 15,870

Intel Integrated Graphics
Motherboards
Gigabyte GA-G33-DS3R

Very good layout
Expensive 

Contact Gigabyte Tech India Ltd 
Phone +91-22-30616666
E-mail sales@gigabyte.in
Price Rs 9,500

Desktop PCs
Sahara 20CK16

Great performer
Slightly bulky

Contact Sahara Computers & 
Electronics Ltd

Phone +91-120-4397777 
E-mail info@saharacomputers.co.in
Price Rs 40,000

AMD AM2 Motherboards
Gigabyte GA-MA69G-S3H

Well built, feature rich
None in particular

Contact Gigabyte Tech India Ltd 
Phone +91-22-30616666
E-mail sales@gigabyte.in
Price Rs 6,900

Home Inkjet MFDs
Canon PIXMA MP160

Good performance
No memory card reader 

Contact Canon India Pvt Ltd
Phone 1800-345-3366
E-mail info@canon.co.in
Price Rs 5,995

Mono Laser MFDs
Brother MFC-7420

Great cost per page, fax
No Ethernet Port 

Contact Brother International India
Pvt Ltd 

Phone 1800-222-422
E-mail customercare@brother.in
Price Rs 18,000

PCI TV-Tuners
Leadtek Winfast PVR2000

Excellent video quality and 
software
Expensive

Contact Topnotch Infotronix (India)
Pvt Ltd

Phone +91-44-42042565
E-mail naqui@zebronics.net
Price Rs 5,500

Mono Laser Printers
HP LaserJet 1020

Good combination of speed,   
print quality, and warranty
A bit slow in comparison to
others

Contact Hewlett-Packard India 
Sales Pvt Ltd 

Phone +91-124-2566111
E-mail kakuni.mahto@hp.com  
Price Rs 6,999

Mice
Logitech MX Revolution

Has a flywheel
Expensive

Contact Logitech Electronic 
India Pvt Ltd 

Phone +91-22-26571160
E-mail response@logitech.com
Price Rs 8,000

Performance Laptops
HP DV6226tx

Funky Looker, features 
Needs better graphics

Contact Hewlett-Packard India
Phone +91-124-2838700
E-mail tapoti-t.tipnis@hp.com
Price Rs 56,990

The best products tested so far in different 
hardware and software categoriesThe A-List
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Value Executive Phone
Nokia E51

Loads of features
None

Contact Nokia India
Web site www.nokia.com 
Price Rs 13,000

Business Device
Nokia Communicator E90

Extremely powerful
Heavy, bulky

Contact Nokia India 
Web site: www.nokia.com
Price Rs 40,499

Office Inkjet MFDs
HP Photosmart C4188 All-in-
One

Good print quality
No fax

Contact HP India Sales Pvt.
Ltd.

Phone +91-124-2566111
E-mail kakuni.mahto@hp.com
Price Rs 7,999

PC Webcams 
Logitech QuickCam IM

Strong performer
Manual focus

Contact Compuage Infocom Ltd
Phone +91-22-65297356
E-mail india_getcreative 

@ctl.creative.com
Price Rs 1,995
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When an OS takes ages to load, hangs, and eventually dies, it’s
time to take a peek into system processes. Many simultaneous
processes run silently on your computer. It’s generally not

possible for you to know what a process (say, “lsass.exe”) does—the
Task Manager doesn’t
state anything about it!
ProcessLibrary.com is
recommended for when
you find yourself in such
a situation.

ProcessLibrary is a
comprehensive online
database and reference
source about system
processes along with spy-
ware and Trojan threats,
and it’s all explained in simple English. You can get to know about the
nature and purpose of the processes that should run on the system,
and which ones are unwanted or suspicious and should be terminated.

The Library tab shows a list of processes, information about each of
which is available on the site.  When you narrow it down to a particular
process, say svhost.exe or AlrtIntl.dll, you’ll have an explanation about the
process and its path detail, as well as the level of threat it carries—you can
check the Security Risk (Spyware, Virus, or Trojan) associated with the
process .exe or .dll. On the same page, you’ll see a box on Removal &
Security, which offers you the options to perform a free scan. Also, using
that software, you can “boost”—as in fix—the process you’re looking up.

Shortcuts To Geekdom

Process library is, well, a library of processes

Digital Tools l 3 Incredibly Useful Sites

If you need to make, say, a budget plan or a consulting
agreement, the first step would be to visit docstoc.com
to find the right starting document. The site is an online

document sharing community where you can post, view,
download, comment upon, and rate thousands of docu-
ments, searchable category-wise (registration is required
to comment or rate). The tabs you’ll see are Legal, Business,
Financial, Technology, Educational, and Creative.

The document collection here can be classified into three
broad categories—Business / Legal, Educational, and other
user-generated material. Business / legal templates and docu-
ments can be reused after modification. 

As an example of the broad variety of documents available, if
you’re looking for a specific legal document, the Legal tab brings up
several sub-categories: Contracts, Employment, Family, Forms,
Incorporations, IP, Real Estate Agreement, Wills & Trusts, and more.

There are also educational documents like research papers,
term papers, and other study material for students as well as
teachers. Creative and user-created material like Learn Japanese
(in English), various user guides, tips & tricks, tutorials, scripts, e-
books, articles, etc. also figure in the document database.

Take a look around; it’s a great collection! You’ll find documents
ranging from Asset Purchase and Sale Agreement to Configure DNS
in Linux to How to control your brain at will. They’re categorised,
but there’s a virtually unlimited range of documents available. We
really can’t go into more detail—this site is a must-visit!

www.processlibrary.com

www.docstoc.com

Docstoc is your one-stop doc shop

DIGIT MARCH 2008

www.keyxl.com

Using a GUI without a mouse might seem insane at first,
but you see these people around you every now and
then, the types who seem unaware that there’s a

mouse by the side of the keyboard. Keyboard shortcuts save
time—precious seconds of your day, to be precise—but more
importantly, it’s one more fun skill to show off, and it saves
you from moving your hand between the two devices.

KeyXL has the largest database (believe it till we dis-
cover otherwise!) of keyboard shortcuts—you’ll find short-
cuts for Windows, Linux, Mac, and popular Web
applications. Even the latest software—like Photoshop
CS3—figure, and there’s a short description with each
shortcut. As a matter of fact, you can learn complicated
software more quickly once you know, memorise, and
practise the keyboard shortcuts. The ever-useful search
field is there on the main page, and you can search for
shortcuts for various software.

Shortcut lists for different programs are constantly
being added, and you can submit your own list(s), too.

You can find 3D objects for free download, and much more!

Samir Makwana

Enhance your keyboard wizardry, and know what’s really going on behind the scenes in Windows
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Nimish Chandiramani

Consider this: you’ve called up, say, your
mobile service provider to resolve an
issue you’re having with your connec-

tion. Once it’s been addressed, the customer
service executive informs you of a special offer
on tariffs—you think, “Ah! This fits perfectly
with my usage”, and accept the offer. You dis-
connect, satisfied and impressed. No coinci-
dence, this—if you’ve ever been satisfied with
customer service, it’s because your service
provider is using a Customer Relationship
Management (CRM) solution that gives them
all the information they need to know what
will make you happy. 

What And Why
CRM solutions let you do just that—manage your
relationships with customers—making sure that
service requests are responded to in a timely
manner, for instance. For you as a businessper-
son, it means that all your customer information
is consolidated in one database, making it easier
for you to identify opportunities for further sales.
Like the example above, a CRM solution will let
you track all your customers’ history, so when
you start a new sales campaign, you’ll know
which customers are likely to buy your product.
You’ll get your income, and your customer will
walk away satisfied, which will eventually trans-
late into even more income. Everybody wins. 

Indirectly, you’ll even be able to better your
products (or services, as the case may be). For
example, if your customers are having trouble
with a certain feature in your product, you can
use this information to amend the product’s
manual, or even change the product itself. 

Before you decide to opt for a CRM solution,
however, you should ask yourself whether you
really need it. If you handle a lot of repeat busi-
ness, then you’ll benefit tremendously from a
CRM solution—especially if your sales force isn’t
the size of a battalion. Even a small travel
agency, for example, may have a few thousand
loyal customers without having more than ten
employees. With a CRM solution, the agency
can track feedback on customers’ trips, their
suggestions, their travel patterns, and based on
all that information, keep them informed of
special packages that they’re most likely to pur-
chase. By targeting the right customers for a
package, salespeople won’t waste their time lis-
tening to the dreaded “Not interested”. In fact,
they’ll be able to handle even more customers
with the same effort!

If, on the other hand, you’re always trying
to snag new customers, and your existing cus-
tomer database is for reference only, a contact
management solution will work, and won’t be
as much of a headache to manage as a full-
blown CRM system.

CRM solutions are typically big invest-
ments, but the cost of “commercial” open
source software is significantly lower than a

Business
Digital

How Technology Can Help Your Organisation

76 Handle with Care 80 Get Self-published 

Smart Business

It’s already
widely accepted
that Customer
Relationship
Management
(CRM) can boost
your business
significantly, not
to mention make
your customers
happy—what if
you could
implement it for
your company at
little or no cost?
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Second, enforce a policy to check for dupli-
cates before creating any new customer
accounts. This is crucial for new salespeople
on your team, for whom customer names
won’t be familiar at all. Duplicate records
might have annoying consequences—a sup-
port request on one record may go ignored
because everyone was referring to the dupli-
cate, for example.

Third, decide on a convention for company
names and acronyms—whether you’re going to
use IBM or I.B.M., for example. The same
applies for places—whether you’re going to use
Delhi or New Delhi, for example. This will
prove handy when you’re searching for cus-
tomer records. Also, decide how you’re going
to use uppercase letters—whether data will all
be in capitals or title case (the first letter capi-
tal). You’ll notice the former in a lot of bulk 
e-mails that you get; it involves less effort—no
worrying about the [Shift] key ever—but
isn’t visually appealing at all. 

To make it easier for you to track your sales
team’s progress, decide on when the system is
to be updated—would a salesperson create a
new entry as soon as the customer is acquired,
or wait till the end of the day to key in all the
day’s customers? 

Finally, spellcheck—typos in your e-mails
look very unprofessional. When speaking to a
customer, make sure the spelling of their name
is verified—misspelling a name is a very effective
way of having your e-mail deleted in a second.

If you’ve already got yourself a messy data-
base, there’s no better way to fix it than to start
getting in touch with customers again—you’ll
be able to get updated data, and re-connect
with your customers, so to speak. 

Other Options
If you’re not a large company, it doesn’t make
sense to even consider a proprietary CRM solu-
tion—licenses can go as high as $995 (Rs 39,800)
per year for just five users—it’s the commercial
open source solutions we’ll stick to.
DaffodilCRM (http://crm.daffodilsw.com/) is anoth-
er promising solution—not quite as polished as
Sugar, but quite usable. Their online demo is
down as of this writing; you might have to
download and deploy it to check it out. A big
plus is that the company’s based in India, so
you’ll have better access to support. The sup-
port plans, however, are a tad unreasonably
priced for our tastes.

CentricCRM (now ConcourseSuite—
http://www.concursive.com/) has also been well-
received online, and unlike other open source
solutions that are AMP (Apache-MySQL-PHP)-
based, this is based on the J2EE platform.
Setting it up on your own serv-
er can be tricky—you’ll have to
compile the source code your-
self—so the on-demand option
is much better. 

Bottom line: no matter
which solution you choose,
you’ll see significant benefits to
your business before you know it.

nimish.chandiramani@thinkdigit.com
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proprietary solution. Commercial Open Source
means that the software and source code is
available free of cost, but you pay for addition-
al features, customisation and support. If
you’re comfortable with that, you can down-
load the software, deploy it on a server and get
cracking right away...

Give Me Some Sugar
Most commercial open source CRM solutions
offer you a free online demo, so you can see
which one works best for you. After foraging a
little, we’re very impressed with SugarCRM—
it’s undoubtedly popular (the site claims over
500 downloads a day), and is definitely one
worth considering. It’s available as a free
Community Edition, or you can choose to pur-
chase one of their paid solutions. Sugar On-
Demand is an option you could consider if
you don’t want to host the software yourself—
it’s hosted on SugarCRM’s own servers, and
available to you from wherever you have
access to the Internet. At $40 (Rs 1,600) per
month per user (for Sugar Professional; $75
(Rs 3,000) for Sugar Enterprise), it might be
worth it if you’d end up spending more on the
IT infrastructure. 

Sugar’s interface can look a little scary—it
aims at large enterprises as well—but once you
start exploring it, you’ll see that it’s logically
laid out, and you’re always only a couple of
clicks away from the information you need.
When you log in to the system, you see a list of
things that demand your attention—calls you
have to make, issues to resolve, meetings for the
day and so on. There’s also a Jotpad to type
notes to yourself. Your individual home page is
fully customisable, and you can drag the “dash-
lets” around to suit your needs. You can also
add more dashlets, including a Space Invaders
clone for those slow days. 

The tabs at the top are self-explanatory—
click on them to manage contacts, customer
accounts, marketing campaigns and so on. They
also let you manage sales leads—people who are
your first contacts before a deal is finalised—
and potential sales opportunities, so if one
salesperson is unavailable, another can follow
up with the lead and close the sale. This
ensures that your income isn’t affected if
unforeseen circumstances put a salesperson
out of commission. 

The row of links under the tabs shows you
areas that you’ve visited recently, so you can get
back to, say, a customer account from the
Opportunities screen in a flash, without having
to search or navigate a list all over again. 

Sugar also has an online library to help
you get started with the software—just click
on the Training link at the top right. You can
also view a number of Flash-based demos on
their Web site—http://www.sugarcrm.com—
which will walk you through using and
administering Sugar. 

And now, to ensure that you don’t end up
with a dirty database...

Keeping It Sane
What good is a tool for creating a customer
database if the data itself is garbled, duplicat-
ed many times over, or just plain inconsistent
throughout? Bad quality data can be the bane
of a good CRM system, but it’s fairly easy to
avoid if you address the problem before it
even begins. You’ll need to set down rules for
using your CRM system, and ensure that
everyone knows them.

First of all, access rights—you’ll need to
decide who gets to create, edit or delete cus-
tomer records. With a proper access hierarchy,
you’ll ensure that data is manipulated only by
people who know what they’re doing.Sugar’s home page gives you a quick run-down of what’s expected of you today

Flash-based tutorials on Sugar’s Web site ease your learning process

Digital Business l Smart Business
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talked about is their impact on individuals,
and the feeling of freedom they grant us. For
every LinkedIn that could get you a job, there’s
an Orkut that could result in your losing it.

Responsible Behaviour
With that freedom—to paraphrase the Indian
Constitution—comes responsibility. And for a
change, this responsibility is not towards socie-
ty or the country—it’s towards you.  In the lais-
sez faire world of social networking, it’s almost
too easy to go astray. With the absence of any
accountability or the need to face people per-
sonally, users are tempted to spice up their pro-
files and adopt a completely different persona.
Peer pressure also adds a lot to this multiple
personality syndrome: after all, we all want to
look great and have more friends or messages
from the opposite sex. And if those people are
good looking, you are guaranteed to be the talk
of the campus and the heart of the party. In
fact, there are sites where you can hire models
to be in your friend profile: they will also mes-
sage or scrap you with sentences that don’t look
like they have been spewed by a chat bot.
Choices are yours—the sky is the limit. You
might even become an Internet celebrity based
on a YouTube video: a case in point is
Lonelygirl15, a “teenager” who posted a series
of videos where she talks about her lonely life,
and which were followed by millions of people
as avidly as they would follow a blockbuster TV
show. That she was later revealed to be an
actress and those videos were professionally
shot is another matter.

The point is that people can draw erro-
neous conclusions based on your online pres-
ence—they say that on the Internet, a dog could
be a man, and nobody would know. The reverse
is also unfortunately true. The Web is a biased
judge, jury and executioner all rolled into one.
For example, not so long ago the gruesome pic-
tures of Nicole Castouras, a young girl killed
in a high speed crash were leaked by officers of
the California Highway Patrol. Those pictures
eventually appeared in more than 1600 Web
sites and made life hell for the Castouras
family, who had to repeatedly endure the sick
photographs of their daughter’s decapitated
body posted on these sites and also mailed to
them, some accompanied by comments which
insinuated that she got what she deserved.  

Many A Slip
It doesn’t take gruesome accident pictures to
ruin your reputation and peace of mind. Your
Orkut profile is just as effective. Think about it:
while you are in the race to impress your peers
by snagging the most number of female friends
and updating fake photos which show you off
as über-cool, there are some other people out
there that would possibly take a dim view of
this whole scenario. One group is your family;
another group is potential and present
employers. For the purpose of this article, let’s
focus on the latter.

By default, profiles, photos, videos and
such other badges of identity in most networks
is public. They have to be—there is no point in

Bhaskar Sarma

What do most of us do when we fire up
our browsers first thing in the
morning? Chances are, apart from

checking e-mail, we log in to social networking
sites to check up on friends and acquaintances.
This trend is more noticeable with the current
generation of professionals, many of whom
believe that e-mail is so last century. If you are
in the age group of 15-30, when was the
last time you had e-mailed a colleague

to enquire whether he or she would be there
at the office party this Friday?

As places to hang out, have fun and meet
people from all over the world these Web sites
are the online equivalent of the office water-
cooler. Most of them offer features like writing
short messages to friends, uploading pictures
and videos and projecting a unique identity by
customising profiles. Still other sites focus
exclusively on sharing photos and videos, and
thereby aim at creating a community. In fact,
we’ve covered these sites exhaustively in our

Fast Track To The Social Web. What we haven’t

andle
Care
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slaving over your profile and leaving it to be
seen by three friends. But there is a downside
to all the attention-mongering: you can be
searched for just as easily by people from
whom you’d prefer to not know that side of
your personality. Search engines accomplish
this in seconds with a few carefully chosen
keywords. General search engines like Google,
as well as people search engines like Spock—
which specifically crawl most social sites—
throw up profile photos, interests, books you
read, movies you saw and a hundred other
details. Oh, and another thing: Google caches
Web results for years. If you had led a wild life
which was reflected in your older MySpace
profile and posted a few NSFW (Not Safe For
Work) photos, be assured that someone will
still be able to access it even after you became
respectable and deleted them.

Since it is always better to show than talk,
we fired up Spock. Here you can search for per-
sons by name and/or e-mail ID, while more
advanced search options let you narrow down
the search by age, sex, location, tags and picture.
We entered a few sufficiently generic names—
we won’t mention the—and entered the tag
“sex”. A second later, the whole page was full of
profiles where the “sex” word was either in a TV
show or in the name of a movie or a book they
recently saw or read. Later in the page, we hit
paydirt: people who’ve put “likes sex” (along
with books, movies and what not) on their pro-
files. Oops! While we won’t be judgemental, and
wish them the best of luck, we can bet that when
any of them walks into a room with a Web 2.0-
savvy interviever, their applications will be
looked at with at least one raised eyebrow. 

Employees In Sights
That’s actually sad, because many of them
might have made those profiles just for fun.
But first impressions are incredibly hard to
dispel and such keywords always raise warning
flags in minds of prospective employers and
partners. Videos and photographs can also get
out of hand pretty fast and become viral. While
job oriented Web sites allow candidates to post
video resumes of themselves, putting irrele-
vant material there would risk your present
and future job prospects, especially if it
showed off your tap dancing skills with a half
naked partner, and if it ever got popular on
YouTube. As a candidate, we always research
prospective employers, looking not only at
financial reports but also how good the work
environment is. It stands to reason that
employers would also check not only our aca-
demic background, but also our social back-
ground as reflected in such sites. As Ulhas
Aher, HR Head of Datacraft—a unified com-

We’d guess you don’t want your boss to see this
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First impressions
are incredibly
hard to dispel,
and “sensitive”
keywords always
raise warning
flags in minds of
prospective
employers and
partners

With
Your paper resume isn’t the only thing potential employers are looking at.
Your life, your friends, your hobbies—if it’s on the Web, they can see it
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munication solution provider says—“I have used
sites like Orkut and LinkedIn for recruitment
purposes. The candidates express their likes
and dislikes which is a representation of their
character. These sites are also great for serving
up sources of unbiased reference”. 

These checks continue even after the can-
didate is hired. A search on Orkut would easily
bring up several communities dedicated to cor-
porations, large or small. These communities
are informally monitored by interested man-
agers to get a feel of what employees think
about their workplace.  Preferring to remain
anonymous, an HR executive in an MNC based
in Hyderabad confirmed this trend, “Our
department keeps an eye on these communi-
ties and if they see something objectionable,
often contacts the immediate superior of the

concerned employee. Depending on the com-
ment, appropriate action might be taken. We
also unofficially check the profiles of new
hires: even my profile was checked out by my
boss before I was hired.” While cases of firing
a person based on his comments about the
boss’s paunch or the company cafeteria are not
heard of, there is every possibility that such
disclosures would be viewed dimly and harm
inter office relationships.

To Blog, Or Not To Blog?
Blogs are another potential landmine in the
context of work life balance. They started off as
personal journals where people talk about any-
thing they want to—in some cases, that might
also be about work: problems with colleagues
and superiors, new things that are happening
at the office, criticism of policies and so on.
While this is all very well on pen and paper in
a private place, they are a strict no-no in public
places like blogs. Just ask Matthew Brown, who
was given the pink slip by Starbucks for criti-
cising his boss on his personal blog!

With companies starting their official
blogs, this medium has attained a modicum of
official acceptance. Official blogging, though,
is another no man’s land without historical
precedence. While corporate blogs aim to

project an image of the organisation that is dif-
ferent from the image projected by press
releases or PR agencies, quite often there are
misunderstandings where individual bloggers
might inadvertently or maliciously show the
company in poor light. Not many have an offi-
cial blogging policy or official bloggers, which
leads to incidents like the furore raised when
a Google employee commented negatively
about Sicko (Michael Moore’s documentary on
healthcare) on the Google Health Advertising
Blog (http://google-health-ads.blogspot.com/
2007/06/does-negative-press-make-you-sicko.html) ,
thus imparting an official slant to her personal
opinion. There have been other cases where
people have been fined, demoted or fired for
leaking company secrets on such blogs.        

Netiquette 2.0
As we have e-mail etiquette and social eti-
quette, there is a crying need to develop a set
of conventions where social networking is con-
cerned. The rule of thumb while you use Web
2.0 is: ask yourself if what you have intended to
be seen by friends can also be shown to your
boss. If the answer is no, don’t post it—your
boss might see it anyway. Social sites like Face-
book have privacy controls where you can
make your profile viewable only to a select
group of people: use them, and even then
refrain from keeping a half-naked picture as
your profile photo. Don’t use the e-mail ID
which appears in your official communica-
tions. When blogging, don’t talk about con-
troversial topics related to work and keep your
blog profile temperate. You also need to be
careful of what friends are saying about you.
As in school, you are known by the company
you keep on the Internet too. Be careful in
posing for photos in say, a beer party or a strip
club and request your friends to remove such
photos from their profiles. You might come
across as a party pooper, but that’s better than
generating negative impression on an inter-
viewer’s mind and losing that dream job. Even
if you aren’t affected now by the exuberant
description of how you streaked across the
campus in your second semester, these things
might haunt you when you are applying for top
management positions. It didn’t affect George
Crump, allegedly the world’s first streaker
from becoming a Congressmen and an Ambas-
sador to Chile because, you see, way back in
1804, there was no Internet.   

Then, there is always the danger that
someone (a business rival or resentful ex)
might create a fake profile on social sites and
fill it with provocative details that make you
seem like a nymphomaniac or a Casanova (as
the case may be). In fact, cases like this related
to Orkut have been reported in the Indian
media ad nauseum. In such cases the affected
parties might have to take legal measures to
salvage their reputation; the best course to
adopt is always discretion, caution and con-
stant vigilance. 

You never know who’s watching you in
cyberspace. 

bhaskar.sarma@thinkdigit.com

If the “worst boss ever” read this, they’d end the posters’ misery rather quick, we’d say

With companies
starting their
official blogs,
this medium has
gained some 
acceptance in the
workplace
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The Right Layout
Once you launch PagePlus, select the option to
Create my own design. In the Choose a Design
window, select Small Publications > Wide
Business Card. Wide Business Cards are Land-
scape-oriented, while Tall Business Cards are
Portrait-oriented.
Before you start work on the card, in order to be
certain that you view all the available tools, click
on View > Toolbars and check all the toolbars.

The Business Card
The blue rectangle that you can see in the
middle of the page is to guide you while
aligning the text and images. Similar to a grid
in the background, it helps you decide the
appropriate position of the various elements in
the card.
Start by inserting your company logo. To do
this, go to Insert > Picture > From file (or
you can simply press [Ctrl] + [G]).
To insert text for your business card, click on
the Artistic Text Tool (the alphabet “A”) on the
Tools toolbar. Alternatively, you can insert text
from any file by clicking on Insert > Text
File (or simply pressing [Ctrl] + [T]). You
can further adjust the font size, height, width,
line spacing and positioning through the
Change toolbar.
Each text or image component forms a box that
you can easily move around the page, either by
dragging with the mouse or using the cursor keys.
After inserting all relevant image and text, our
next step is to insert a separator, which is a line
towards the bottom of that card, separating the
address of the company. To insert a line, click
on the Straight Line Tool. You will find this tool
just below the artistic text tool. After selecting
this tool, click on one end of the intended posi-
tion and drag the mouse to the other end
forming a straight line. You can adjust the posi-
tion of the line by using the up and down
cursor keys.
In the same way, insert the address of your
organisation and proceed to view your card by
doing a Print Preview.
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Nash David

S
oHos have publishing needs that have no

end—brochures, fliers, bulletins, business

cards—the list just goes on and on. Saving

money is what SoHos swear by in order to stay

competitive, and we’re here to tell you just how

to get it done.

Desktop publishing is the need of the day,

and many SoHos are outsourcing their require-

ments. Why? Because even though their

desktop publishing may not require the pro-

fessional touch of an agency, the software that

is used to achieve professional looking results

will cost them an arm and two legs! Quark

Express 7—about Rs 32,000! Adobe InDesign

CS3—almost Rs 28,000! There’s no way most

SoHos can justify such expenses, especially for

occasional publishing needs. That’s where free

and open source software comes in, and all you

have to do is look around to find one that suits

you. We found PagePlus SE (www.freeserifsoft-

ware.com) and Scribus (www.scribus.net) to be the

best free desktop publishing software—you can

find both in this month’s CD.

Look Before You Leap

All creative work needs planning. Before you

search for software, you need to identify your

requirements. Whether it’s a brochure you

need to make, a flier, or a self-designed visiting

card, before you do anything else, sit down

with a pencil and paper and try and plan out

what you want to achieve. This holds true

for any sort of desktop publishing you

may have—plan, arrange, execute!

Frame a mental picture of

the most appropriate layout of

text and images—this aids in

faster execution of the task at

hand. Go hunting for the best

images to suit your requirement—

use Google to find royalty-free

images, or buy one from one of the

many services that offer them. TIFF or

PNG images with a resolution of 200 DPI

or higher are generally preferred, because

although images may seem alluring on

your computer screen, results differ once

they are printed.

Take The Plunge

Of the two software solutions we mentioned

earlier—Scribus and PagePlus SE—we prefer

PagePlus: firstly, because it’s extremely user

friendly, and secondly, because it gives you

more useful tools. Scribus, on the other hand,

is too intimidating for a beginner in layout.

PagePlus is a flexible and effective solution.

After you’ve installed the software, and before

you begin designing, say, your business card,

you need to make sure everything is organised.

Gather all the relevant text and images—

including your company logo—in a specific

folder. Use this as your project folder. Now you

can start by launching PagePlus.

The first task is to help you design your very

own professional-looking business card. To do

this, you need to follow some simple steps in

PagePlus.

Get Self-published 
Publishing needs are universal—here are publishing solutions that yield

professional results, without the need for hiring professionals

PagePlus’ toolbars explained

For almost 7 years, you have
contributed to our success as a reader 

It’s time to take it to the next level... 

We’re looking for Writers,
Copy Editors and Test Centre

Reviewers, based in Navi Mumbai

Send your resume to
editor@thinkdigit.com

Remember to specify the post applied for in the subject line

Write

Edit

Test
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Booklets, Brochures, Fliers And 
Pamphlets
The brochure we are going to design has four
printed sides, created out of a single A4-sized
paper. When printed on both sides and folded
into half, it yields four pages.

Similar to the procedure that we followed for
the business card, after launching PagePlus,
start by clicking on Create My Own Design. In
the Choose a Design window, select Folded
Publications > Books/Booklets. Select Side
Fold Booklet and hit the Finish button.
Click on the Pages tab of the Studio toolbar
located on the right, to see a snapshot of all
the four sides. Only one sheet of paper can be
used to form the four page booklet.
To the right of the screen, you can see four
sheets of paper laid out as portrait. However,
do not confuse these to be four individual
sheets of papers. These are the four halves of
the two sides of a single A4 sheet.
Insert your title with appropriate fonts and
size for emphasis. For your logo, follow the
same procedure that we followed while
preparing the business card—Insert > Pic-
ture > From File. Alternatively, you can
click on the Import Picture button on the
Tools toolbar. Drag the image to its appro-
priate size by viewing its dimensions on the
Change toolbar. You can also directly type in
the dimensions in the Change toolbar to
adjust the image appropriately.
Double-click on Page 2 of 4. This opens a
fresh page in the work area. You can still see
a preview of Page 1 in the studio area on the
right of the screen. Continue adding your text
and images on this page. Generally, in most
brochures, this is where the density of infor-
mation increases. Hence, to make it really
easier, to insert significant amount of text,
click on Insert > Text file or simply press
[Ctrl] + [T], if you are more comfortable
with keyboard shortcuts for faster results.
Continue working on Page 3 and Page 4 in
the same way. Once you are done with your
work, we recommend that you periodically
save using good old [Ctrl] + [S]. 

Associated Office Stationery
We have created a business card and now a
booklet that you can use either as a flier, a bul-
letin or even a brochure for your product. You’ll
likely have a lot of mailing requirements, and
as a result also require envelopes and address

labels. Customised address labels have great
appeal. For example, your logo on the address
labels or the envelopes of your letters creates
the impression of professionalism when com-
pared to a handwritten address, or one that is
simply typed out. 

After launching PagePlus, select Use Down-
loaded Designs.
In the Choose a Design window, go to Busi-
ness Stationery > Envelopes > DL.
With an envelope in the main work area, click
on the Design tab of the Studio toolbar. Here,
you can see a form containing fields such as
Company, Address, Phone and other contact
details. Fill in all the essential details here.
These data fields are appropriately displayed
on the face of the envelope.
You can also change the background images,
if they do not appeal to you. You can delete
the earlier picture by selecting it and hitting
the delete button. You can also replace it
with a newer image.
Similarly, for the address labels, click on
Create my own design > Small Publica-
tions > Avery Labels. Select among the
options given and hit the Finish button.
Working on this is similar to the documents
we have worked on so far—Insert Text then
Insert Image! 

Wrapping Up 
We’ve dealt with the most common office pub-
lishing needs in this article, which should make
other publications easier for you. For example,
a letterhead is a single A4 sheet of paper. You
can easily design one by keeping the layout sim-
ilar to the business card, with the logo on top of
the page followed with a separator. You can
place blanks to provide Date and Ref on either
side of the page. Finally, a separator and the
address at the bottom of the page, and you are
done with a professional letterhead.

Time to start publishing! 
nash.david@thinkdigit.com

Create professional business cards at leisure with
PagePlus

You get a preview of the other pages on the right

You can easily
design letter-
heads in a similar
manner to creat-
ing a business
card
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Agent 001

oes the word gaming remind
you of happy hours spent in
front of a Nintendo Game Boy,
or does it have you fondly
reminiscing with memories of
late night Quake 3 frag
sessions? Does a pleasant
game of Spider Solitaire relax
you? Maybe you like to

remember yourself poised with a
twitchy finger curled around the
trigger of your carbine with an
enemy’s skull in your sights?
Gaming brings different levels of
satisfaction in different ways to
different people and though we
Indians are well and truly on the
gaming bandwagon, our journey
into the realm of interactive
entertainment has just begun.

For me, gaming began with
classics like Art of Fighting, Contra,
Mario, and Spartan. The move to
PC gaming came around with
classics like Doom, Quake and
Diablo on an old Pentium 2
machine, and it’s been a move
from whence there’s no return.

But that was in the late
nineties—today’s gaming market
has evolved tenfold. For one, there
are more options available. Two—

Digital Leisure l Touched By Tech
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upgrading your PC isn’t
the headache it used to
be. Three—a lot of con-
soles vie for your atten-
tion—the Xbox, Xbox 360
(X360), PlayStation 2 (PS2),
PlayStation 3 (PS3) and Wii,
and even handheld consoles
like the PlayStation Portable
(PSP). In fact, getting into
gaming can be daunting for
the sheer variety of choice.
Not all of us can afford a
super- PC, an X360 and a PS3 with
a 50-inch plasma screen—
resources are limited, and a deci-
sion has to be made. If anything,
the fact that your cash is going to
be spent on leisure rather than
work, education or productivity
will ensure that your budget is
even skimpier. And for good rea-
son too—while spending on a gam-
ing setup, it’s all too easy to lose
your sense of financial decorum.

Unlike music—where one
piece of equipment plays all
kinds of music equally well—
there’s another variable. The
platform you choose—PC or con-
sole—is going to affect your gam-
ing experience with different
genres of games. What plays well
on a PC may not play well on a

console, and vice versa. Again,
remember that you will probably
migrate to different genres as
you get more and more involved
with gaming. You may, for exam-
ple, start with racing games and
get hooked on FPSes after playing
a couple of them, or RPGs may
start to interest you. In my opin-
ion, both PC and console make
equally good gaming boxes, and
which one suits you largely
depends on the genre of game.

Speaking of which...

The Genres Explained
Shooters
This is the most popular genre.
Such games have, (in general),
much easier learning curves, and

TThhee

ULTIMATE
GGaammiinngg GGuuiiddee
Gaming is a far better pastime
than watching movies, and can be
just as cinematic and riveting. But
you’ve got to start somewhere,
right? Here you go...
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offer instant gratification which is
why many newbies dabbling in
games for the first time start here.
Shooters can be of a number of
types depending on the type of
action and tactics employed, or
even the camera angle.

FPS (First Person Shooter):
The most popular type.
Characterised by combat from
the perspective of the player—as if
you are holding the weapon. The
best graphics and the most action
are generally found in this genre.
Some shining examples are Crysis,
Far Cry, Prey, Doom 3 and F.E.A.R.

TPS (Third Person Shooter):
These shooters usually take a
“behind the shoulder” view to
deliver a slightly more cinematic
(if less realistic) view to the action.
They usually have slightly deeper
storylines and a little less violence
than FPSes, but this is no hard
rule. Grand Theft Auto 3 (GTA 3),
GTA San Andreas, Manhunt and the
Max Payne games are examples.

Tactical Shooter:
These are based on either FPS or
TPS camera angles, but offer the
additional element of stealth. A
tactical shooter could also be a
squad-based action game where
you work with a team to, say,
take down a group of terrorists.
The best examples of stealth-
based tactical shooters are the
Splinter Cell series, and the Metal
Gear Solid series. For squad based
tactical shooters, G.R.A.W, the
Delta Force series and the Rainbow
Six series are the best examples.

Shoot ‘em Ups:
Games like the Serious Sam series
simply have one objective—fun.
Just shoot anything that moves.

RTS (Real Time Strategy)
Although the RTS genre is as
diverse as Shooters, most RTS
games have one thing in com-
mon—use resources to build up an
economy and gradually build
structures of different sorts which
give you certain benefits like addi-
tional units or technology
research options. Then build up
an army, and attack. RTS games
can be very slow or lighting fast.
Some strategy games are turn-
based as opposed to real-time,
where you make a move and wait
for the enemy to move (somewhat
like chess). For example,

Warhammer, the
Civilization series and the
Warlords series are leg-
endary turn-based
games. RTS games tend to
be a little faster paced,
since you actually build,
expand and defend in real
time. Examples are
Warcraft 3, Company Of
Heroes, Age of Empires and
Warhammer 40,000.

RPG (Role Playing Games)
Traditionally, an RPG will
have you playing the game as
an adventurer of sorts. There
are usually classes of charac-
ters like wizards, barbarians,
bards, rogues and so on, but
the classes and the skills that
each class has depends on
the story’s setting. Typically,

an RPG tries to create a
believable world out of fantasy

settings, and you are an individ-
ual in that world, living, travel-
ling, eating, sleeping, adventur-
ing, fighting and so on. All RPGs
will have some sort of points sys-
tem, where you get to level up,
thereby increasing your charac-
ter’s skills—for example, a war-
rior may be able to perform new
moves, or a wizard may be able to
cast new spells. Neverwinter
Nights, The Witcher, Knights of the
Old Republic, Mass Effect, and
Hellgate London are some of the
better known RPGs around.

Vehicle Simulation
This is another wide genre, as it
could involve a multitude of vehi-
cles from cars, aeroplanes and
motorbikes, to fighter aircraft,
battle tanks, and even spaceships.
Such games can be very serious,
simply fun, or somewhere in
between. The most common of
the vehicle simulators are car rac-
ing games—cars are something
everyone can relate to. Games like
Microsoft’s Flight Simulator accu-
rately depict flying an aeroplane,
while the Colin McRae series have
you racing in rallies with realism.
Games like the NFS (Need For Speed)
series are fun, with hardly any
deep simulative nature.

Arcade Fighters
These games usually have you as
a combatant in a series of fights
against a single opponent or a
multitude of other combatants.
You will have an array of special
moves and powers to aid you, like

being able to shoot fireballs from
your hands. Games like Mortal
Combat, Art of Fighting, and even
classics like Contra and Spartan
fall into this genre.

There are a whole lot of other
genres like sports games (foot-
ball, basketball, tennis, etc.),
music based games (want to be a
rock star? Play Guitar Hero), puz-
zle solving games, and other fun
games like pinball which don’t
really fit into any specific genre. 

So now, let’s take a look at
your two major options:

PC Gaming: A Window
Seat To The Action
How can I not sound biased when
I say that I’ve always been a fan of
the computer? Its unmatched flex-
ibility is the key—learn on it, send
e-mails, work, listen to music, surf
the Internet, watch movies—the
PC has something for everyone.
It’s shockingly adept at each of
these tasks, and far from the jack
of all trades that it may sometimes
appear to be. While consoles can-
not even dream of approaching
the functionality that the PC
offers, they do have one very note-
worthy advantage where gaming

is concerned—they were designed
specifically from the ground up
for that purpose. The X360 and
PS3 also have limited Web surfing
and movie-watching potential,
which simply means that their
manufacturers are trying to bring
them closer to their competitor…

Games People Play
Computers reign supreme for
games of the FPS, RTS and RPG
genres. They also match consoles
for TPSs and many adventure
games, sometimes even overshad-
owing them. With one or two
shining exceptions, the moment
you say First Person Shooter, I’ll
happily point you towards a PC.

The best visual treatment,
graphics, effects and realism are
often found in this genre. Not to
mention the most realistic, vis-
ceral action. PC gaming’s worst
proponent will agree when that
consoles suck at FPSes. They
require accuracy and precision
while wielding weapons that
only a good mouse can provide.

RTSes and RPGs also play
best on a PC—this is mainly due
to the fact that both these gen-
res have a lot of environment
interaction, or even group con-
trol of characters or units. Most
RTS and RPG games also have a lot
of sticky key shortcuts (such as
[Ctrl] + [Alt] + [E]) or
some other combination, which
you simply cannot execute on a
console. Most of these games have
been designed for the PC, and con-
sole versions remain poor ports.
Some of the best RTS games like
Company Of Heroes, Warcraft 3, Age
Of Empires and Warhammer 40000
all have strong roots in the PC, on
which they play the best.

Of course, the PCs forte has
been customisability. A variety of
keyboards and mice are available
specifically for gaming—

Logitech’s G15, Microsoft’s
Reclusa and Razer’s Tarantula are
gaming keyboards designed to
make the overall gaming experi-
ence more fun. Such keyboards
have a number of additional fea-
tures like extra configurable but-
tons, macro keys (keys that can
store multiple keystrokes and use-
ful for executing combos in
arcade fighting games) and back-
lit keys (for gaming sans illumina-
tion). Mice like Razer’s Lachesis,
Copperhead and Logitech’s G5
and G9 will leaving opponents
quaking (no pun!) in their boots.

Whether you’re playing your
first FPS or starting up a Quake 3
frag-fest with your friends on a

LAN, gaming mice are worth a cur-
sory look (at least). My advice is to
skip the keyboard unless you real-
ly plan to take your gaming seri-
ously—a regular multimedia key-
board will suffice. Note that the
mouse is more important for near-
ly all genres of games than the
keyboard, so choose one carefully.

Visually speaking, the PC also
delivers the best visual experi-
ence. Of course you need a mod-
estly powerful rig, but with the
right components, the graphics
on a PC will blow consoles out of
the water—though the X360 and
PS3 have bridged the gap, there’s
still a decent way to go before con-

soles get to where current-genera-
tion PC graphics are.

Hardware Requirements
When talking PC, the ugly issue of
the “hardware upgrade curve”
usually surfaces. Computers aren’t
exactly easy on your wallet once
you try to get them game-ready,
and the process of converting a PC
into a gaming rig can be expen-
sive! Once you start building a PC
for gaming, there’s virtually no
end to the expenses you can face,
and you will also need to save up
for at least one upgrade per year! 

For the biggest gains keep
this order in mind:

1. Graphics Card: This is the

The
graphics
card is the
primary
component
for gaming,
and
upgrading
it will yield
the biggest
perform-
ance gain

All RPGs will have some sort of points
system, where you get to level up,

thereby increasing your character’s
skills—for example, a warrior may be

able to perform new moves, or a wizard
may be able to cast new spells
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primary component for gaming, and
upgrading it will yield the biggest per-
formance hike

2. Processor: Your CPU feeds your GPU with
data. The faster the CPU, the faster the
GPU will work

3. Memory: if have less than 1 GB, then
upgrading your memory to 2 GB can
give you a boost of around 40 per cent!

If you are not very discerning about how
good your game looks, then a mid-range, 
Rs 8,000 graphics card will get you through eas-
ily. Discerning gamers who want to play the lat-
est games in all their visual splendour will need
to keep a budget of around Rs 15,000 for a good
card. I recommend NVIDIA’s 8800GT-based card
(Rs 13,000) to the discerning gamer, and
NVIDIA’s 8600GT core (Rs 7,500) to the more
budget-minded. For the extreme gamer who
wants to run games at very high resolutions
with all the visual settings kept at maximum, a
single graphics card may not suffice. But for the
simple reason that PCs get outdated so fast, I
don’t recommend investing in an SLI or
Crossfire (multiple graphics cards) setup.

The second component you need to inspect is your
CPU. The faster the clock speeds, the more frames per
second you will get in any game. Intel’s latest 45 nm
Penryn processors (codenamed Wolfdale) are just out.
The Wolfdale E8400 which runs at a speedy 3.0 GHz,
is priced at just under the Rs 10,000 mark, and is an
excellent solution for gamers. In fact, this processor is
a killer deal for any kind of fast PC, and I heartily rec-
ommend it. If you must have something cheaper,
Intel’s older 65 nm Core 2 Duo based E6750 (2.66 GHz)
is available for Rs 7,900. Quad-core proces-
sors are also available, but the two addi-
tional cores don’t do much for gaming,
since most games are heavily single-
threaded. The cheapest quad-core is Intel’s
Core 2 Quad 6600, a 65 nm, 2.4 GHz chip
(Rs 11,000). As for memory, opt for a mini-
mum of 2 GB of DDR2 system memory—its
dirt cheap these days at Rs 900 per GB—
and you’re set to go as far as your PC’s per-
formance goes. Look for good brands like
Transcend, Kingston, and Corsair.

But wait…the devil is in the details,
right? A good monitor is essential to get
the best out of premium components,
and these days the name of the game is
widescreen LCD. A 22-inch widescreen LCD will
sport a native resolution of 1680 x 1050 pixels, and
should cost around Rs 15,000. 24-inch TN panels are
in the realm of 19,000 bucks and I feel this is superb
value for money. Brands to look out for are Dell,
ViewSonic, AOC, Acer, BenQ, Samsung and LG.

Keep in mind that these recommendations are
generic, and certain genres of games will run easily
on even lower-end hardware. Games like racing
games and adventure games (in general) are not as
harsh on system requirements as other genres,
although there is no hard and fast rule.

Consoles: Single Minded Purpose
Consoles are broadly of different types and the term
console is used to signify that the gaming station is a
device other than a PC. Even the Sony PSP—a tiny

handheld device—is a console in the strict sense of
the word. Over the past two years, we’ve seen a lot of
developments in the world of consoles. One serious
advantage over the PC remains that consoles are
designed keeping games and game developers in
mind, and it takes a console a couple of years to
mature and to get proper development support.
After all, what good is a shiny new, powerful console
with no games to play? The PS2, for example, was
released in the year 2000, and still enjoys a much
larger fan following than the PS3. In fact, it was a

title that was released much later
that actually sold the PS2—God of
War. Even the X360 experienced a
tremendous boost in sales with
the release of Gears of War—a third
person shooter that was launched
a year after the console. Whereas
you would have undoubtedly have
had to upgrade your PC a number
of times from 2001 to 2007 to play
games, and spent more than a
lakh on components, if you had a
console like the PS2, chances are
you’d still be enjoying the experi-
ence. In fact, the best titles for any
console tend to release at least two

or three years after the console is launched, that
being the period of time it takes developers to churn
out a good game.

The X360 is in no way a mature platform. Sure, it
has some great titles, like Gears Of War, The Elder Scrolls
4: Oblivion and Mass Effect, but the best is yet to come.
In fact, I remember when the Xbox came out,
Microsoft only had a single big title for it—Halo.
Consoles also cannot be modified to improve per-
formance and parts can’t be swapped out like a PC, so
a developer has to think of the hardware of the con-
sole and its limitations when he writes code. With a
PC, on the other hand, most developers know that
they can design something a little heavier than what
current generation hardware can run comfortably,
and manufacturers like NVIDIA, ATI, Intel and AMD
will just go back to their drawing boards and design

something more powerful.
So when you go with a con-
sole, you needn’t think
about future-proofing.

The Hidden Costs
So then, a console seems to
have all the answers. Why
not buy an X360 for
Rs 20,000, instead of a PC
which costs Rs 50,000, and
which you have to upgrade
repeatedly? There’s a pit-
fall to consoles too. Most
consoles have anti-piracy
measures built in and so do the game titles, but
unlike PCs where you can have cracks and registry
editors, you must have the original game DVD in
your drive before you can start playing on a console.
If you’re like a bowling ball at an arcade with game
titles you’re going to chalk up quite a bill, especial-
ly considering new titles for the latest consoles
(X360, PS3) can cost as much as Rs 3,000. While this
doesn’t mean that you should buy a PC just so that
you can play pirated games, PC titles are generally
more varied than console titles, and tend to cost
less, and you also get special editions where you can
buy an entire series in a single box for much less
than the individual titles.

Most people who buy an X360 use their TVs to
play games, and then complain “man, the graphics
suck!” And why not? Consoles like the X360 and PS3
have been designed with a resolution of 720p
(1280x720 pixels) in mind—a regular television can-
not even hope to meet that specification, and you
the image you see is blurry, lacks colour, resolution
and even detail. An additional cost which you
should incur is to buy yourself an LCD / Plasma
screen to go along with the console—this is really
where a console will earn its stripes and the expe-
rience will be enjoyable and immersive.

For a viewing distance of around 10-12 feet, a 32-
inch LCD should do the trick. Brands to look out for
are Sony, Samsung, and LG. If you have a larger liv-
ing room then go for a bigger screen, since chances
are you’ll be sitting further away, and remember
that such a screen, in addition to your console,
makes for a killer movie-theatre like experience.

In fact both Microsoft and Sony have gone
through pains to ensure that their consoles are
more than just gaming stations. The X360 is a full
fledged HD-DVD player, while the PS3 comes with a
Blu-Ray DVD drive. This kind of future proofing
ensures that your console is ready for the next gen-
eration of content, although on a minus point such
drives do increase prices. 

What To Consider
Consoles use controllers to interface with them.
Some of them are wireless, which give you the lib-
erty to sit far away from your screen without hav-
ing a clutter of cables. Both the X360 and the PS3
have such controllers, while other consoles like the
Nintendo Wii (pronounced “we”) has a special
remote control unit that makes use of built in
accelerometers and gyroscopes as well as infrared
tracking to make use of user gestures and actions to
control actions in a game, as well as the traditional

button system. But really, it’s
titles that sell consoles; the only
point of difference that matters
to the user is applications—in
this case, games.

So what games feel better on
the controllers of a console? Well
the most convenient candidates
are arcade fighters and hack-em-
up games that require a lot of
frantic key presses (called button
mashing) to execute combo
moves, or use special powers.
Accessories like racing wheels
are also available for consoles as

they are for PCs, and racing games on a console
have the added advantage of being played on a larg-
er screen as opposed to your PC’s monitor.

The next thing you need to look at is the present
and upcoming crop of game titles for each console.
This is very important, because unlike a PC which can
be used for many things other than gaming, you
don’t want to be stuck with a console that hasn’t got
adequate title support. Garnering developer support
is important—more game developers developing for
your console equals better games. Development stu-
dios have been taken over (a so called forceful con-
version) and we’re even seeing developers who are
working on titles for both consoles. Franchisees
change hands too—we’ve seen Devil May Cry 4 being
announced for the X360 as well as the PS3, previous-
ly this franchisee was a Sony exclusive.

The PS3 doesn’t have many noteworthy titles to
speak of—in fact, God Of War 2 (the sequel to the best-
selling God of War) was announced for the PS2 and
not the PS3, which clearly proves the point I was
making about the longevity of a console as com-
pared to a PC. That aside, the PS3 is a very strong
contender for your attention, especially considering
that most of its big titles are scheduled for 2008
launches. However, the PS3 makes a costly proposi-
tion and costs 60 per cent more than an Xbox 360.

Microsoft has another distinct advantage when it
comes to the X360—they have very strong roots in PC
gaming, where their Windows rules supreme as a
gaming platform. It’s a simple matter, therefore, to
approach developers to develop games for their con-
sole platform as well, or even release X360 versions of
PC classics. We’re seeing games like Universe at War:
Earth Assault, Rainbow Six: Vegas, and Fallout 3 all head-
ing for the X360 as well.  The reverse is also true, and
many Xbox / X360 titles make their way into PC—
Gears Of War, Halo, and Jade Empire are a few examples.

In Retrospect
Regardless of how much you spend, the hardware you
use, the platform you choose, or even the genres of
your taste—the main aim of games is to have fun. They
involve us, pull us into a world where anything is possi-
ble, and you’re at the centre of it. You get to control
events around you...playing God can be fun! Games in
moderation will benefit your thinking, and can even
have effects like lowering stress levels, or even improv-
ing hand-eye coordination. You’re never too young or
too busy to start, and it’s never too late to get into it.
As for me, I’m gearing up for our next Quake 3 session
which begins in another 15 minutes…

agent001@thinkdigit.com

Keep in mind that these recom-
mendations are generic, and
certain genres of games will
run easily on even lower-end
hardware. Racing games and
adventure games are not as

harsh on system requirements

The most
convenient
titles for
consoles
are arcade
fighters
and
hack-em-up
games that
require a
lot of 
frantic key
presses

Digital Leisure l Lead Feature
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that the fact that no cell phone
can approach the kind of mul-
timedia functionality (camera
aside) that a PMP will give you.
PMPs in general have bigger,
better screens and better
music playback quality—that
alone is enough to ensure a
steady demand from more dis-
cerning users.

A PMP is as personal a
device as a cell phone or head-
phones, and no two people will
have the same requirements.
While someone may want to
watch videos in bed, another
may need something with
exemplary music quality to use
as a portable source. Someone
else may need a basic player to
tune in to music en route to
their workplace. PMP vendors

all the honking around you, or
the din made by fellow trav-
ellers aboard your daily 9.30 am
local train?

For many of us, the Portable
Multimedia Player (PMP) is a
blessing sans disguise. The
next time you’re travelling,
just ask anybody with earplugs
stuck in his ears what it means
to him. Music soothes, relaxes,
and is akin to the daily morn-
ing cup of fresh tea. To further
testify the popularity of PMPs,
just visit any electronics
store—chances are you’ll see
many such devices—they sell
like hot cakes these days. Not
only are they immensely func-
tional, but whip out an iPod
and a couple of people around
you will surely perk up. Add to

Michael Browne

Silence speaks a thousand
words. Poetic but true,
though the sheer amount

of noise pollution these days
means you may well need some
silence to hear anything, or be
heard yourself. If you’re a
metropolitan who spends a
couple of hours commuting to
work, you’ll probably lament
the lack of time spent with
loved ones. To make things
worse, the couple of hours of
mandatory travel are marred by
all kinds of pollution. Short of
scrapping hydrocarbon-spew-
ing automobiles totally, there’s
nothing that can be done about
air pollution, but what about

88 DIGIT MARCH 2008 89DIGIT MARCH 2007

Whether road warrior or daily com-
muter, your journey just isn’t com-
plete without a good dose of music—to
soothe your soul, bust stress and relax
your nerves. We’ve got 46 faithful
companions, just waiting to take that
dusty, noisy ride with you...

Imaging Rohit A Chandwaskar
Photograph Jiten Gandhi & Sandeep Patil
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have realised this, and through-
out this test you’ll see devices 
specifically designed for a partic-
ular use and performing other
tasks as well—sort of like a jack of
all trades and master of one.

FLASH-BASED PMPS
BELOW RS 5,000
Sure, PMPs scale with price, and
you get exactly what you pay for,
but not everybody wants a high-
end PMP with excellent perform-
ance and features to boot. That
doesn’t mean that a value-based
player has to be a compromise.
Au contraire, sub-Rs 5,000 players
have a host of features that were
previously available only on
much costlier models. Part of the
diminishing cost is due to the
sharply declining prices of flash
memory—prices have dropped to
quarter of their values a year ago.
Equally to blame is the increas-
ing popularity of PMPs—nothing
mysterious, just the simple laws
of economics at work. So, you can
get a very good sounding PMP,
with features like FM radio, text
document support, and basic
add-on features like an alarm,
stopwatch, and even PIM features
like contact management.

Features
Of all the players we received, the
concept of a watch that’s an MP3
player as well was somewhat
exciting. The Aigo U Watch MP3

is a nice little item—cool and
funky-looking with all the set-
tings of a good MP3 player,
including an equaliser. It loses
out on FM support, and of
course, video playback isn’t pos-
sible. It’s also let down by an un-
intuitive and painful menu sys-
tem, and the fact that you’ll have
a cord dangling from your wrist
doesn’t help any. Transcend’s
T.Sonic 840 comes in a piano
white facia with a solid steel back
that is (thankfully) not chrome
plated, but matte—no smudges!
It’s a full-fledged multimedia
player with music, photo and
video capabilities, and has a pret-
ty good screen to boot. The but-
tons seem a little tacky, but not
as bad as some of the other play-
ers. iRiver’s S7 is another cool
looking player—its front sur-
face looks like a magic cube
with indented intersecting
grooves built into it. The S7 is
meant to be worn around

your neck—and it’s certainly
attractive enough. YES had four
players in this comparison—and
all their players in this category

have been in our labs last year.
Creative’s Zen Stone and Zen
Stone Plus are very compact look-
ing players shaped like pebbles—
the difference being the screen
on the Plus.

The Sansa Shaker was anoth-
er novelty—it looks like a salt
cellar (hence the name), and

although it isn’t feature rich,
it’s good for kids, owing to its
tough body. Apacer’s Steno
AU581 sports a grey metallic
finish that is dominated by a
crisp blue OLED screen.
Zebronics had the smallest play-
ers in test—both the Beta and
the Gamma are compact and
solidly built, and sport OLED
screens. Zebronics’ Gamma has
a very nice feature where music
fades in if the player is paused
and then un-paused, so your
ears don’t get blasted. Sony’s
Duo—the NWD-B103F and NWD-
B105F—are designed to look like
large flash drives, and there’s
no hassle of a USB cable—you
can just plug the player into a
USB port. Needless to say, both
are built really well despite
their plastic bodies. The pearl-
white finish is bright, without
being overly f lashy. Another
pen-drive-like player, the
SanDisk Sansa Express attracted
and held our attention. It’s built
like a little brick, and sports an
aesthetic pearl grey finish. The
front is dominated by a legible
OLED screen. Both the SanDisk
Sansa Express and the
Transcend T.Sonic 840 have very
well laid-out menus—the former
is very simple and uncomplicat-
ed—a boon when dealing with a
small screen—while the T.Sonic
840 scores on usability due to
its much larger screen and intu-

itive interface. The Aigo MP-
F585 is a well-built and compact
player with a smudge-attracting
chrome finished rear. The only
irritation here are the small
and tacky buttons.

Performance
Sony’s duo offered good per-
formance—while the overall
bass seemed a little muddy on
the Bose earplugs, things sound-
ed just right with the Audio
Technica circum-aural cans.
One complaint was the volume
levels on both these players—not
as high as we’d like—far from
ringing, our ears barely even got
warmed up…

The Transcend T.Sonic 840
suffers from sluggish perform-
ance. Navigating menus will
cause music to skip—not a good
thing at all; keep your hands off
it while tuning in to your
favourite tunes. Both the T.Sonic
840 and the T.Sonic 610 offer
good music quality, but the for-
mer is a better player as far as
vocals go—a strong mid-range is
never bad. The T.Sonic 840 is a
decent video player mainly due
to its clear screen, but with the
issue of processing juice rearing
its ugly head again, movies
weren’t the experience we
hoped they’d be. With its lighter
interface and the OLED screen,
the cheaper T.Sonic 610 doesn’t
have the issues that plague its
pricier sibling.

The cute Aigo U Watch MP3
may be fun as a wristwatch, but
it wasn’t as much fun to listen to.
With boomy bass and a very
restricted top end, we were disap-
pointed—novelty is no substitute
for performance. Its costlier sib-
ling has overly bright female
vocals, with a little extra colour-
ing in the top end of the vocal
spectrum. Male voices sound spot
on and the mids are strong, even
over-emphasised. Both the Sony
players impressed us with their
sound quality, good highs, and
nice instrument detail—unfortu-
nately, they don’t go up to even
normal listening volumes, let
alone loud volumes. SanDisk’s
Sansa Express is an impressive
music offering.

The YES YMP 30 is the best
music player from amongst the
YES players—the YMP 18 has
some issues with female vocals—
they sound harsh and the vol-
ume needs to be turned down to
prevent an earbleed; guitar

tones are well-rounded with
decent detailing. The YMP 35
scores halfway between the bet-
ter YMP 30 and the inferior YMP
18. The two Zebronics players—
the Beta and the Gamma sound
good—comfortably high vol-
umes, good bass, and with a full
mid-range. 

Conclusion
We were quite honestly, (and
pleasantly), surprised to see the

performance that these minnows
put forth. A good product with
serious value for money is always
a good thing, since one purchase
will encourage several more
from people who come in touch
with the owner and his or her
positive experience. The fact that
we’ve seen a few of these players
in the hands of various com-
muters aboard buses / trains sim-
ply means that market penetra-
tion is quite good.

If you look at our graphs,
you’ll see a strange phenome-
non—the cheaper PMPs in this cat-
egory offer superb performance
for the money, while the costlier
players don’t offer a proportional
bang for the buck. This clearly
means that hikes in price in these
sub-Rs 5,000 products come with
a minimal hike in value—some-
thing we were alarmed to see. 

Apple iPod Touch 8 GB: Thy Palm Over Flo-eth!

When Apple announced a PMP based on
their iPhone concept, many of us were

excited—for the first time we’d have
freedom from menus, complicated
sequences of button presses to achieve a
simple task, and the ability to navigate a
device at our
leisure. After all,
exploration is a
leisurely activity, isn’t
it? Now that we’ve
used the iPod Touch,
we must say it’s an
experience that’s been
conceptualised
exceptionally well and
executed with the same
panache and finesse that
Apple has been known for.
Once you play around with
the Touch, feeling it and
exploring its world, chances
are you’re already doomed to
shell out the 17,000-odd
Rupees that it takes to own
one. And people will want to
possess such a device with the
same fervour that wannabe
rich-boys chase Lamborghinis
and Playboy Playmates with. And
all this even before you listen to
what it can do to your senses!

The Touch incorporates
excellent sound, with the kind of
tonal neutrality that most run-of-
the-mill PMPs can only dream of. With a
bass response approaching perfection, a
deep hit-in-the-gut feeling that can only
come with expensive speakers, the Touch
sounds equally at ease with Heavy Metal as
it does with Jazz or Blues, or even Rock

music where liquidity of response is the
name of the game. With class-leading
vocals and mids, the Touch has a revealing
top end that’s clear and precise without
being overly bright.

It’s a photo viewer well above par, and
you’ll love the way browsing

through photos is as simple as
flipping through an album. As if
to prove its “touch” status,
there’s a single button on the
facia whose sole aim is to return

to the main menu, regardless of
where you are. It’s a very good
video player too, and will satisfy
even movie junkies with its large,
crisp and clear screen.

The integrated WiFi ensures
that you’re connected even
while...err...disconnected, even
as the Safari Web browser
makes a snap of surfing the
Internet. Initial firmware
issues had us bothered
about the sluggishness of
the browser, but that’s
history with the version 1.1
firmware. With the ability
to flash your device
online, and the use of
the entire storage space
as a Flash drive, the

Touch also boldly goes
where no previous iPod (save

the very recent 3G Nano and 5.5G
Classic) has gone before. 

Its one of those rare must have lifestyle
products, like a Nokia N95 8GB, or even a
BMW M3—one of those flashy yet functional
devices that doesn’t really deserve your hard
earned cash, but demands it…

We divided our PMPs into two categories:
1. Flash-based
2. Hard Drive-based
We further divided the flash category into
price based segments:
1. Flash-based players up to Rs 5,000
2. Flash-based players from Rs 5,001 to 
Rs 10,000
3. Flash-based players above Rs 10,000

For a look at the features we graded,
turn over to our tables. For performance,
we tested the audio and video
performance of each player. Audio
performance has been given greater
weightage, simply because this is more of
a priority for most people.

On the video front, we judged each
player’s display quality in general for
multimedia content.

Alongside is a list of the audio tracks
used and what we looked at in each track.

Good music requires equally good
gear, and the bundled earplugs aren’t any
good if one is to make a comparison. We
used a pair of supra-aural Grado SR60s, a

circum-aural Audio Technica ATH A900,
and Bose’s Intra Ear earplugs for our
testing purposes. These headphones
allowed us to listen to the finer nuances
of each track. Each song was rated on a

scale of 1 to 10, taking an average of its
performance on each headphone. After
that, we tested each PMP with their
bundled earplugs and rated their earplugs
against the trio of reference cans.

How We Tested

Tracks
Eagles—Hotel 
California

The Corrs—Brid og ni
Mhaille

Charlotte Church—Bridge
over Troubled Water
Pink Floyd—Speak to Me
/ Breathe
Dire Straits—Sultans of
Swing
Guns N’ Roses—
November Rain (Live)
Eric Clapton—Layla

Chand Sifarish (Fanaa)

Beedi (Omkara)

What We Looked At
The lead guitar in the beginning, drum bass, male vocals. There are a
couple of places where minor nuances like the the artists hand moving
along the guitar body can be heard, something we looked out for
Very good track for female vocals. Voice timbre, accurate tonal balance
and vocal texture is of utmost importance. Accompanying instruments
are mostly higher frequencies, soundstaging is also important
Strong female vocals. Charlotte Church has a lot of depth to her voice,
and can take low and high octaves equally well
Sensitivity to low volume sounds, soundstaging, and accurate
reproduction of electronically produced sounds
Guitar work is exemplary here. We look for clarity, and detailing
around the 500 Hz mark (guitar frequency)
Fast drum attack, good array of instruments, lots of guitar fill-in

Male Vocals, and a lot of intricate guitar work make this one of the
best blues songs to check for music quality
Good vocals, and a super hit song, drum and tabla accompaniments
make for a melodious number with a lot of nuances to pick up
Female vocals, and a fast number, gives us a good idea of how the
player will perform on most indipop albums

Apacer Steno AU351
Performance at
extreme value
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SanDisk Sansa Express
A Li’l monsta in disguise
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Transcend’s T.Sonic 840 is an
impressive offering—all the
features and decent perform-
ance at an honest to goodness
price of Rs 3,750, but one look at
the Apacer Steno AU351 will
shock you—85 per cent of the
840’s performance at just 46 per
cent of the price. That’s
value for money!
Supercomp’s Semp3-S7A
was another such player—
very decent music quality at
a price of just Rs 1,500, and it
even manages a tiny screen—
excellent value for someone
looking at something entry-
level. Digit’s Best Buy is an award
few like to share, but we’ve
seen enough to award it jointly
to the Supercomp Semp3-S7A
and the Apacer Steno AU351.

Other noteworthy products
in this category are the duo
from Sony and the Sansa
Express. Surprise picks, yet
equally good products, were the
duo from the Zebronics stable—
superb price for the sound qual-
ity—Rs 1,650 for the Gamma,
and Rs 1,750 for the Beta. YES’
YMP 30 was another excellent
performer as far as music goes,
and we have no qualms about
recommending this to someone
who’s a little more discerning
with sound quality.

Aigo’s MP3 watch catches
your fancy, but doesn’t offer
either the performance or the
usability to please. If you’re look-
ing for a watch, chances are you’ll
look elsewhere. Do the same in
case you want a good PMP.

FLASH-BASED PMPS
Between Rs 5,001 And 
Rs 10,000
Anyone spending more than 
Rs 5,000 on a PMP had better
know what he’s buying, and
that’s what we’re here to ensure.
In general, these players have
more storage space, a better list
of features and even better audio
and video performance. And not
for nothing, because they vie for
attention amidst sub-Rs 10,000
multimedia cell phones, which
have their own added benefits.
Features such as FM radio and
better screens are taken for
granted. What you need to look
at is the quality of audio and
video, as most of these PMPs will
support movie playback—unless
they’re specifically targeted at
music only user groups. Also look
at photo viewing options—a neat

little plus point that much
cheaper players—like the
Transcend T.Sonic 840 in the pre-
vious category support.

Features
SanDisk’s Sansa E280 has experi-
enced a sharp decline in pricing—
it’s an 8 GB PMP, priced lower
than its 4 GB sibling was last
year! The E280 is built like a tank;
it’s also very traditional-looking,
and has a nice solid metal back
finished in matte. The scroll
wheel dishes out some feedback,
but it’s a scroll-type wheel and
not touch-sensitive like the
iPod’s. Speaking of which, the
new Nano 3G (third genera-
tion) is gorgeous! It’s nearly
half the length of the previous
Nano, and a little wider with
a slightly larger and brighter
screen. The smudge-happy
yet utterly sexy chromed
rear makes a comeback, and
the new Nano is compact
enough to sit in the tightest

pockets without fuss. It’s got
video playback now, and Apple
claims to have upped the bat-

tery life as well. Their click-wheel
is as good as we remember, and
with the controls designed into
it, there are no protrusions of
any sort on any part of the body.

Samsung’s T10 is even slim-
mer than the Nano, and lighter,

with a fibre body instead of
metal. Its sibling, the YP-S5 is
very similar to the S3 from last
year, with a sideways sliding
body that opens to reveal the
inbuilt speaker and disable the
headphone jack. Both these play-
ers feature illuminated touch
controls—great flaunt value, but
perfectly usable. One irritation
was the volume level on the
headphone out getting reset to
50 per cent each time you switch
from the loudspeaker to the
headphones. Very unassuming
and un-glamorous the Philips
GoGear might be, but it’s a well-
built, satin black player that’s
replete with features. The only
let down is the screen—not as
bright or as clear as we’d hoped.
Not unreadable, but for a video
PMP, we expected better.

YES’ YMP 45 is a neat PMP,
made attractive by a strip of red
plastic that runs around the
screen and adds a touch of piz-
zazz to a rather ordinary black
body. Mitashi’s MWI-4GA has a
chrome-finished posterior, but
it seems to be plastic and not
metal. Although the player is
attractive, build quality is
mediocre and the tackiness of
the buttons is unacceptable.
Creative’s Zen is a plain looker
with a black glossy front and
matte-finished plastic rear

that’s been moulded to look
like ripples in water after a
splash. Note that the Zen has
a large-ish screen, and is tar-
geted at video aficionados.
Cowon’s iAudio 7 is another
neat looker—very compact and
very well built. The screen
isn’t as good as some of the
other players, particularly
the Samsung models, the
iPod Nano, the Sansa E280
and the iRiver X20.

The Sansa E280 has all the
features you need—music,
photo and video support, FM
radio, text support and even
expandability (should 8 GB not
suffice). The iPod Nano has most
of these features (excluding FM
radio and expandability), and
the addition of nifty add-ons
like a stopwatch, alarm, calen-
dar and contacts make the Nano
a superbly converged device.
Unlike older Nanos, this one can
also be used as a pen drive. Both
Samsung PMPs also have
Bluetooth support, which can
be used to transfer music to (but
not from) other devices—that’s
taking anti-piracy nuttiness to
the limit, in our opinion.

Sony’s NWZ-615F also
impressed with its feature list,
the only thing missing is
expandability (and Bluetooth,
which was exclusive to the
Samsung PMPs). 

Performance
Our first major fight for top spot
sees the excellent Samsung YP-
S5 and the T10 slug it out with
the Apple iPod Nano 3G, the
SanDisk Sansa E280 and the
Cowon iAudio 7, with the iRiver
X20 neck and neck with every-
one. Both Samsungs aren’t flaw-
less, however—closer tests reveal
what seemed like a slight roll-off
for lower frequency sounds in
the first couple of octaves. The
highs sound excellent, however,
and female vocals are delivered
outstandingly. If we were to
choose the two best-sounding
PMPs from this excellent lot, the
laurels would rest with the iPod
Nano and the iRiver X20. From
the lower to the upper bass
ranges, low frequencies are
defined and tight, yet the
thump is very apparent—some-
thing that is as important for
bass-heads as it is for audio-
philes. The mid-range is well-
defined, smooth and full bod-
ied, and guitar detailing will

Cowon D2: A Different Beast

When we think wild, performance
uncontrolled, we think Touch. When

we think features, power, usability we
think D2. The Cowon D2 was last year’s
winner, and the reason for making it two
in a row is as complicated as it is simple.
Why improve on perfection, or as close to
it as is possible in this imperfect world?

The Cowon D2 is a very unassuming
player—as small as a Nano, but twice as
thick—and with very unappealing lines that
make you go “Yuck!” at first. By then, you
quickly realise that first impressions aren’t
necessarily the last, and it’s more a device
that you can live with daily rather than
admire from a distance, much like the
neighbourhood belle when compared to a
supermodel.

You want features? How does FLAC
support, inbuilt FM radio, expandable
memory, a touchscreen, text reading and
notepad support sound to you? This device is
an amazing music player as well, and
although the screen is on the small side, it
offers a fantastic movie experience as well.
It’s very powerful, and offers more features

and performance
per cubic inch than any

other device we can think of.
The D2 is all about functionality and

features, and you will find lots of settings
to play with while playing music and even
movies. In fact, we were surprised at the
equaliser options, where cut-offs can be
set for each frequency range—for example,
you can set the first equaliser from 40 Hz
to 80 Hz or to 110 Hz. Our only possible
issue with the D2 is it’s a little thick for its
small dimensions, and may not gain
popularity as an in-pocket jogging
companion as the iPod Nano 3G. We’re
sorry not to find anything else to nitpick,
but it’s the way of a class A device to
deliver all the goods with nary a hint of
bad in sight.

Samsung YP-S5: The Power Of A Touch

Samsung’s been known to
make excellent PMPs—

our only issue has been their
atrocious pricing, thanks to
which hardly anyone is seen
toting a Samsung player.
Someone in Samsung’s top
brass must have heard our not
so silent plea, and here goes—
the YP-S5 has more features
than the YP-K3 we tested last
year, and costs just a fraction of
its predecessors’ price of 
Rs 18,000, at just Rs 6,600. An
amazing deal, this, considering
the S5 is a potent all-round PMP. It has
an amazing LCD screen—that at first
glance appears to be an OLED screen—
and soft touch controls that are backlit in
very pleasing colours such as cool blue
and light yellow. We can guarantee looks
from just about anyone if you just whip
out this player, because chances are
people will figure it for being at least
thrice as expensive.

It features Bluetooth, a rare but useful
feature in case you want to transfer music
from it to your cell phone or even PC, but
the S5 itself requires to be synced with a
PC to transfer music. While on the topic,
sound quality is very good, and the S5
approaches the quality of costlier players
easily. Its got a very clean and crisp
sound to the vocals, and both male and
female vocals seem to come alive. While
it doesn’t go as low as the Cowon D2 or
the iPod Nano and Touch, the bass
definitely can’t be termed as deficient
in any way. It also provides sufficient
volume to drive most headphones

properly, and we didn’t notice any issues on
our two reference models.

If you’re looking at something
extremely usable at a great price, but you
want something that stands out and feels
far more expensive than its price, the S5 is
a tailormade fit. It represents the best
value amongst the sub-Rs 10,000 PMPs
and is one of those rare products that
actually offers more satisfaction for the
compensation it demands.

Samsung T10
Slim is good...

Apple iPod Nano 3G 4 GB
Pocket audiophile
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knock your socks off. A glorious
top-end awaits you at the upper
echelons of the audible sonic
spectrum. The Cowon iAudio 7
loses out by a hair’s breadth, but
bass on the iAudio 7 is astound-
ing—a deep hit-in-the-gut feel-
ing that was especially notice-
able with the circum-aural
Audio Technica reference cans.
Once again, we must caution
you—such detailing is only possi-
ble on good headphones. The
default earbuds that ship with
even some of the best players are
atrociously short of any kind of
aural experience, and if you’re
serious about sound, you’ll
chuck them out. 

The YES YMP 45, Philips
GoGear and Mitashi MWI-4GA
just aren’t in the same league as
the above mentioned PMPs, and
the Sony NWZ-S615F and
Creative Zen 4 GB fall slap-bang
in the middle of the best and
the rest.

If you’re looking for primari-
ly a video player, then you
should look at another category.
The YES YMP 45, Creative Zen,
and the Mitashi MWI-4GA have
the largest screens—and size
matters when you’re talking
anything visual. The Creative
Zen will win the race for the
best video PMP, because it’s got a
better screen, and has excellent
music quality to begin with.

Conclusion
Our graphs reveal two products
standing a little taller than the
rest—amazingly, the Apple iPod

Nano 3G and the iRiver X20
score exactly the same,
even after having slightly
different features and a bit
of a performance gap.
While its sheer audio
quality, compact build,
looks and extensive fea-
ture list are enough to
make the Nano stand
out in any company,
the more suave iRiver
matches it very close-
ly. The Nano is espe-
cially recommended
for those looking for
something compact
yet powerful—it
offers the smallest

footprint and the
best performance (albeit by

the smallest of margins). But if
you take a look at the third
dimension—the price—things
begin to change. The Samsung
YP-S5 offers the biggest bang for
the buck—it’s a marvellously
well built device, the touch con-
trols are as precise as clockwork,
and it comes very close to both
the Nano and the X20 in terms of
performance. We find no serious
reason to nitpick—it’s even got
speakers! Our Best Buy award
belongs to the second-cheapest

device in the entire category—
the Samsung YP-S5, it’ll just
about be the best Rs 6,600 you’ve
ever spent.

Cowon’s iAudio 7 and
SanDisk’s Sansa E280 also have a
nice mix of quality, storage space
and features—highly recom-
mended as well.

If you’re looking for a video
PMP with good audio quality,
look at the Creative Zen—it
offers the best of both worlds:
good music quality and a
superb screen. The YES YMP 45
and Mitashi MWI-4GA could
also interest you, but audio
quality takes something of 
a nosedive.

FLASH-BASED PMPS
Above Rs 10,000
By now, all memories of tonal
colouring, recessed mid-ranges
and boomy bass have gone (but
not forgotten), the pockets are a
little deeper, the audience more
discerning and expectations
skyrocket. If you’re part of the
small but growing group of con-
sumers who are willing to shell
out in excess of four figures on
a PMP, you’ll probably grin at
the above statement. Such PMPs
have an uphill task ahead of
them—they should excel a cou-
ple of things, while still retain-
ing excellence for all other
areas of functionality. 

Features
Right off the block, Apple’s iPod
Touch duo (8 and 16 GB models)
impresses with just a glance. The
rear, chrome plated and buffed to
a mirror-like sheen will only
make the black front—devoid of
any buttons save one large and
dimpled menu button—stand out.
A large and crisp touchscreen
(identical to the iPhone’s) greets
you. Menu navigation is a snap,
and the much-vaunted Touch-flo
isn’t just hype—it really works!
You’re never lost too deep in the
Touch’s menu subsystem, a press
of the aforementioned button
and you back on the main menu.
Icons are bright, well laid-out and
everything seems designed with
usability in mind. Browsing is fun
with finger swipes, particularly
when resizing and zooming in on
photos with your fingers
onscreen. The inbuilt gyroscope
means the Touch reorients its
screen for your viewing conven-
ience when it’s tilted.

The Apple iPod Nano 3G
makes another appearance in an

8 GB guise, as does the iRiver
X20 (4 and 8 GB). Creative’s Zen
was another familiar face, and
the 8 GB version finds itself
amongst the upper echelons of
the Flash-based players. The only
real newcomer is the Cowon D2,
a device which won our Best Buy
award last year. The Cowon has a
nice crisp touchscreen; though
the screen icons don’t look too
clear, this is a 16 million-colour
LCD and it makes its presence
felt later. It also supports text
and PDF, besides the usual fea-
tures like voice recording and
FM radio.

Performance
Up front, the Apples were clearly
distinct from the oranges and
everything else, and with the
exception of the stalwart Cowon
D2, Mr Jobs’ offerings would hog
the limelight. Cowon’s D2 is real-
ly a superb performer and soni-
cally very nearly nirvana. A full
extension throughout the audi-
ble spectrum—an excellent low-
ends and fully revealed mid-

Apple iPod Nano 3G 8 GB: Tiny Dancer

If you thought the older model was
compact due to its slimness, wait till

you lay eyes on the new one. It’s shrunk
to nearly half the length of the previous
Nano while getting a couple of
millimetres wider, and also getting a
better, bigger screen in the bargain. The
conscious attempt at space-saving is
unabashedly evident, and the 3G is more
“nano” than ever.

It’s a very well built device, although
the smudge- and scratch-prone rear will
have you using a case whenever you
take it around. The 3G Nano supports
video playback, and with this move,
Apple has just raised the bar for the
compact PMPs—no other model in this
class has comparable features. Why no
FM? Simple…why listen to radio stations
when you can listen to your favourite
numbers with four (and eight) gigabytes
of storage space?

Audio quality is class-leading and the
Nano is within a hair’s breadth of the
quality of the iPod Touch, which for us

was the best sounding PMP,
period. Second place is not a
bad place to be, especially
when both are flying the same
colours. The Nano
approaches the same
kind of deep, pounding
yet lively bass that the
Touch has, there’s no
hint of flab or colouring
of any sort, and in tracks
like Hotel California, the
drum score in the beginning
will cause you to close your
eyes and sigh with
satisfaction. It gets better
with the mid-range, as guitar
harmonics have that very live
feel, there’s no over-emphasis
on tones like some players—if there’s a
sound in the recording, you’ll hear it the
way it was produced—accurate to a fault.
With a fully revealed top-end, the Nano
will satisfy lovers of high frequency
instruments like saxophones and violins.
We got the chance to audition a couple of

Yanni DVDs—we daresay the
maestro himself would be pleased.

The other little utilities like a
calendar, alarm, contacts and

stopwatch are all present as are
three engaging little games, with
more stuff downloadable from the
iTunes store (which isn’t available
in India, unfortunately).

The Nano positions itself in a
league just below the iPod
Touch in price, but serves a
very different audience. We
don’t see anyone (for
example) working out with
the Touch in their pocket. In
fact, a user who could afford

to would buy both PMPs—so
different are they from each other.

What they share in common is brilliance
of design, usability and performance. If
you’re looking for something that’s
compact and powerful while retaining
stellar performance—and that too under
Rs 10,000—you’d be daft to even consider
anything else.

Cowon A3: One PMP To Own Them All

Ashiny off-white pearl finish, a contoured
body with sleek steel buttons down the

front side of the facia in a neat row, and with
dark grey trimming on the outer bezel,
sporting powerful hardware under the hood,
a brilliant view to the action, and
a look that’s in a class
of its own. You’d be
forgiven for thinking
we’re writing an
advertisement for the
latest Aston Martin or
something. It is the
proverbial Bentley
amongst PMPs
though, and the
moment we laid eyes
on it, we knew we
beheld something special.

To power itself, the A3 uses a DaVinci
dual-core processor. If your wondering
where that came from or why Cowon
decided on overkill, let us tell you that this
device is the first of its kind to actually
support 720p HD content natively without
any transcoding. Imagine dragging huge
.VOB files to a PMP and enjoying skip-free
video. Or imagine playing a 50 MB audio file
in all its FLAC splendour without a hiccup.
The A3 does it all. About the only trick
Cowon missed is the gimmicky and “in”
touchscreen, but we’re told they have
another A3-like PMP called the Q5W lined
up, which addresses “touchaholics”.

The A3 is a very good music player, and
does everything right if it’s all you listen to.
The iPod Touch and the Nano highlight the
sonic limitations of the A3, unfortunately.
Another little niggle is the volume level of

the A3, which isn’t
satisfactorily loud.
But once you fire up a
video on this baby,
prepare to be blown
away—the A3 is all
rampaging
performance, a video
player on steroids that
delivers quite a wallop
for the money you

pay. It’s got an AV-out
cable as well, which means you can

take the action-onscreen. We tried a 720p
movie on the A3 on our 32-inch LCD screen
and the experience was as good as any HD
DVD player. All the regular features—Cowon’s
full-fledged equaliser, FM radio, photo
viewing, and voice recording—are also
present, should you need them.

Quite simply put, if you need the best
video PMP around, this is your safest bet. It’s
also your cheapest bet, as both 30 GB and
60 GB versions are cheaper than Creative’s
sole challenger, the Vision W. Do remember
that its bulky, and also heavy, so its not
something you’ll slip into your denims, its
intended as a micro home theatre, so please
keep it there.

iriverX20
Feature rich ‘n flashy
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range coupled with a very trans-
parent and tonally accurate
upper range means the D2 is at
home with almost any kind of
music. It does have a whop-
ping output of 74 mW,
but surprisingly doesn’t
seem to drive either the
Bose or the Audio
Technica cans as well as
the iPods do. 

The iPod Nano is hard-
ly superior to the D2—it
offers slightly higher vol-
umes, (which doesn’t mean
a lot unless you’re a decibel
junkie), what is perceptible
is a marginally better exten-
sion in the lower bass. The
Nano also seems to do a little
more justice at detailing the
higher frequency ranges, but
this is a close comparison, and
noticeable only if you’re look-
ing for it. As far as video play-
back goes, both the Nano and
the D2 have good screens, but
the D2 sneaks ahead with
greater picture clarity, a slightly
larger viewing area and signifi-
cantly better colour.

The iRiver X20 4 and 8 GB
kept very close to the D2 and
the Nano as far as sound quality
goes. The real revelation proved
to be the none other than the
exquisitely designed iPod
Touch, which simply blew us
away with the sheer music qual-
ity. If you want absolutely the
best sound, this has to be it. The
Touch seemed slightly brighter
than the Nano, but some more

time spent auditioning both 8
and 16 GB versions convinced us
of their sonic excellence: there

was a little more detail
high up the frequency
ladder that the Nano
missed out on. Also
noticeable to the care-
ful listener was a tad
more texturing to
fine guitar-work on
Eric Clapton’s Layla—
certain chords
sound a little richer
and somehow more
full bodied. There’s
also a barely per-
ceptible (but per-
ceptible nonethe-
less) increase in
depth and detail
to Charlotte
Church’s incred-
ible vocal
chords in Bridge
Over Troubled

Water. Both the
Nano and Touch offer

similar bass signatures,
and a nearly similar

mid-range—all the micro-
improvements seem to have
gone into frequencies higher
than 4 KHz.

The iPod Touch makes a good
video PMP too, with its large and
crisp 3.5-inch screen, but the D2
pulls one over here, and makes
for a better micro-theatre.

Conclusion
The iPod Touch is an excellent
PMP, and offers good value for

its price. After all the hype sur-
rounding the iPhone, this is one
player that will satisfy your
sense of flair, and you’re virtu-
ally a show-off for just taking it
out of your pocket! As with any
sensational product, pricing is
always a deterrent and Apple
never meant for every aspiring
PMP owner to buy an iPod
Touch—if music quality means
the most to you, and very good
video playback capabilities are
as important as the large screen
and touch-flo, just close your
eyes and stop searching. If you
decide you can do without the
extra screen size and the flash
factor, look at the iPod Nano or
the Cowon D2. The former is an
excellent music PMP and its
compactness makes it an ideal
workout companion. The D2 is a
very different beast—it has a lot
of features, and a brilliant
screen, and the added advan-
tage of it being touch-sensitive.
It’s also something of a novelty
with the ability to scribble in a
notepad—a perfect conglomer-
ate of performance, features
and price. And yes, the D2’s 
4 GB of storage is also expand-
able thanks to an SD card slot.

We’re conferring our Best
Buy award on the Cowon D2 for
its superb music quality and
overall brilliant features and
functionality. At Rs 11,000, it’s
quite a bit cheaper than the
iPod Touch—although the Touch
is more of a lifestyle device than
the D2 can ever be. Nonetheless,

the D2 offers unbeatable features and perform-
ance for its price.

The iRiver X20s offer similar features and pric-
ing to the iPod Nano, but don’t sound as good, and
although the difference isn’t very significant, it is
noticeable. The Creative Zen 8 GB finds itself up
against the wall with the other brutes in this cate-
gory. Completely outgunned, this PMP cannot real-
ly be recommended to anyone, though it’s a good
device in its own right.

HDD-BASED PMPS
Unlike Flash players—which are mainly geared
towards music with a few exceptions taking a stab
at a more video-oriented device—HDD-based PMPs
have colossal amounts of storage at their disposal,
and are geared more towards video-watching than
anything else. Chances are HDD-based PMPs will
have larger screens, and of course have a larger
footprint—something that won’t be very unobtru-
sive in your pocket. Such players are also useful
for people who have a gigantic music collection
and like to carry all their music with them. Quite
honestly, very few people would carry more than
16 GB of music with them, but if you happen to
have a 20-odd gigabyte MP3 collection that you
want at your fingertips, along with a dozen or so
movies, then Flash players aren’t going to cut it.
Hard drive-based PMPs also have the advantage of
cost per GB—which is ridiculously low compared
to Flash-based players—comparatively still an
expensive storage medium.

Features
One look at the beautiful Cowon A3 duo had us all
as excited—while music is definitely cool, what
could be cooler than a personal cinematic experi-
ence? The screen has got to be as close to the real
thing as possible—with a 24-bit LCD that measures
four inches diagonally and can display a whop-
ping 16.7 million colours, the A3 is geared
towards being a proper video player. Its even got a
dual-core processor, so it can play .vob files (DVD
movies) without resampling or downsizing!
What’s more, even 720p is supported—once again
a drag-and-drop away. It goes without saying that
the A3 plays all other major video formats.
Absolutely amazing, considering we’ve seen some
notebooks stutter with 720p content. On the
audio front (like its cousin, the Flash-based D2), it
supports FLAC files, so diehard audiophiles who
constantly complain about the pitfalls of lossy for-
mats can finally hold their peace. The icing on the
cake has to be the superb build quality and
upmarket look—with pearl white as a base and a
dark grey bezel, the A3 is a stunner.

The other large-screen PMP was the Creative
Zen Vision W, with an even bigger screen (4.3 inch-
es). Despite the fact that the Creative doesn’t seem
to have the specifications on paper that the A3
does, it manages to impress with a very simple
menu layout, exceptionally good build quality, and
a screen that despite displaying only 262,000
colours doesn’t look the worse for it.

Apple has upped the storage on their 5.5G
iPod Classic to a massive 80 GB, and an even more
colossal 160 GB. The fact that the Classic manages
to fit in nearly six times the data of the Zen
Vision W at nearly half the footprint itself says a

Headphones: Do They Make A Difference?

Most definitely! “But how, and will I
notice it?” you might ask. Well, good

sound is quite like good food, or even a
nice car—it’s habit-forming, and going back
to something archaic after something neo
isn’t an easy thing to do. A simple
example—if you listen to any of the award-
winning PMPs in this test on their bundled
earplugs, you’d go “Wow!” Listen to them
on our reference headphones (the Bose
Intra Ear, Grado SR60, and the Audio
Technica ATH A900), you’d go “Damn! I
didn’t even know this track had that little
sound in it” and “Wow! Listen to that
guitar…awesome!” You have just come a
little closer to becoming discerning—a trait
of audiophiles—those evil men and women
who spend more than a third of their
disposable income on audio equipment.

Headphones make a resounding
difference, and even two very good
headphones will sound quite different due
to the fact that they have different sound

signatures, or in common terms, are
endowed by their manufacturers with
different acoustic properties. Remember
that a headphone is a miniature speaker,
with two little drivers, and will respond
favourably to changes in the music source,
amplification, and basically anything
which cleans up the sound signal being fed
to it. Most high-end headphones can’t
even be used with PMPs, simply because
such sources don’t provide enough juice to
properly drive the headphones’ drivers.
Most earplug-type headphones make do
without amplification—they’re intended
for portable use. If you’re serious about
sound, ditch the stock earplugs as soon as
you can, and buy a decent set of
earplugs—we recommend Creative’s
EP630—which, at Rs 900, is superb value
for money. If you want something better,
the Bose Intra-ear is available for 
Rs 5,000—and will give you more clarity in
the highs than the EP630.

If you’re listening at home and you
don’t mind something bigger, (like
circum-aural headphones), look at the
Sennheiser HD201 and HD202—at 
Rs 1,400 and 1,800 respectively. Stick to
known brands and you should be all
right. Costlier headphones don’t make
much sense, because they need a much
better source than a PMP is ever going
to be. For those who are interested,
higher-end models from the likes of
Sennheiser, AKG Acoustics and Grado
Labs are also slowly becoming available
in India. These headphones range in
prices from Rs 2,000 to Rs 35,000, and
with such a wide price range, there’s
literally something for everyone.

If you’re spending anything over 
Rs 8,000 for a PMP intended for long
music sessions, take our advice and invest
in a good set of headphones. Shell out big
and cry once, but forever have world class
audio at your disposal.

Apple iPod Classic 80 GB
80 Gigs of nirvana
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BRAND 
MODEL

Price (Rupees)
Comments

Grand Totals (Out of 100)
Features (Out of 35)
Performance (Out of 65)
Features
Capacity
Display Type
Display Number of Colours
Display Size
Type of Battery
Weight of Device
Firmware Upgradeable (Y/N)
Memory Upgradeable (Y/N) / Type of
Memory
FM Tuner (Y/N)
Voice Recording (Y/N)
Audio Formats supported

Photo Viewing / Video Playback (Y/N)
Video Formats supported

Screen Brightness adjust (Y/N)
Screen Orientation Sensor (Y/N)
Built-in Speakers (Y/N)
No of Preset Modes / Customisable
Equaliser
Point A to B Track Repeat (Y/N)
Custom Playlist saving (Y/N)
Folder Creation (Y/N)
Use as Portable Drive (Y/N)
Addon Features
Built-in Calendar / Contacts / Stopwatch
/ Alarm
Bundled Accessories

Additional Features (If any)

Performance
General Display Performance (So 10)
Video Performance (Movies) (So 10)
Music Performance (Out of 10)
Eagles—Hotel California
The Corrs—Brid og ni Mhaille
Charlotte Church—Bridge over 
Troubled Water
Pink Floyd—Speak to Me / Breathe 

Dire Straits—Sultans of Swing
Guns N’ Roses—November Rain (Live)
Eric Clapton—Layla
Chand Sifarish (Fanaa)
Beedi (Omkara)
Bundled Headphone Quality (Out of 10)
Battery Life (Actual Tested) 

Scoreboard                      Flash Based PMPs Up to Rs 5,000
Supercomp
Semp3-S7A

Rs 1,500
+ Compact, light

weight
– Build quality, 

slightly tacky keys
43.87
10.85
33.02

1 GB
OLED
1
1.1 inches
Li-ion
26 gm
Y
N / NA

Y
Y
MP3, WMA, WAV

N / N
NA

Y
N
N
5 / N

Y
N
Y
Y

N / N / N / N

N

N

1.5
NA

7.25
6.75
7

6.5

6.5
6.25
6.5
7
7
4.75
6.5 h

Zebronics
Gamma

Rs 1,650
+ Very compact,

solidly built
– Tiny screen, display

quality
42.98
9.45
33.53

2 GB
OLED
1
0.9 inch
Li-ion
26 gm
N
N / NA

Y
Y
MP3, WMA, WAV

N / N
NA

Y
N
N
5 / N

N
N
Y
Y

N / N / N / N

N

N

1.75
NA

6.75
6.75
7

6.5

6.75
7
6.5
7
7
5
8.3 h

Apacer
Steno AU351

Rs 1,720
+ Built well, good 

performance
– Poor screen 

quality
47.15
12.53
34.62

2 GB
LCM
1
0.9 inch
Li-ion
28 gm
Y
N / NA

Y
Y
MP3, WMA, WAV

N / N
NA

Y
N
N
6 / N

Y
N
Y
Y

N / N / N / N

N

N

1.5
NA

7.25
7
7

7

7
7
7
7.25
7.25
5
7.7 h

Zebronics
Beta

Rs 1,750
+ Very compact, 

built well
– Tiny screen, screen

quality
42.98
9.45
33.53

2 GB
OLED
1
1 inch
Li-ion
30 gm
N
N / NA

Y
Y
MP3, WMA, WAV

N / N
NA

Y
N
N
5 / N

N
N
Y
Y

N / N / N / N

N

N

1.75
NA

6.75
6.75
7

6.5

6.75
7
6.5
7
7
5
8.1 h

SanDisk
Sansa Shaker

Rs 2,090
+ Funky concept, 

solidly built
– Low performance, 

slightly bulky
27.23
4.20
23.03

1 GB
NA
NA
NA
AAA
32 gm
N
N / NA

NA
NA
MP3, WMA, WAV

N / N
NA

NA
NA
Y
NA / N

N
N
N
Y

N / N / N / N

N

N

NA
NA

4.75
4.75
5

4.5

4.75
4.5
4.25
4.5
4
5
6.7 h

Apacer
Steno AU581

Rs 2,240
+ Great build quality, 

good performance
– Small screen, non 

intuitive menu
47.53
12.53
35.00

2 GB
OLED
1
1.3 inches
Li-ion
30 gm
Y
N / NA

Y
Y
MP3, WMA, WAV

N / N
NA

Y
N
N
6 / N

Y
N
Y
Y

N / N / N / N

N

N

1.5
NA

7.25
7
7

7

7.25
7
7.5
7.25
5.25
6.5 h

Transcend
T.sonic 610

Rs 2,500
+ Good set of 

accessories
– Tiny screen, tacky 

buttons
50.91
18.20
32.71

2 GB
OLED
single
1 inch
Li-ion
28 gm
Y
N / NA

Y
Y
MP3, WMA, WAV

N / N
NA

Y
N
N
6 / Y

Y
Y
N
Y

N / N / N / N

Carry pouch + wrist
strap + Neck strap

N

2.25
NA

7
6.5
6.5

6.25

6.5
6.5
6.25
6.75
6.5
5.25
11.2 h

Creative
Zen Stone

Rs 2,599
+ Solidly built, 

compact
– No screen, buttons 

little hard
49.28
15.44
33.84

1 GB
NA
NA
NA
Li-ion
18.5 gm
Y
N / NA

Y
Y
MP3, WMA, WAV, 
audible

N / N
NA

N
N
N
4 / Y

Y
Y
N
Y

N / N / N / N

N

N

NA
NA

7.25
7
7

7.25

6.75
7
7.25
7.5
6.75
5
7.6 h

SanDisk
Clip

Rs 2,990
+ Compact, funky, 

belt clip inbuilt
– Volume button 

tacky
51.77
14.77
37.00

1 GB
OLED
1
1 inch
Li-ion
25.8 gm
Y
N / NA

Y
Y
MP3, WMA, WAV

N / N
NA

Y
N
N
4 / Y

Y
N
Y
Y

N / N / N / N

N

NA

2.5
NA

8
7.5
7.25

7.5

7.25
7.5
7.5
7.25
7.25
5.5
9.1 h

YES
YMP 35

Rs 3,150
+ Neat looking, 

compact
– Less storage space,

hard buttons
48.01
17.01
31.00

512 MB
OLED
65K
1.5 inches
Li-ion
40 gm
Y
N / NA

Y
Y
MP3, WMA, WAV

N / Y
SMV

N
N
N
5 / Y

Y
Y
N
Y

N / N / N / N

Carry Pouch

Dual 3.5 mm jacks

4
NA

6.5
5.75
6

6.25

6
6
5.5
6.25
6.25
4.25
10.2 h

YES
YMP 18

Rs 3,250
+ Very light, neat 

looking
– Requires batteries, 

build quality
39.94
10.85
29.09

1 GB
LED
Single (multiple backlit)
1.2 inches
AAA
25 gm
Y
N / NA

Y
Y
MP3, WMA, WAV

N / N
NA

N
N
N
4 / N

Y
N
N
Y

N / N / N / N

Carry Pouch

FM radio recording,
Dual 3.5 mm jacks

2
NA

6
4.75
5.5

5.75

6.25
6
6.25
6.25
6.25
4
23 h

SanDisk
Sansa Express

Rs 3,399
+ Good performer, 

built well
– Tiny screen

53.13
14.77
38.36

2 GB
OLED
1
1.1 inches
Li-ion
31.1 gm
Y
N / NA

Y
Y
MP3, WMA, WAV

N / N
NA

Y
N
N
4 / Y

Y
N
Y
Y

N / N / N / N

N

N

2
NA

8
7.75
7.75

8

7.5
7.5
8
7.75
7.5
6
14.2 h

Mitashi
MPL 1004

Rs 3,490
+ Large screen, well 

laid out menus
– Low performance, 

tacky buttons
43.31
16.38
26.93

1 GB
LCD
262K
2.2 inches
Li-ion
45 gm
Y
Y / SD

Y
Y
MP3, WMA

Y / Y
MPEG-4

Y
N
Y
6 / N

Y
N
N
Y

N / N / N / N

N

NA

6
4

5
4.5
4

5

3.5
4.75
5
5
5
2.5
8.2 h

Aigo
U Watch MP3

Rs 3,500
+ Novel concept, 

compact
– Low performer, un-

intuitive controls
33.77
5.67
28.10

512 MB
NA
NA
NA
Li-ion
38 gm
N
N / NA

N
Y
MP3

N / N
NA

N
N
N
4 / N

N
N
N
Y

N / N / N / N

N

N

NA
NA

6
6.25
6

6

6
5.75
5.5
6.5
6.25
NA
4.6 h
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BRAND 
MODEL

Price (Rupees)
Comments

Grand Totals (Out of 100)
Features (Out of 35)
Performance (Out of 65)
Features
Capacity
Display Type
Display Number of Colours
Display Size
Type of Battery
Weight of Device (gms)
Firmware Upgradeable (Y/N)
Memory Upgradeable (Y/N) / Type of
Memory
FM Tuner (Y/N)
Voice Recording (Y/N)
Audio Formats supported

Photo Viewing / Video Playback (Y/N)
Video Formats supported

Screen Brightness adjust (Y/N)
Screen Orientation Sensor (Y/N)
Built-in Speakers (Y/N)
No of Preset Modes / Customisable
Equaliser
Point A to B Track Repeat (Y/N)
Custom Playlist saving (Y/N)
Folder Creation (Y/N)
Use as Portable Drive (Y/N)
Addon Features
Built-in Calendar / Contacts / Stopwatch
/ Alarm
Bundled Accessories

Additional Features (If any)

Performance
General Display Performance (So 10)
Video Performance (Movies) (So 10)
Music Performance (Out of 10)
Eagles—Hotel California
The Corrs—Brid og ni Mhaille
Charlotte Church—Bridge over 
Troubled Water
Pink Floyd—Speak to Me / Breathe 

Dire Straits—Sultans of Swing
Guns N’ Roses—November Rain (Live)
Eric Clapton—Layla
Chand Sifarish (Fanaa)
Beedi (Omkara)
Bundled Headphone Quality (Out of 10)
Battery Life (Actual Tested) 

Scoreboard                      Flash Based PMPs Up to Rs 5,000
Transcend

T.sonic 840

Rs 3,750
+ Good performance,

built well
– Tacky buttons, 

slightly heavy
55.51
19.60
35.91

2 GB
LCD
65K
1.8 inch
Li-ion
70 gm
Y
N / NA

Y
Y
MP3, WMA, WAV

Y / Y
MTV

Y
N
N
5 / Y

Y
Y
N
Y

N / N / N / N

N

N

6.25
5

6.75
5.75
6

6

6
6.25
6.25
6.5
6.5
5
9.5 h

Sony
NWD-B103F

Rs 3,990
+ Compact, well built,

good controls
– Tiny screen

47.65
15.05
32.60

1 GB
LCD
65K
1 inch
Li-ion
30 gm
Y
N / NA

Y

MP3, WMA

N / N
NA

Y
Y
N
5 / N

Y
Y
N
Y

N / N / N / N

N

N

2
NA

7
6.5
6.5

7

6.25
6.25
6.25
6.5
6.25
5.5
8 h

Aigo
MP-F585

Rs 4,000
+ Well built, good 

features
– None in particular

46.81
11.90
34.91

1 GB
LCD
65K
1.8 inches
Li-ion
50 gm
N
N / NA

Y
Y
MP3, WMA

Y / Y
AVI

Y
N
N
5 / N

N
N
N
Y

N / N / N / N

N

N

3.5
4

6.5
6.75
6.25

7

6.25
6.25
6
7
6.5
4.5
6.3 h

YES
YMP 35

Rs 4,150
+ Looks cool, 

compact
– Hard buttons, un-

intuitive menu
48.01
17.01
31.00

1 GB
OLED
65K
1.5 inches
Li-ion
40 gm
Y
N / NA

Y
Y
MP3, WMA, WAV

N / Y
SMV

N
N
N
5 / Y

Y
Y
N
Y

N / N / N / N

Carry-pouch

Dual 3.5 mm jacks

4
NA

6.5
5.75
6

6.25

6
6
5.5
6.25
6.25
4.25
10.2 h

iRiver
S7

Rs 4,399
+ Neat looks, built 

well
– Overpriced, few 

features
40.14
7.70
32.44

1 GB
NA
NA
NA
Li-ion
17.5 gm
Y
N / NA

Y
N
MPEG 1/2/2.5 Layer 3,
WMA, ASF, OGG, MP3

N / N
NA

NA
NA
N
NA / N

N
N
Y
Y

N / N / N / N

N

N

NA
NA

6.75
6.75
6.5

6.5

6
7
7
6.75
6.5
6
7.5 h

Creative
Zen Stone Plus

Rs 4,399
+ Compact, clear

screen, built well
– Overpriced, hard 

buttons
50.32
15.44
34.88

2 GB
OLED
1 (blue)
1 inch
Li-ion
21 gm
Y
N / NA

Y
Y
MP3, WMA, WAV, 
audible

N / N
NA

N
N
N
4 / Y

Y
Y
N
Y

N / N / N / N

N

N

2
NA

7.25
7
7

7.25

6.75
7
7.25
7.5
6.75
5
7.6 h

YES
YMP 30

Rs 4,950
+ Good music quality,

built well
– Plain looks, no 

video support
45.23
13.51
31.72

2 GB
OLED
dual-colour
1.3 inches
Li-ion
35 gm
Y
N / NA

Y
Y
MP3, WMA, WAV

N / N
NA

N
N
N
4 / N

Y
N
N
Y

N / N / N / N

Carry-pouch

N

2.25
NA

6.25
6.25
6.25

6

6.25
6.25
6.75
6.5
6.5
5
13.2 h

Sony
NWD-B105F

Rs 4,990
+ Compact, well built,

good controls
– Tiny screen

47.65
15.05
32.60

2 GB
LCD
65K
1 inch
Li-ion
30 gm
Y
N / NA

Y
Y
MP3, WMA

N / N
NA

Y
Y
N
5 / N

Y
Y
N
Y

N / N / N / N

N

N

2
NA

7
6.5
6.5

7

6.25
6.25
6.25
6.5
6.25
5.5
8.1 h

YES
YMP 45

Rs 6,490
+ Large screen, stylus 

provided
– Lacks music quality,

build quality
44.38
13.23
31.15

2 GB
LCD
262K
2.4 inches
Li-ion
60 gm
Y
SD

Y
Y
MP3, WMA, WAV

Y / Y
AVI

Y
N
Y
5 / Y

Y
N
Y
Y

N / N / N / N

Carry-pouch and
strap, stylus

Touchscreen

6
4.25

5.25
5.25
5.5

5.75

5
5
5.25
6
6
3.5
11.3 h

Samsung
YP-S5

Rs 8,900
+ Built well, great 

music performance
– Bulky, prone to 

fingerprints
64.20
22.09
42.11

2 GB
LCD
262K
1.8 inches
Li-ion
78.7 gm
Y
N / NA

Y
Y
MP3 AAC WMA

Y / Y
MPEG-4

Y
N
Y
6 / Y

Y
Y
Y
Y

N / N / N / N

N

Bluetooth

6.25
6.25

7.25
7
7.5

7.25

7.25
7.5
7.75
7.5
7.25
6
19.4 h

Mitashi
MWI-4GA

Rs 6,790
+ Large, clear screen, 

loudspeaker
– Poor music quality, 

unintuitive menu
46.74
19.53
27.21

4 GB
LCD
262K
2.4 inches
Li-ion

Y
Y / SD

Y
Y
MP3, WMA

Y / Y
MPEG-4

Y
N
Y
6 / Y

Y
N
Y
Y

N / N / N / N

N

N

6.5
4.5

5
4.75
3.75

5

3.5
4.5
5
5
4.75
2.5
6.7 h

Philips
GoGear 4GB

Rs 6,999
+ Well built, good 

menu system
– Mediocre screen, 

lacks volume
56.86
17.01
39.85

4 GB
LCD
65K
2.2 inches
Li-ion
45 gm
Y
N / NA

Y
Y
MP3, WMA

Y / Y
MPEG-4, WMV

Y
N
N
7 / Y

N
N
Y
Y

N / N / N / N

N

N

5.5
5

7
7
7

7

6.75
7
7
7.5
7.5
6
11 h

Cowon
iAudio 7

Rs 7,750
+ Powerful sound, 

great music quality
– Looks too simple 

and unassuming
63.13
19.60
43.53

4 GB
LCD
262K
1.3 inches
Li-ion
60 gm
Y
N / NA

Y
Y
MP3, OGG, WMA, ASF,
FLAC, WAV

Y / Y
MPEG-4

Y
N
N
5 / Y

Y
Y
N
Y

N / N / N / N

N

N

2.5
3.5

8.5
8.25
8.5

8.5

8.25
8.5
8.25
8.5
8
6.75
29.8 h

Sony
NWZ-S615F

Rs 7,990
+ Good screen, good 

features
– None in particular

57.04
17.15
39.89

2 GB
LCD
262K
1.8 inch
Li-ion
50 gm
Y

Y
Y
MP3, AAC, WMA

Y / Y
H.264, MPEG-4,  
AAC-LC

Y
Y
N
5 / N

Y
Y
N
Y

N / N / N / N

N

N

6
6.5

7.5
7
7.25

7

6.25
6.5
7
7
6.75
5.5
20.2 h

Flash Based PMPs from Rs 5,001 to Rs 10,000

Digital Leisure l PMP Test
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BRAND 
MODEL

Price (Rupees)
Comments

Grand Totals (Out of 100)
Features (Out of 35)
Performance (Out of 65)
Features
Capacity
Display Type
Display Number of Colours
Display Size
Type of Battery
Weight of Device (gms)
Firmware Upgradeable (Y/N)
Memory Upgradeable (Y/N) / Type of
Memory
FM Tuner (Y/N)
Voice Recording (Y/N)
Audio Formats supported

Photo Viewing / Video Playback (Y/N)
Video Formats supported

Screen Brightness adjust (Y/N)
Screen Orientation Sensor (Y/N)
Built-in Speakers (Y/N)
No of Preset Modes / Customisable
Equaliser
Point A to B Track Repeat (Y/N)
Custom Playlist saving (Y/N)
Folder Creation (Y/N)
Use as Portable Drive (Y/N)
Addon Features
Built-in Calendar / Contacts / Stopwatch
/ Alarm
Bundled Accessories

Additional Features (If any)

Performance
General Display Performance (So 10)
Video Performance (Movies) (So 10)
Music Performance (Out of 10)
Eagles—Hotel California
The Corrs—Brid og ni Mhaille
Charlotte Church—Bridge over 
Troubled Water
Pink Floyd—Speak to Me / Breathe 

Dire Straits—Sultans of Swing
Guns N’ Roses—November Rain (Live)
Eric Clapton—Layla
Chand Sifarish (Fanaa)
Beedi (Omkara)
Bundled Headphone Quality (Out of 10)
Battery Life (Actual Tested) 

Scoreboard Flash Based PMPs from Rs 5,001 to Rs 10,000
SanDisk

Sansa e280

Rs 8,490
+ Decent screen, 

feature-rich
– Scroll wheel feels 

tacky
68.15
23.45
44.70

8 GB
LCD
65K
1.8 inches
Li-ion
76.54 gm
Y
Y / Micro SD

Y
Y
MP3, WMA, WAV

Y / Y
AVI, MPEG-1/2/4, DAT,
ASF, MOV

Y
N
N
7 / Y

Y
Y
Y
Y

N / N / N / N

Pocket strap

NA

6
6

8
8
7.75

8

7.5
7.75
8
8.25
8
6.75
14.1 h

Apple
iPod Nano 3G

Rs 8,800
+ Great music quality 

and screen
– No FM radio, 

smudge prone back
69.48
22.93
46.56

4 GB
LCD
262K
2 inches
Li-ion
49 gm
Y
N / NA

N
N
MP3, AAC, AIFF, WAV

Y / Y
H.264, MOV, MP4,
MPEG-4

Y
N
N
22 / N

Y
Y
N
Y

Y / Y / Y / Y

N

N

6.5
6

8.75
8.5
8.75

8.5

8.25
8.5
8.75
8.5
8
5
19.2 h

Samsung
T10

Rs 6,600
+ Good music quality,

nice screen
– plasticy exterior, 

slightly long
62.68
21.04
41.65

2 GB
LCD
262K
2 inches
Li-ion
43 gm
Y
N / NA

Y
Y
MP3 AAC WMA

Y / Y
MPEG-4

Y
N
N
6 / Y

Y
Y
Y
Y

N / N / N / N

N

Bluetooth

6
6.25

7.5
7
7.5

7.25

6.75
7.25
7
7.5
7.25
6.5
17.6 h

iRiver
X20 2 GB

Rs 8,999
+ Good performer, 

feature rich
– Slightly costly, 

controls tacky
69.08
23.45
45.63

2 GB
LCD
262K
2.2 inches
Li-Ion
15 gm
Y
Y / Micro SD

Y
Y
MP3, WMA, OGG, ASF

Y / Y
MPEG-1/2/4

Y
N
Y
5 / Y

Y

Y
Y

N / N / N / N

N

N

6.5
6.5

8.25
7.75
8

8.25

8.25
8.25
8.25
8.5
8
5.5
14.3 h

iRiver
E10

Rs 9,499
+ Built well, neat 

navigation
– Low quality screen 

spoils video
57.05
20.41
36.64

6 GB
LCD
65K
1.5 inches
Li-ion
76 gm
Y
N / NA

Y
Y
MPEG 1/2/2.5 Layer 3,
WMA, ASF, OGG

Y / Y
AVI, SWF

Y
N
N
3 / Y

Y
Y
N
Y

N / N / N / Y

N

N

2.5
3

6.75
7
7

7

7.25
7
6.5
7
7
6
13.24 h

Creative
Zen

Rs 9,999
+ Good screen, decent 

music quality
– None in particular

63.46
21.81
41.66

4 GB
LCD
16.7M
2.5 inches
Li-ion
65 gm
Y
N / NA

Y
Y
MP3, WMA, AAC5 (.m4a),
WAV (ADPCM), Audible 2,
3, 4

Y / Y
MJPEG, WMV9, MPEG-4-
SP4, DivX4 4/5 and
XviD4

Y
N
N
8 / Y

Y
Y
Y
Y

Y / N / Y / N

N

N

7
7.5

7.25
7
7

7.25

6.75
7
7.25
7.5
6.75
5.5
14.5 h

iRiver
X20 4 GB

Rs 10,999
+ Feature rich, feature

rich
– Slightly costly, 

controls tacky
69.21
23.45
45.76

4 GB
LCD
262K
2.2 inches
Li-Ion
15 gms
Y
Y / Micro SD

Y
Y
MP3, WMA, OGG, ASF

Y / Y
MPEG-1/2/3

Y
N
Y
5 / Y

Y

Y
Y

N / N / N / N

N

N

6.75
6.5

8.25
7.75
8

8.25

8.25
8.25
8.25
8.5
8
5.5
14.3 h

Cowon
D2

Rs 11,000
+ Very good perform-

ance and features
– Slightly bulky, 

weird looks
73.90
26.95
46.95

4 GB
LCD
16M
2.5 inches
Li-ion
91 gm
Y
Y / SD

Y
Y
MP3, WMA, FLAC, OGG,
WAV

Y / Y
AVI, MPEG

Y
N
Y
5 / Y

Y
Y
Y
Y

N / N / N / Y

Stylus, Carry-case

Touchscreen 

6.5
7.5

8.5
8.5
8

8.25

7.5
8.25
8.5
8.5
8
6.5
36.5 h

Apple
iPod Nano 3G

Rs 11,400
+ Great music quality 

and screen
– Lacks FM radio, 

smudge prone back
69.48
22.93
46.56

8 GB
LCD
262K
2 inches
Li-ion
49 gm
Y
N / NA

N
N
MP3, AAC, AIFF, WAV

Y / Y
H.264, MOV, MP4,
MPEG-4

Y
N
N
22 / N

Y
Y
N
Y

Y / Y / Y / Y

N

N

6.5
6

8.75
8.5
8.75

8.5

8.25
8.5
8.75
8.5
8
5
19.4 h

iRiver
X20

Rs 12,999
+ Feature rich, good 

performer
– Slightly costly, 

controls tacky
69.21
23.45
45.76

8 GB
LCD
262K
2.2 inches
Li-Ion
15 gms
Y
Y / Micro SD

Y
Y
MP3, WMA, OGG, ASF

Y / Y
MPEG-1/2/3

Y
N
Y
5 / Y

Y

Y
Y

N / N / N / N

N

N

6.75
6.5

8.25
7.75
8

8.25

8.25
8.25
8.25
8.5
8
5.5
14.3 h

Creative
Zen

Rs 13,999
+ Good screen, decent 

music quality
– Slightly costly

63.46
21.81
41.66

8 GB
LCD
16.7M
2.5 inches
Li-ion
65 gm
Y
N / NA

Y
Y
MP3, WMA, AAC5
(.m4a), WAV (ADPCM),
Audible 2,3,4

Y / Y
MJPEG, WMV9, MPEG-
4-SP4, DivX4 4/5 and
XviD4

Y
N
N
8 / Y

Y
Y
Y
Y

Y / N / Y / N

N

N

7
7.5

7.25
7
7

7.25

6.75
7
7.25
7.5
6.75
5.5
14.5 h

Apple
iPod Touch

Rs 17,700
+ Amazing performer, 

great interface
– Pricey

73.20
24.96
48.25

8 GB
LCD
262K
3.5 inches
Li-ion
120 gm
Y
N / NA

N
N
MP3, AAC, AIFF, WAV

Y / Y
H.264, MOV, MP4,
MPEG-4

Y
Y
N
22 / N

Y
Y
N
Y

Y / Y / Y / Y

N

Touchscreen

8
7.75

8.75
8.5
8.75

8.5

8.25
8.5
8.75
8.5
8
5
16.5 h

Apple
iPod Touch

Rs 22,000
+ Amazing performer, 

great interface
– Pricey

73.20
24.96
48.25

16 GB
LCD
262K
3.5 inches
Li-ion
120 gm
Y
N / NA

N
N
MP3, AAC, AIFF, WAV

Y / Y
H.264, MOV, MP4,
MPEG-4

Y
Y
N
22 / N

Y
Y
N
Y

Y / Y / Y / Y

N

Touchscreen

8
7.75

8.75
8.5
8.75

8.5

8.25
8.5
8.75
8.5
8
5
16 h
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Great sound, something really compact, and feature-rich: Don’t look anywhere beyond
the new iPod Nano 3G. In its 4 GB avatar, the Nano is priced at Rs 8,500 and the 8 GB ver-
sion costs Rs 11,500—perfect performance and features for its price. It’s a true audiophile’s
delight, and will satisfy your cravings for pure sound like nothing else in its price bracket.
A video oriented PMP for watching high quality videos: The Cowon A3 has got to be
your target. Priced very conservatively at Rs 20,000 for the 30 GB version, the Cowon
has the best processing hardware under its hood and can even be hooked up to your tel-
evision—it’s a fully functional DVD player! Music quality is very good, but not up to the
iPod Nano, iPod Touch, or Cowon D2.
Something really cheap—sound quality isn’t that important: How does Rs 1,500 sound
to you? Supercomp’s SEMP3-S7A will certainly do the trick. It’s got a small screen,
besides very good music quality for the price. You’ll be surprised at how much PMP you
get for your money.
A feature rich PMP, and one that is well priced. Music quality is important:
Performance with Value? Look no further than the Cowon D2. At Rs 11,000, it represents
sterling value, with a 16.7 million colour touchscreen that’s shockingly adept at video,
and stunning audio performance.
I have a budget of Rs 7,000. I want the best device for the price: Samsung’s YP-S5 is the
answer. An excellent screen, amazing audio quality, video playback, funky backlit touch
controls, FM radio support, Bluetooth, photo viewing and a customisable equaliser. And
it only costs Rs 6,600, too.
I’m rich, money isn’t a concern…show me the best: Other than the private jet and the
yacht you no doubt own, look at the Apple iPod Touch 16 GB. Or better still, wait a bit for
the 32 GB version. The amazing touchscreen will be a feature you’ll find eminently prac-
tical after a while, adding to your sex appeal, while the music quality will blow those
1,000 rupee socks off!

I want a great PMP for music but have a huge collection of MP3s that I wish to cart
around: Apple’s 80 GB and 160 GB iPod Classic will satisfy. Which one you buy is purely
dependent on your storage needs, but they’re both equally amazing music players, with
strong video playback performance as well. Battery life is also very good for an HDD-
based PMP. The icing on the cake is the shocking price—the lowest cost per GB from such
exemplary PMPs makes your decision a no-brainer. 

Decision Maker

0 20 40 60 80 100 120 140

Iriver S7 1GB

YES YMP 35 1GB

Creative Zen Stone Plus 2GB

YES YMP 30 2GB

Sony NWD-B105F 2GB
133

86

132

81

117

91

117

72

107

86

Supercomp Semp3-S7A 1GB

Value Index

40

79

Transcend T.sonic 610 2GB
67

92

Aigo U Watch MP3 512MB

Mitashi MPL 1004 1GB

Transcend T.sonic 840 2GB

Sony NWD-B103F 1GB

Aigo MP-F585 1GB 107

84

106

86

100

100

93

61

93

78

SanDisk Clip 1 GB

Creative Zen Stone 1GB

YES YMP35 512MB

YES YMP 18 1GB

SanDisk Sansa Express 2GB
91

96

87

72

84

86

80

93

69

89

Apacer Steno AU351 2GB

Zebronics Gamma 2GB

Zebronics Beta 2GB

SanDisk Sansa Shaker 1GB

Apacer Steno AU581 2GB
60

86

56

49

47

77

46

85

44

77

Price Index

PMPs up to Rs 5,000

0 20 40 60 80 100 120

YES  YMP 45 2GB

Value Index

68

64

SanDisk  Sansa e280 8GB
89

98

iRiver X20 2GB

Samsung T10 2GB

iRiver E10

Apple iPod Nano 3G 4GB

Creative Zen 4GB
105

91

100

100

100

82

100

100

69

90

Mitashi MWI-4GA 4GB

Samsung YP-S5 2GB

Philips GoGear 4GB

Cowon iAudio 7 4GB

Sony NWZ-S615F 2GB
84

82

82

91

74

82

71

67

94

92

Price Index

PMPs Rs 5,001 to 10,000

0 50 100 150 200 250

iRiver X20 4GB

Value Index

100

94

Apple iPod Touch 16GB
200

99

Apple iPod Nano 3G 8GB

Cowon D2 4GB

iRiver X20 8GB

Creative Zen 8GB

Apple iPod Touch 8GB
161

99

127

86

118

94

104

94

100

100

Price Index

PMPs 10001 and above

0 20 40 60 80 100

Apple iPod Classic 80GB

Value Index

52

97

Cowon A3 30GB

Apple iPod Classic 160GB

Cowon A3 60GB

Creative Zen Vision W 30GB
100

100

87

93

77

93

68

97

Price Index

HDD-based PMPs
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BRAND 
MODEL

Price (Rupees)
Comments

Grand Totals (Out of 100)
Features (Out of 35)
Performance (Out of 65)
Features
Capacity
Display Type
Display Number of Colours
Display Size
Type of Battery
Weight of Device 
Firmware Upgradeable (Y/N)
Memory Upgradeable (Y/N) / Type of
Memory
FM Tuner (Y/N)
Voice Recording (Y/N)
Audio Formats supported

Photo Viewing / Video Playback (Y/N)
Video Formats supported

Screen Brightness adjust (Y/N)
Screen Orientation Sensor (Y/N)
Built-in Speakers (Y/N)
No of Preset Modes / Customisable
Equaliser
Point A to B Track Repeat (Y/N)
Custom Playlist saving (Y/N)
Folder Creation (Y/N)
Use as Portable Drive (Y/N)
Addon Features
Built-in Calendar / Contacts /
Stopwatch / Alarm
Bundled Accessories

Additional Features (If any)

Performance
General Display Performance (So 10)
Video Performance (Movies) (So 10)
Music Performance (Out of 10)
Eagles—Hotel California
The Corrs—Brid og ni Mhaille
Charlotte Church—Bridge over 
Troubled Water
Pink Floyd—Speak to Me / Breathe 

Dire Straits—Sultans of Swing
Guns N’ Roses—November Rain (Live)
Eric Clapton—Layla
Chand Sifarish (Fanaa)
Beedi (Omkara)
Bundled Headphone Quality (Out of 10)
Battery Life (Actual Tested) 

Scoreboard                      HDD Based PMPs
Apple

iPod Classic 160 GB

Rs 20,500
+ Great performance, 

huge storage
– Lacks FM Radio, 

slightly heavy
68.57
22.93
45.65

160 GB
LCD
262K
2.5 inches
Li-ion
162 gm
Y
N / NA

N
N
MP3, AAC, AIFF, WAV

Y / Y
H.264, MOV, MP4,
MPEG-4

Y
N
N
22 / N

Y
Y
N
Y

Y / Y / Y / Y

N

N

6.5
7

8.25
8.25
8.25

8

8.25
8
8
8.25
7.75
5.5
17.5 h

Cowon
A3 30 GB

Rs 23,000
+ Amazing screen, great 

features
– Bulky, lower volumes

65.53
22.61
42.92

30 GB
LCD
16.7M
4 inches
Li-ion
280 gm
Y
N / NA

Y
Y
MP3, WMA, ASF, FLAC,
OGG, M4A,
MATROSKA(MKA), APE,
WAV
Y / Y
AVI, WMV, ASF, MP4,
MATROSKA (MKV), OGM,
MPG/MPEG, VOB, DAT

Y
N
Y
6 / Y

Y
Y
Y
Y

N / N / N / N

Carry case, handstrap, AV
Out cables, a/c charger
N

9
9

7
7
6.75

6.5

6.75
7
6.75
7.25
6.75
6.25
12.8 h

Cowon
A3 60 GB

Rs 26,000
+ Amazing screen, great 

features
– Bulky, lower volumes

65.53
22.61
42.92

60 GB
LCD
16.7M
4 inches
Li-ion
280 gm
Y
N / NA

Y
Y
MP3, WMA, ASF, FLAC,
OGG, M4A,
MATROSKA(MKA), APE,
WAV
Y / Y
AVI, WMV, ASF, MP4,
MATROSKA (MKV), OGM,
MPG/MPEG, VOB, DAT

Y
N
Y
6 / Y

Y
Y
Y
Y

N / N / N / N

Carry case, handstrap, AV
Out cables, a/c charger
N

9
9

7
7
6.75

6.5

6.75
7
6.75
7.25
6.75
6.25
12.6 h

Creative
Zen Vision W

Rs 29,999
+ Large, crisp screen, 

good music quality
– Costly, bulky, non 

intuitive controls
70.54
22.30
48.25

30 GB
LCD
262K
4.3 inches
Li-ion
276 gm
Y
N / NA

Y
Y
MP3, WMA, WAV

Y / Y
AVI, WMV9, MPEG-1/2,
MPEG-4-SP, MJPEG, DivX
4.x/ 5.x, XviD-SP

Y
N
Y
8 / Y

Y
Y
Y
Y

N / N / N / N

Carry Case, AV Out
cables
N

8.5
8.5

8.5
8.25
8.25

8.25

8
8
8.25
8.25
8
6.25
11.7 h

Apple
iPod Classic 80 GB

Rs 14,600
+ Great performance 

and storage
– Lacks FM Radio, 

slightly heavy
68.57
22.93
45.65

80 GB
LCD
262K
2.5 inches
Li-ion
149 gm
Y
N / NA

N
N
MP3, AAC, AIFF, WAV

Y / Y
H.264, MOV, MP4,
MPEG-4

Y
N
N
22 / N

Y
Y
N
Y

Y / Y / Y / Y

N

N

6.5
7

8.25
8.25
8.25

8

8.25
8
8
8.25
7.75
5.5
17.5 h
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lot for Apple’s design. The
screens on the 5.5G iPod
Classics somehow seem slightly
bigger than their predecessors,
and definitely brighter. The
Classic utilises the same kind of
chromed rear that the Nano
and Touch do. A neat feature in
the Classic and the Nano is the
scroll. Previously, you would
need to scroll through tracks
alphabetically, so getting to a
track that starts with, say, R
would be a pain. Now, once you
do a couple of fast scrolls, an
alphabet is displayed and the
scroll list now becomes alpha-
betical—scroll through the
alphabets to get to the one you
want, and find your track from
there. A neat feature, and one
that people who use the colos-
sal storage options provided
will fully utilise.

Performance
The Creative Zen Vision W is a
superb music player—a fact
which became apparent just a
few minutes into our MP3 tests.
It’s even better than the iPod
Classic, which is a superb PMP
for music in its own right. Once
again, when you’re talking
about brilliant PMPs, a few
points of difference is hardly a
big thing, but the fact is that
the Zen Vision W is one heck of
a PMP—it scored well because of
its superb screen, which made
movie watching and navigation
a fun-filled affair. The Cowon A3
is another excellent video play-
er; in fact, the slightly smaller
screen is, if anything, even
crisper than the Vision W. We
tried watching a 720p movie on
the A3, and were blown away by
the extent of immersion that
such a small screen can bring.

In comparison, the two iPod
Classics don’t seem to make as

big a splash with their diminu-
tive 2.5-inch screens, but make
no mistake, they are potent
video oriented PMPs as well—
it’s just that their aural roots

are a little more evident.
Musically, the Vision W scores
slightly more due to its very
strong mids and vocals, both of
which are the most important
component of any genre of
music and usually the high-
light of any track. The iPod
Classic rules the high frequen-
cies where the detailing is very
close to the iPod Touch. The
Touch and the Nano are an
extra inch better than the iPod
Classic for music, and both are
also better at mid-range fre-
quencies than the Cowon D2
and the Vision W.

The Cowon A3 takes a back-
stage when it comes to sonic

performance—there’s no com-
parison even between it and the
cheaper D2, which is noticeably
superior in the music quality
department.

Conclusion
The best video performance
would have to go to the Cowon
A3—a brilliant screen, very good
music performance, and a very
decent all rounder to boot. The
Creative Zen Vision W occupies
the pinnacle of the audio tests,
an outstanding product, consid-
ering that the other Creative
products didn’t make such a
splash. But the Zen Vision W is
costly, and at Rs 29,999, it’s
nearly double the price of the
Apple iPod Classic, which has 98
per cent of its musical capabili-
ties, 40 per cent of its video
capabilities, nearly the same
features, and half the price (Rs
15,500). Then there’s the small
matter of nearly thrice the stor-
age space. For its brilliant all
round capabilities, we’re award-
ing our Best Buy to Apple’s iPod
Classic 80 GB. It’s also a bril-
liant music player for the
price—go with this if you want a
great looking, excellent sound-
ing, feature rich, and large
capacity PMP.

If you’re looking for a colos-
sal amount of storage, you may
consider its older brother the—
the iPod Classic 160 GB. For
video, go with the 30 GB ver-
sion of the Cowon A3—it’s avail-
able at three fourths the price
of the Vision W.

michael.browne@thinkdigit.com

PhoneCompany E-mailBrand

Contact Sheet MP3 Players

Aigo
Apacer
Apple
Cowon
Creative
iRiver
Mitashi
Philips
Samsung
SanDisk
Sony
Supercomp
Transcend
Yes
Zebronics

BridgeOne Technologies Pvt Ltd
Apacer Technology Inc.
Apple India
Lipap Systems Pvt Ltd.
India Digital lifestyle Distributors
SALORA INTERNATIONAL
Mitashi Edutainment Pvt. Ltd.
Philips Electronics India Limited
Samsung India Electronics Pvt. Ltd.,
Rashi Peripherals Pvt Ltd
Sony India Pvt. Ltd
Supertron Electronics Ltd.
Mediaman Infotech Pvt Ltd 
India Digital Lifestyle Distributors
Top Notch Infotronix India

0484-4049450 
080-25702208
080-25744646 
9819917440
011-46096400 
011-29207100 / 01
NA
9833033804
011-41511234
022-67090909 
1800-11-11-88
022-23881397 / 23881924
022-23818100 / 3200
011-46096400 
044-26616201

contactin@bridgeonecorp.com 
suraj_raina@apacer.com
indiasales@mac.com 
iaudio@lipap.com
contactus@idldpl.com
taku.rajeev@salora.com
vishal@mitashi.com 
a.k.mathew@philips.com
jitender.c@samsung.com
sandisk@rptechindia.com 
sonyindia.care@ap.sony.com
info@supertronindia.com 
sales@mediamangroup.com
contactus@idldpl.com
enquiry@zebronics.info

Creative Zen Vision W
Pocket Theatre
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Nimish Chandiramani

If you’ve got half a strategising bone in your
body, you’ve loved the SimCity (SC) series all
these years. Each game is practically timeless—

I could even pick up SimCity 3000 (released more
than ten years ago) even today, and not have a
complaint beyond the slightly dated graphics. I
couldn’t help but expect the universe from SimC-
ity Societies now, could I?

Instead of continuing with the original
manage-a-large-city theme, SC Societies takes a leaf
out of the book that Caesar III wrote so well. You
don’t assign residential, commercial or industrial
“zones” anymore—you now have the freedom to
choose which structures to build where. Even the
focus of the game’s changed—instead of strategi-
cally managing a city, the scale of the game
narrows to managing societies and their values.
As someone who’s played the previous SC games
for days on end, I can tell you that this departure
from the original can be a little disorienting—if
you’re a fan, you’ll have to keep an open mind
while playing this. 

So here’s how the game works: you’ll be
managing small urban settlements (on the scale
of your locality, if that helps) and building struc-
tures that contribute to, or consume various

“energies”—Creativity, Authority, Prosperity, Spir-
ituality, Knowledge and Productivity. You could
build an Authority-heavy totalitarian regime, a
stainless steel IT powerhouse, or your own little
artists’ village depending on the buildings you
choose. On paper, this is a brilliant concept, but it
falls apart in the game. 

For some unfathomable reason, building
energies only affect other buildings! So if you
decide to be Big Brother and take joy in oppress-
ing your Sims, you’re in for a nasty revelation—as
long as they’ve got a home, a job and a little recre-
ation, they’re sickeningly happy. Which brings
me to the second thing I don’t like about this
game—it’s (ugh) easy. Unlike the previous games
where you’re always caught in a battle to keep
your Sims happy without running your city into
debt, it’ll take some serious effort to muck up in
Societies. In some cases, even if you build struc-
tures based on their energy rather than their
function, you’ll survive.

What I could get used to, however, is how visu-
ally wonderful this game is. You can choose from
various architectural styles—cartoon-like, Cyber-
punk, glass-windowed towers—the variety is
ridiculous. Building animations are sometimes
very cool, and attention to detail throughout the
game is impeccable. 

Maybe I’ve been a bit unfair—in the first few
hours (even days) that you play the game, SC: Soci-
eties is wonderful—even if it’s only because you’ll
need all that time to explore what you can do.
Checking out all the buildings and their effects is
mesmeric, and gets addictive. It’s only later—when
you’ve started to invest time in serious city-build-
ing—that you realise that the gameplay isn’t
exactly the cat’s meow. It’s a game that you need
to experience, but that can wait till it becomes a
500-Rupee EA Classic. 

nimish.chandiramani@thinkdigit.com

SOCI AL
Revolution?

Rating: 6/10
Developer: Tilted Mill Entertainment
Publisher: Electronic Arts
Distributor: Excel Interactive
Contact: customercare@excelinteractive.co.in
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Oh God no!–Not another alien invasion…please. These 
were initial thoughts. Thanfully, UAW: EA does things a 
little differently. At the beginning, I’d go “jeez, couldn’t 

they make this game better looking?” but then you find that 
the graphics aren’t as archaic as they seem, with some nice 
transparency effects and more. The cut scenes definitely need 
some make up work—they’re bland, along the same lines as 
the cut scenes in Warcraft 3, a six year old game! UAW: EA has a 
couple of tricks up its sleeve, which become apparent once you 
spend some time with the game. For one—it plays a slightly dif-
ferent storyline (no spoilers!) but you will be entertained. The 
second trick won’t be apparent till you play through a good bit 
of the game—Unlike most RTS’ which have different units with 
similar properties, you’ll find a completely different menu 
system for each faction—unique research trees and even more 
unique units—types of weapons, even modes of travel and each 
unit gets a unique ability...yay!
The  Story: The Novus play the crusaders, come to rescue 
the sentinents (humans) from a hostile alien invasion force 
(the Hierarchy). The humans fade into the background, as 
the fighting between these two factions awakes a third and 
ultimately more dangerous force lying dormant somewhere 
inside the planet—the Masari. With such an intergalactic sto-
ryline, it’s nice to see mankind take a backseat for once.

The Novus is a faction of cybernetic beings that are basi-
cally hit and run experts characterised by fast movement 
speeds, fast attacks, and low health. They befriend you in the 
beginning of the single player campaign, where you play as 
earth forces, and soon you’ll be controlling the Novus. The 
Novus basically thrives on mobility and they have an energy 
network through which collector drones travel (at speeds of 
light) and forage for resources. You can even instantly trans-
port armies from power node to power node. 

The faction Hierarchy are the bad guys, and all their powers 
centre around walkers. They have the Habitat walker—a lum-
bering colossus, armed with a number of powerful weapons 
in addition to the ability to spawn troops from pods. He has 
a number of nodes that can be upgraded to create units, or 
wield deadlier weapons. While the Novus survive with hit-and-
run tactics, the Hierarchy follows a brute force approach.

The Masari are the last race in the game and they don’t 
have the guerrilla tactics of the Novus, nor the numbers of 
the Hierarchy. Instead, they have fewer, costlier and more 
powerful units. The Masari also have a twist in their resource 
gathering and don’t salvage like the other two races. Instead, 
they build batteries that charge up slowly, and gradually add 

to your resources. They also have the option of going light or 
dark with the energy produced, which alters the abilities of 
some buildings and units.

All three factions have hero units, and in the cam-
paign, if your hero dies—its game over. Thankfully, most 
heroes are capable of taking care of themselves, unless 
swarmed by enemies en masse. In the campaign, you’ll 
eventually play as all three civilisations, one at a time, 
through three distinct campaigns.

A very good game, definitely a must try for RTS fans, 
with a decent plot and entertaining units. The big let down 
for me was the inability to zoom out of battles, and the 
camera control could have been much better—a blemish 
on an otherwise spotless canvas. A refreshing change from 
most RTS’—this, and one which should keep you engaged 
with a robust online multiplayer component as well.

michael.browne@thinkdigit.com

Universe at War:
Earth Assault

For thousands of years, mankind has stared 
at the stars with awe and wonder. After 

today, we’ll wish we were blind

 Gaming PC
XFX GeForce 8800 Ultra, 
Intel Core 2 Duo E6600, 

4 GB DDR2 RAM,
Windows Vista Ultimate x64

Rating: 8.5/10
Developer: Petroglyph

Publisher: Sega
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Gears Of War for the X360
was one of the console
selling titles, personally I

loved it! Typically, console
ports suck. Moreover, following
the footsteps of greatness is
never easy so you’ll forgive my
trepidation while reviewing the
PC version. It’s been two days,
and 18 hours… and I have one
word for you—awesome! The
controls on the X360 were nice
(a rarity for third person
shooters on any console) and
the mouse totally rocks. Now
headshots are only limited by
weapon recoil and a twitchy
arm. The gameplay is as fre-
netic as the X360 version, and
with five new levels GOW has
something for you even if
you’ve played it on the console.

Marcus Fenix, ex-con and
ex-COG (Coalition Of Govern-
ments) special forces, and his
team are up against the locust
horde—a race that have
mysteriously emerged from
the very bowels of the earth
through worm holes.

Your mission is to plant a
very large explosive device at
the core of the hordes hives,
deep, deep underground. Fire
fights are unavoidable and
why the heck would you want
to? Fenix is the classic grunt—
all muscle and abuse, and he’s
as likely to make worm kebab
with his assault rifle as he is
likely to make grub salami
with his chainsaw. In fact, this
weapon (the under-barrel
mounted chainsaw) makes for
some of the goriest and
squishiest moments in the
whole game, where you get to
melee the locusts if they get
too close. The enemy ain’t

smart, but they are fast, and
fearless, as well as a little on
the juicy side…yum-yum.

GOW is all about combat,
team tactics, and proper use of
strategic points like cover,
machine gun nests, even
elevated positions. There ain’t
no live heroes in this
game…The locust horde takes
many forms from the grunts,
who are man-like, a little
taller, to the  boomers—slightly
larger rocket wielding grunts,
to much larger enemies like
spawners. Combat is never
boring, and you can actually
melee an enemy with a spiked
grenade…watch ‘em run and
go pop…voila, lovely red
paintjob.

One of the things I really
liked was that GOW never at
any point feels like a console
port, and having played the
X360 version, I never once felt
this was second best. The
graphics are better, and
appear naturally sharper and
with more detail, due to the
higher resolution a PC is
capable of. Note that this is no
Crysis, and this is the only area
where GOW lets down a bit…it
just hasn’t got enough eye-
candy for us PC freaks. With
nice visuals, an extensive mul-
tiplayer component where you
can partake in battles online
and rank yourself, and a deep
storyline that we’re told will be
concluded later (shhhh!) GOW
is one adrenaline load you
shouldn’t miss. Indulgence is
the best form of worship…so
get this and play it now…

michael.browne@
thinkdigit.com

Gears Of War:
A Cog full of Testosterone!
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Rating: 9/10
Developer:

Microsoft Game Studios
Publisher: Epic Games

XFX GeForce 8800 Ultra,
Intel Core 2 Duo E6600,

4 GB DDR2 RAM,
Windows Vista Ultimate x64

GAMING PC
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outlawed for civilians.
Games would become
standard issue, and video
game developers would
become part of the
military industrial
complex. They would lobby
Congress to continue
pumping money into wars,
and would be buddy-buddy
with the likes of Lockheed
Martin and Boeing.

MAP THAT

Trouble
Spots

The Big G has tripped
up. Again. After
making enemies with

the residents of an Israeli
town, it is taking to
renaming oceans. Confused? 

Google Earth has user
generated content where
users can describe what the
place is about, with short
snippets about local history
and culture. Sort of like a
map-based Wikipedia. This
is a classic Google strategy—
get the users to do all the
work for them. Some call it
wisdom of the crowds,
others call it crowdsourcing

and yet others say, “For the
community, by the
community.”

However, whenever this
strategy is followed, there
are always pitfalls. Though
it may sound good in
theory, in practice there are
plenty of controversies—the
almost regular
controversies about
Wikipedia articles are an
ample indicator. And now
Google Earth has also
caught the Wikipedia bug.
Turns out that one town in
Israel named Kiryat Yam
was described as built on
the ruins of a Palestinian
village after the 1948 Arab-
Israeli War. The locals were
not amused, because the
official version is that
Holocaust survivors built
the town ground up in a
barren desert. They took
Google to court, demanding
the removal of the
offending citation, which
had a link to a pro-Palestine
site. Google pointed out the
terms of its end user
agreement, which was
probably not read by 99.98
per cent of the residents,
and washed its hands off
the matter saying that they
are not responsible for such

content. The case, as of
writing is still undecided.

In the second case where
oceans were concerned,
Google cannot blame users’
misplaced sense of
geography. Some days back,
the body of water called the
Persian Gulf was referred to
as the Arabian Gulf in
Google Earth. Indignant
Iranians promptly took
Google to task, pointing out
that a similar goof-up by
National Geographic was
corrected later. Google has
not officially responded to
the accusation, but we would
like to think that they will
revert back to status quo. We
assume that the best course
of action for Google would be
to show the whole Middle
East as an amorphous whole,
and leave the contending
parties to fight it out
regarding nomenclature.
Knowing Google, they
wouldn’t have too much
problems in churning out a
foolproof method, complete
with DNA profiling and iris
scans. This would kill two
birds with one stone—nobody
will accuse Google of being
biased, and the process
remains all open source and
community driven.
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Move over, singers and
stand up
comedians—soldiers

in war zones have found a
new way to kill their
boredom right in their
tents. It comes with a shiny
green X, and plays games
where you blast the hell out
of aliens and Nazis. It’s
called the Xbox 360, and the
war zone in question is Iraq.

Soldiers on a tour of
Iraq pack their kit bags
with more than weapons
and rations, apparently.
Most of them carry video
game consoles along with a
few favourite games like
Halo and Call of Duty. In
fact, Halo has a long history
with Iraq. Way back in
2006, the beta release of
Halo 3 was first released by
Microsoft and Bungie
Studios (the game
developers) to be played by
troops stationed in Iraq.
Smart wits at that time
opined that Bungie was

testing the weapons, AI and
gameplay of the game on
soldiers to get a reality
check. Seems the men in
fatigues gave a whole-
hearted thumbs-up, what
with the game finding a
place among the tools 
of war. 

One of the reasons why
games have found such a
great following among
soldiers on the front is
that war has a habit of
keeping people on
tenterhooks—one moment
you’re getting sniped and
bombed and shelled, and
another moment you are
holed in a bunker or
trench waiting for the
other side to make a move.
Such long waits on a
constant alert create high
levels of stress, and
nothing beats stress than
spiking a Covenant minion.
You get to breathe easy,
and not take out the
aggression on the POWs or

on the scenery. These
games also fostered
camaraderie and espirit-de-
corps—after all, if you’re
kicking some butt in co-op
mode, that makes you
comrades in arms. Latest
reports indicated that the
top brass was seriously
mulling over discontinuing
regular pep talks by squad
officers in favour of this
approach.

This is probably why
even psychologists, who
otherwise roll out charts
and presentations
detailing the harmful
effects of violent video
games on society, agree
that games were just what
they would have ordered.
By the way, here is another
of our insights: at the rate
which mass media is
painting video games as
the Ultimate Villain and
the source of all mental
distress, it might be that
violent games would be

You’ve read about fast and
efficient processors for
computers, mobiles,
UMPCs and other
embedded devices. Besides
the silicon chip, how can
one make a CPU work as
fast? This question struck
Maurice Wilkes, a British
computer scientist and he

came up with the concept
of ‘Micro-programming’
for processors in 1951.
Later the concept of micro-
programming was widely
adopted by the industry
for CPU development. One
thing was sure, that his
concept was too advanced
for his time.

Besides, he’s also
known for suggesting
labels, macros and sub-
routine libraries, the
fundamentals used in
high-level programming
languages as we know
them today.

He has also worked on
the early stages of time-
sharing systems (now
known as Multi-user
operating systems) and
distributed computing. A
graduate from Cambridge
University, he developed
keen interest in computing
methods after his
experimental research of
radio wave propagation in
the ionosphere.

His brilliance was
utilised to its best during
World War II, when he
worked on the Radar
system. 

Arun Bala, Kalavakkam, Chennai
How he did it:
XGL Desktop Customization - Mac Dock look
alike - 6 desktops can be dragged using a simple
mouse action like a XGL cube - Options include
support forzooming & menu options etc - There's
also a bottom dock for reflection which uses
action scripts to process the images - This also
includes a menu which can be panned along
horizontally

People Who
Changed

Computing

Flying, Japanese Style
The Japanese believe in thoroughness. They believe that when
you start learning something, you need to immerse yourself in
lessons thoroughly. If you’re learning to fly, they won’t spare you
even during the coffee break—cafes in the flying schools have
installed flight simulators for students to practise their moves.
Serious people, these chaps. 

BOXES OF WAR

Are You Game?

Maurice Vincent
Wilkes

My Desktop

Whatever 
Happened To…

The Gizmondo,
manufactured by Tiger
Telematics, was a

handheld gaming console
with GPRS and GPS
capability. Launched in
2005, it didn’t manage to
make a mark and sold
poorly. By February 2006,
the company discontinued
production and was forced
into bankruptcy. 

The console included a
GPS module for in-car
navigation which could also
be used to track player
movement in real-time for
multiplayer games. It also
had a VGA camera mounted
on the rear of the device. It
could send e-mails and even
SMS / MMS messages.

Known for being
extravagant and unnaturally
lavish, the UK-based arm,
Gizmondo Europe (GE) filed
for bankruptcy on January
23, 2006 with an estimated
loss of $210 million. Soon
after, retail locations in
both the US and the UK shut
shop, and finally the
Gizmondo Web site was also
shut down. In addition, their
game development arm also
went out of business.

Recently, the Chairman
of Gizmondo, Carl Freer,
stated in an interview in
November 2007 that he was
interested in the production
of the Gizmondo again, and
plans a potential launch in
the Q3 of 2008. With all the
past associated with it and
the way Gizmondo has been
handled, all we can say is—
Carl, your Gizmo…no…do!

Name Game
A hacker going by the name of Chujwamwdupe recently
published a security exploit which busted a recent security 
patch in Office 2003. The guy had approached Microsoft
with the exploit and requested them to credit it to him.
Dumb request, and not just because the name is Polish for
a vulgar act...

There’s a bug on my code!

WIN!
Send in your entry and you could win an exciting gift by sharing an amusing picture
with a tech angle to it. The picture should have been shot by you, and should not
have been published anywhere earlier. 
E-mail your picture with “DigiPick” in the subject line, mentioning your postal
address, oonn oorr bbeeffoorree tthhee 2200tthh ooff tthhiiss mmoonntthh to digipick@thinkdigit.com. One
prize-winning picture will be published each month.

Send us your desktop  with a description of how you
made it to mmyyddeesskkttoopp@@tthhiinnkkddiiggiitt..ccoomm with the subject
““MMyy DDeesskkttoopp””,, and tell us your postal address, too.

Participate in this contest
and win next month

Professional
Adobe Flex2
by Rich Tretola, Simon Barber,
Renaun Erickson

Published by

Participate and 
win next month:

Adobe
Flash CS3 Professional
by Reinhardt Dowd

Published by

Gizmondo

Last month’s winner:
Benoy Somanathan
Chennai

Maurice

n  Vivid blames Google and Yahoo! for kids finding porn  n  Woman sues Best Buy for $54 million over lost laptop n  Shareholders sue Yahoo! for not selling to Microsoft  n  Hackers use Google to find flaws in sites  n  Sarkozy “get lost” video an Internet hit
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no site is 100 per cent safe,
and if you want to keep
photos completely private,
keep them on your PC. Or
better yet, print them out
and keep the photo album
in a locked box. Hacker
proof, the old way.

BUSINESS SENSE

Outsourcing
Malice

Outsourcing,
globalisation and
catering to local needs

are not only buzzwords
among the legalised
businesses. The villains of
cyberspace—hackers,
spammers, phishers and
their ilk—have discovered
that going local pays big
time. This theory seems
perfectly reasonable when
the tone of the help wanted
postings in underground
channels—which are the
cyber equivalent of seedy
bars where criminals hang
out—is inspected.

According to the
postings, programmers with
Mandarin, Russian and
Portuguese skills are in hot
demand. The focus is on

creating sites without any
typos or grammatical
mistakes: too often, a fake
site can be differentiated
from the real goods by lousy
language. Another benefit
of going this route is that
they can sound more
genuine when they refer to
something that makes more
sense in local context.
Because face it, if you get a
long unsolicited mail
offering you houses for sale
on the US East, coast you

would hit the Delete button
without thinking—but if
that offer was for one in
Mumbai, maybe you would
be a wee bit more interested.
Besides, knowing local
conditions would make
their attacks more
sophisticated—it is better to
spam P2P networks in
Japan, gaming sites in China
or banks in Brazil. The
market for malicious
software products in
languages other than

English is booming, and like
any good business, the
hacking networks are
spreading their wings.  

Will this strategy work
for India? Will hackers, in
the future send mails
offering Pongal gift packs in
Tamil, or Diwali gift
certificates in Hindi? Expect
to know in, like, 7 years!
(Disclaimer: that figure is our
guess, but don’t sue us if you get
cleaned out by such a rogue a
few months from now).

Bang!
February’s a short month, and in

general, we don’t approve of it. Where
did the Gregorians get off stealing our
precious extra days from us? Things get
extra-crazy around here anyway, but this
February will go down in history...

You’d probably expect the cribbing to
start right here, but some good things
happened, too: Sanket bit the bullet and
got himself hitched earlier in the month.
Surely you’ll join us in wishing the couple
many years of giddy happiness. 

We’ve also got us a new addition—
Nash David has joined us as our new Copy
Editor. Rumour has it that after watching
us for the first two weeks, he had his head
buried in his hands and was murmuring
to himself “Dear God, what
have I done?”

We have plans for this one...
MuwahahaHAHAHAHA.....

And now for the bad news. First,
(naturally) Sanket wasn’t available for
work this month, so the Test Centre’s 
job became that much tougher. The
result: Raaabo’s already sparse scalp even
gets sparser.  

Nimish was on leave too, spending
time with his visiting mother. The result:
Raaabo’s sparser scalp starts to sweat...

And again, we must bring up the fact
that February is an unacceptably short
month, and we’ve got the Powers That Be
breathing down our necks. Well, Raaabo’s
neck, to be precise.

Last we checked, Raaabo was roaming
the streets in a daze, asking people if

he could borrow a gun...

Robert Scoble
http://tinyurl.com/ysq3ls
http://scobleizer.com/2008/02/04/what-you-all-are-
missing-about-google/
What you all are missing about Google
The bloggers are going nuts, once again, over the email
that a Google lawyer sent to Microsoft regarding
Microsoft’s proposed purchase of Yahoo.

Here’s what’s really going on:
1. Google doesn’t mind this deal going through at

all. Google knows they will be able to outrun a
“Microhoo.” Why do they know that? Because they’ve
been able to outrun them both separately. As I said on
Channel 5 news on Friday night: put two turkeys
together and you don’t get an eagle....

Enigmax
http://tinyurl.com/2ybmof
http://torrentfreak.com/how-a-bittorrent-tracker-
owner-hides-from-the-anti-pirates-080206/
How a BitTorrent Tracker Owner Hides from the
MPAA/RIAA
In most countries around the world, the legality of
running a tracker is still uncertain, in that definitive
court decisions have not been made. Even in the US, the
last two big trackers to be shut down—LokiTorrent and
EliteTorrents—weren’t shut down by a court, but thanks

to the mainstream media, and public perception that
these sites are operating illegally. The lawyers of the
MPAA, RIAA and IFPI maintain they’re illegal so that’s
often enough to cost an admin—if his identity is
compromised—lots and lots of worry, and probably
money too, regardless of his status under the law….

Guy Kawasaki
http://tinyurl.com/2tc5bw
http://blog.guykawasaki.com/2008/02/into-thin-air-
h.html
Into Thin Air: How I Spent $5,000 on Air and Made
Fifty-Year Old Women Swoon
…Day 7: Having read all the specs and reviews
about the Air, decide that this “no-compromise”
machine has way too many compromises. For
example, no Ethernet, no CD/DVD drive, tiny hard
disk/solid-state drive (I have forty gigabytes of
pictures alone), incompatible with my 30-inch
Apple monitor, and a ridiculous new power supply.
Therefore, order a totally souped-up MacBook 
Pro 15-inch.

Day 8: Entourage database corrupted for the
umpteenth time. Old MacBook Pro hard disk now too
small to rebuild (my email database file is 9 gigabytes).
Need to do something soon. Delete to make space and
rebuild Entourage for hopefully the last time.

Google’s cold
shoulder towards
Microsoft’s proposal
to buyout Yahoo!, a
MacBook Air user’s
experiences and
Torrent sites being
shut by media hype
are part of this
month’s blog watch

In The Nudesights

What do you get when
you combine Google

Maps with the local
knowledge of where the best
peep shows are held? You get
Nudar—advertised as a radar
for nudity. 

At http://nudar.nudar.com
(it’s not safe for work, so
look before clicking), Google
Maps is used to locate strip
clubs, nude resorts, nude
beaches, topless bars and all
other similar establishments.
Currently available in US and
Canada, this Web site aims
to map out similar places
around the world.

These places can be
searched based on different

categories—location,
permission to serve alcohol
and distance from landmarks
like airports.

By simply pointing out to
the location, users can rate
and review them. This means
that if you are in any city
and want to get a bit of
action—no more embarrasing
questions.

For people who have GPS
units, you don’t have to look
at the Web site. Custom
made maps with emphasis
on skin spots are on sale by
the Web site. Buy the
package for $29.95 (Rs 1,196)
and waltz across cities and
alleys fearlessly, homing in
with unerring accuracy. 

Catty Exercises

You have a cat, and you love
her to bits. You also swear

by yoga and think everyone
should do some asanas once in
a while. You pamper your cat
so much—it has become
overweight and lazy! If you are
worried that the cat could have
arthritis or bad liver, go over to
www.yogakitty.com and look
at the videos which shows you
how to do yoga with your cats.
Yes, you heard right! And no,
we are not delusional.

We haven’t watched all the
videos here (the connection
was really slow) but the titles
are sufficiently exotic—“Clearing
past karma”, “Electromagnetic
Frequency”, etc. 

PUBLICLY PRIVATE

Hole In
Space

MySpace is like a big
sieve where there
are no secrets, even

if you have used the
“private” setting. It thus
wasn’t a big surprise when
about 500,000 photos in
private areas were accessed
by hackers exploiting a
security hole in the
platform architecture. These
photos totalled about 17 GB
in size, and were one of the
most hotly downloaded
items on The Pirate Bay. At
one point, about 6,700
downloads were underway
at full speed, which tapered
off sharply as the comments
of the first downloaders
started trickling in.

Most of the people who
downloaded the private
photos were thinking of only
one thing: porn. They
assumed that because it was
MySpace, and because it was
private, those half a million
photos would be of girls in
various states of undress.
Sure beats having to pay
sites dollars for the daily
dose, right? Well not so fast,
buster. As the first
downloaders opened up the

files, expecting to see
something else, they were
greeted with images of
babies, weddings, fat ladies
pushing prams, people
toasting at parties or guys
wearing skirts and tops. The
comments in the forums
revealed quite a few gems.
One unlucky pirate
bemoaned that instead of
wasting bandwidth to
download 17 GB of baby
photos, he would have done
better to download the real
thing. Yet another stricken
soul pined for image (he
meant porn)
detection
software. The
third
commenter had
a you-gotta-lie-
in-the-bed-you-
made attitude:
his comment
was simplicity
personified—“If
people want to see
porn, they should
download porn”.

Even after
people were
warned that the
photos were not
as expected,
many
continued to
download
them. In this
context, it must
be mentioned

that this security hole had
remained unpatched in
MySpace for the last three
months. Many people who
continued to download
them regarded this as
cocking a snook at the site,
and also to scare other
people into thinking twice
before uploading personal
photos. In fact, with the
rash of hacker attacks
reported all over photo-
sharing sites—where
private or restricted photos
have been accessed by
outsiders—we have come to

this conclusion:
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Social Networking
Poke: This is a Facebook
trademark. A poke can mean
anything—a way to announce
your presence to friends,
reminding your partner how
much you miss their TLC, or just
another way of saying Hi!
Wall: This is Facebook’s
alternative to Orkut’s scrapbook
with the option to send only
text. This is however, not the
primary means of
communication. The default wall
is supplanted by applications
like FunWall, which is more
flexible in terms of usage.
Scrap: This is Orkut’s primary
method of communicating with
people. Members in Orkut,
have an area called scrapbook
where all the messages, which
they have received are seen.
You can send videos,
animations and pictures along
with plain text in scraps.
Hot list: A list of your special
friends in Orkut—this is for your
eyes only. A similar feature is the
crush list. However, if both the
persons have added each other
in their crush lists, they will get a
message that there is a match. 
Teaser: This is a private
message in Orkut, which only
the recipient will see. Teasers
are categorized into different
moods and can be customised
too, apart from the score that
is provided.
Tweet: In Twitter, your update is
called Tweet. It’s a short
message, with a maximum of
140 words.   
Nudge: This is a reminder
system in Twitter. If you are not
updating your Twitter, you might
receive a nudge from your
friends. Needless to say, there is
no restriction on when you can
nudge someone.
Usage: Within half an hour of
opening my account, I got three
pokes and seven wall messages.
Meanwhile, in Orkut my scraps
are touching 15,000 while
teasers and crush list matches
from my girlfriends are filling my
inbox. I have, however, yet to see
the benefits of Twitter—the
Tweets are too short, and I have
no friends to nudge. They don’t
seem to like Twitter!  

Wild Wild Web

n  New Jersey is first state that requires a background check for dating sites  n  Shakira is 9th fastest falling in search queries globally  n  YouTube blocked in Pakistan because of anti-Islam videos  n  Man jailed for 3 years for fake Facebook profile of Moroccan prince
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What does spitting in the
technology arena refer to?

(a) Sending VoIP spam
(b) Breaking down a firewall
(c) Bookmarking an article on

Digg.com
(d) Editing a Wikipedia entry

What is UMPC?
(a) Ultra Miniscule Personal

Computer
(b) Ultra Micro Personal Computer
(c) Ultra Mobile Personal Computer
(d) Ubiquitous Mode Per Channel

What is David Bradley
famous for?

(a) For starting Bradley Computers
(b) He started in the 70s sitcom

Brady Bunch
(c) He invented the transistor

(d) He invented the
[Ctrl]+[Alt]+[Delete]
combination

I am a former student of
Harvard Business School,

had a small bicycle business, then
introduced push button phones in
India. Today I head a major
telecom company in India. Who
am I?
(a) Ratan Tata
(b) Anil Ambani
(c) Kumarmangalam Birla
(d) Sunil Mittal

What does LG stand for?
(a) Luci Gudisheeni

(b) Lucky Getty
(c) Lucky Goldstar
(d) Left Gear

The kitchen computer is a
term hardly heard of these

days. What is it?
(a) You must be kidding. Why

would someone need a kitchen
computer   

(b) A PC placed in the kitchen is
called a kitchen computer

(c) There was in fact a kitchen
computer released by
Honeywell years ago to assist
women with recipes and other

gourmet activities.   
(d) Microsoft’s next venture into

the home business is the
kitchen computer.

What is the electric pencil?
(a) Similar to the stylus, just

that you write with a pencil
(b) Handwriting recognition

software
(c) First word processor
(d) Stationary company

Galvin Manufacturing
Corporation went on to sell

car radios. How do we know it
today?
(a) Dunlop (b) Goodyear
(c) Michelin   (d) Motorola

9

8

7

6

5

4

3

2

ACROSS
7. An integer’s property of being odd or even (6)
8. Characterized by slanting characters (6)
9. Readable and writable external storage medium (4)
10. Chatterbot predecessor (5)
11. American dance form is also a windows application
development system that uses predefined templates (5)
13. Storage device that holds incoming messages from the
Net (7)
16. Multiple----- - collection of information arranged for
processing by a program (7)
17. To go into partial deactivation to save power in
hardware technology (5)
20. 8th letter of the Greek alphabet (5)
21. To have a real-time conversation online (4)
22. To correct problems in hardware or software (6)
23. Representing data in continuously variable physical
quantities (5)

DOWN
1. Collection of information that is organised 
for it to be accessible and upgraded (8)
2. Collection of information stored on a computer (4)
3. Common units of computer storage from 
desktop computer to mainframe (5)
4. ‘D’ in DVD (7)
5. Side by side interface—used for connecting the printer
on a PC (8)
6. ---- Up—temporary connections between
machines over a telephone line using modems (4)
12. A pointer to a program or information file in
Windows (8)

14. Character that represents an action in computer
programming (8)
15. Ad serving program run by Google (7)
18.System for detecting the position and movement of a
remote object by radio waves reflected from its surface (5)
19. Sound emitted by the computer to indicate that
something requires the user’s attention (4)
21. Challenge-Handshake Authentication
Protocol(abbr) (4)

Crossword 

Got an
interesting
question? 
Send it in with
the answer to
TQ@thinkdigit.com
Mark “TQ” in the
subject area.

Time to think!
What does the SLOOP
project refer to?talk

about?
(a) Sloop? There is no such term 
(b) Steady Learning Over Obvious
Problems
(c) Scientific Lessons
On One Principle
(d) Sharing Learning
Objects in an Open
Perspective

1

The voice in the
famous AOL ad saying

“Hello! You’ve got mail”, is
that of Elwood Edwards, an
American voice-over actor who
has also dubbed for Simpsons,
also advertising for the movie
You’ve Got Mail.

Did You
Know?

Answers

1. d
2. a
3. c
4. d
5. d

6. c
7. c
8. c
9. d

Crossword by Nitta Jaggi

January’s Winner
Dushyanth R
Mysore, Karnataka

Send in your entries to
TQ@thinkdigit.com on
or by 20th of this
month. One lucky
participant 
will win 
3ds Max 9 Bible
By Kelly Murdock
Published by

Win!

February’s Solution
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Give Me My Space
I have had a lot of trouble over the past
few issues of Digit. My problem is that
your text and pictures are being placed
too close to the bound edges of the
magazine.

Please provide more of a gap at the
bound edges, because, since I have only
one hand, I find it difficult to read the
magazine. I hope you will consider my
request and implement this soon.

Raghu GS
Bengaluru

Wow, it’s heartening to see that your disability
has not stopped your passion for technology, or
for Digit. We have forwarded this mail to our
designers and they promise to look into the
matter, and stop trying to pack in too much
content into the bound edges. 

Team Digit

Slow Track?
I have been a long-time reader of your
magazine, through all its name changes,
:). I find Digit extremely interesting and
useful, but this is the first time I am
writing to you. Perhaps this is because I
have two small requests.

1) Please add the latest version of
OpenOffice.org as soon as possible.

2) Please include the previous
month’s Fast Track book in PDF version
on the discs. 

I would be especially grateful for the
second request, because I am tired of my
friends “borrowing” the Fast Track books,
and then never getting it back.

Adding the PDF to the subsequent
month’s DVD will prevent me from
having to chase it around my city all
month while it’s out on its “walk”.

I can’t wait till your December or
June issues to get my hands on the PDF
versions.

Sandeep M

Well Sandeep, we’re sorry to tell you that not
only are you doing yourself a great injustice,
but us as well. You should consider forcing the
subscription form on to your friends, and
insisting that they subscribe to Digit.

Not only will this safeguard your copy of
Digit and Fast Track, it will also be good for all
your friends and us as well.

As for the Fast Tracks in PDF format, we’ll
see what we can do. Though you have to admit
that adding the Fast Tracks in PDF to our
special issues does make them worth the wait.

Team Digit

Inbox

Rich Man’s Mag?
I am a Subscriber of Digit—my
technology navigator. I am from a lower
middle class family, and like everyone
else I have some wishes to fulfil in my
life—one of them is to own a computer. 

The reason I’m writing this letter is
to tell you that you’re a “rich person’s”
magazine. You have no products for
customers like myself. I would love it if
you reviewed CRTs or 17-inch LCDs, a
budget 160 GB hard disk, low priced
speakers (Rs 500 to 1,000), etc.

I know you cannot test everything
that exists in the Indian markets, but
once in a while why not test budget
phones and the like, to tell us what to
buy. Aren’t the Nokia 1112, 5070, 6070,
6030, etc., considered to be good phones?
I know you have limited pages, but
perhaps you can test them for us and tell
us which budget products we can buy. 

I’d like to be able to buy a budget
computer, and do not need a quad-core
gaming rig. So what about readers like
myself?

I don’t know if you will read this
letter or not, but I still would like to
thank you for a great magazine.

Antu Kanta
Durgapur, West Bengal

I rarely answer letters in this space, but I was
moved by your letter. We want you to go out
and buy a computer, and we thought the best
way to inform you of what to buy would be to
base my column on this very topic. The team
also promises to try as hard as they can to get,
test and include products for all budgets. 

All I can do is promise that I will keep my
eyes open on shopping trips, and see if I can
spot deals in the budget categories. Keep
writing in and send us more suggestions, we
love to help whenever we can.

Agent 001

Unhappy Feet
I think Digit feels that we’re all
penguins—experts at Linux. Although
Linux is my passion, and I enjoy using
the Open SuSE 10.3 that you gave me, I
am disappointed with the Linux content
on the DVDs. Yes, it’s true that your
DVDs have the best content, the Linux
content is all provided as tarballs. Not all
of us can compile from source. I know
the basic commands, such as
“./configure”, “make”, and “make
install”, but many software require
special libraries to work. I wish you guys
would look at the requirements and
provide those libraries as well. At least
provide the software manuals, or give us
RPM packages.

Also, you give us Avast! Home Edition
and it’s update every month, but I feel
that it’s not the best free anti-virus. I
think Avira and AVG are much better,
and you don’t even give us the virus
definitions for them. Please provide us
with updates for the same every month.

Still, thanks for providing us with
such a variety of software. I would also
like to thank you for switching me over to
open source. Although I do have a pirated
copy of Windows as dual-boot, I’m trying
to do everything possible on Linux. I hope
Microsoft will forgive me because I am a
student and I’m poor, but I promise to
either switch over to Linux completely, or
buy Windows with my first salary.

Aswin Babu K
Alapuzha, Kerala

We hope Microsoft will forgive you too! We will
also try and provide you with executables and
RPMs instead of tarballs, which we give so that
any users of any Linux distro can compile from
source. We’re very glad that you’re choosing
open source over piracy, and hope that more
people will continue to do so. Keep writing in,
and let us know whether you finally make the
switch or when you buy Windows.

Team Digit

Confessions Of A Serial Reader
When I first got your magazine, I
committed the blunder of trying to
compare it to the others. After a few
months of buying them, all I realised
was that none of them could beat Digit. I
was born into a middleclass family, and
no one but me has an IT background. I
used to work for a hardware vendor, so I
picked up a lot on the job. Now, I’m in
the music business, but I still use Digit to

stay in touch and keep my passion alive.
I would suggest that you keep up the
good work and add more tutorials and
articles about computer education,
instead of just product-specific articles. I
hope you will forgive my earlier blunder
of buying other magazines, and accept
me as a member of the Digit family.

Vasanth Kumar Jagan Mohan
MD, SA Musicals

We’re actually glad you bought those “other”
magazines. It’s good that you got a first hand
look at them and chose us for being better.
Unlike jealous spouses, or significant others,
we’re always forgiving and welcome you back
with open arms. 

Team Digit

BOO!
My brother has been a “die hard” fan
since 2000—when Digit was called Chip,
and I was in class two. Now I’m in class
10, and we’re both fans. This time we
actually got your magazine five days
earlier than usual, thanks for that. I was
terribly disappointed by your mobile
phone reviews. I wish you would have
compared them the way you normally
do, because all the phones seemed to get
ratings of 3 or 4. How are we supposed to
tell which ones to buy? I would have
preferred a comparison test.

Still, I have to admit that you have
helped me learn technology, and I am
considered a “tech consultant” in class. I
also liked the article Settling Differences,
about which is more secure, Linux or
Windows!

Akash Agrahari
Lucknow

We’re glad that you’ve followed in your
brother’s footsteps, and we hope you’ll
continue to do so. The reason why we did
individual reviews for the mobile phones was
to bring out finer aspects of all the mobiles.
Unlike graphics cards, hard drives, CPUs and
the like, it’s a lot harder for us to tell you what
to like or hate about a phone. We’d rather give
each one its due and let you, and all our
readers, decide on what best suits their needs.
Of course, we also thought about people like
you who wanted to compare the phones and
wanted detailed scores and feature lists, and
provided you with the tables at the end of the
article. We’re not going to kid ourselves and
imagine that we can please you all, but you
can rest assured that we’ll keep your
suggestions in mind for the next test. 

Team Digit

Write to the Editor
E-mail: editor@thinkdigit.com

Snail Mail: The Editor, Digit, KPT House, Plot 41/13, Sector 30, 
Vashi, Navi Mumbai 400 703

Digit will publish the best letters on these pages. Letters may be edited for clarity.
PPlleeaassee iinncclluuddee yyoouurr ccoommpplleettee aaddddrreessss iinn aallll ccoommmmuunniiccaattiioonn.. 

For subscription queries 
send an e-mail to help@thinkdigit.com
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I Want More
I am a regular reader of Digit since
August 2003, and I haven’t missed a
single issue since. This magazine is
simply mind blowing. I keep reading
all my magazines throughout the
month, and this helps me keep
updating my tech knowledge.
Although I am very happy with Digit, I
still have some suggestions:

1) Please increase the size of the
Tips & Tricks section.

2) Please add more about Vista,
Linux and the latest hardware.

3) Don’t give us those old movies
in the entertainment section.

4) Provide the latest games, movies
and wallpapers in every issue.

5) A Fast Track to DirectX 10.
6) Give us more information on

Web sites and freeware.
I hope you will consider my

suggestions.
Imran

Kashmir

Hmm, so let us get this straight. Basically,
you want more Tips & Tricks, more Vista,
More Linux, more... well... Digit!

Although we all wish we could double
the size of the content on a regular basis,
we’re all quite afraid that our families will
disown us, our employees will drop of
exhaustion, or worse, quit!

Jokes apart, we can understand your
point of view, and will try and provide you
with the overdose of information that you
seek. Of course, we have to keep our costs
and our health in mind, so all we can
promise to do is try our best. 

Team Digit

I Want My Big Mac?
I am a fan, and read your magazine
faithfully. I loved the article Settling
Differences, but I feel you should have
included Mac from the security angle.
Since the Mac is quite a mystery to us
PC users, a little information in that
regards would have been useful. Please
also add more articles about Linux. 

Manish Sharma

The article focussed on Linux and Windows
mainly because pretty much every desktop
in the world runs either a Unix-based OS or
Windows. Apple’s OS is based on BSD, which
is another Unix-based OS. But yes, we will
try and include  more Mac-centric content.

Team Digit

No, No, NO! Oh Fine...
I’m writing to you after a
long time. I used to buy a
lot of IT magazines, but
now I only buy Digit.
However, you guys have
to make certain
improvements. The disc
packaging is getting
worse. This month’s DVD
and CD refuse to sit in place
because of the poor jewel case. I have
also been getting DVDs with a few
corrupted files on a more regular
basis, and the Entertainment DVD of
your anniversary issue did not run at
all. I expect better from India’s No. 1
magazine! Also, you said you’d provide
the missing Google Fast Track on the
following DVD, but the DVD-Guy
forgot—please add it when you can.

As for the Fast Track, you need to
take it to the next level, and add topics
such as Adobe Flash, Programming,
Dreamweaver, etc.

Of course, only criticism and no
praise is not fair, so I should tell you
that your disk interface is the best of
all the magazines. The other
magazine’s discs do not run on my old
computer, but your disc runs
perfectly—it’s good that you went for
usability and not fancy, irritating and
heavy interfaces. When I return to my
village, where I have 128 MB RAM
machines, I don’t even bother carrying
anything but Digit’s discs with me.
Please start adding movie trailers
again, I loved those.

Also, one of my friends is following
your advice in the Tech Careers section,
and is doing well. I thank you on his
behalf. Please continue to be our
technology navigators! I would write
more, but both you and I do not have
such luxuries with time...

Inderdeep S

Wow Inderdeep, you’ve really taken the time
to send a feedback letter. We’ll look into the
DVD jewel case matter, though sometimes a
handful might be damaged during packaging
and transport. We request you and all our
readers to write to help@thinkdigit.com to
get free replacements for damaged DVDs.

Yes, apparently the “DVD-guy” fell
asleep again, and forgot the Fast Track to
Google PDF again. Seriously though, he was
on leave and the rest of us are to blame for
that. We’ll include it as soon as possible. 

Thanks for appreciating everything else,
and please keep writing in and giving us your
valuable suggestions.

Team Digit
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of the
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People And Events That Grabbed The Headlines—For Better Or For Worse

We have featured a
clutch of celebs in
these pages who are

technophiles at heart. The
latest to join the list is Robin
Williams, the funny man and
sensitive actor.

Robin Williams discovered
the Internet after giving up
addictions like drugs and
partying. Once he was hooked
and logged on, there was no
prying the man away from the
computer. Things had come to
such a pass that he would not
stay in a hotel without a Net
connection. Besides being
active on chat rooms—where
he was once accused of
impersonating an 8 year old
girl—he is an avid gamer.

His favourite genre is first
person shooters, and gets his
kicks playing online against
other players. Half-life and
Warcraft 3 are what he
nominates as his favourites,
though he is game for other
titles too. Williams is

fascinated by the clans and
myths and guilds that are the
heart of modern day games,
especially MMORPG and, for a
newbie and a guy on the wrong
side of 50, picks up stuff pretty
well. In fact, his analysis on
how mods make a good game
greater, as well as how
modding evolved, is as good as
that coming from a hardcore
gamer. Way to go, Robin.  

Apart from online gaming
and chatting, William’s other
online activities include
trawling the auction sites for
kicks and checking on game
sites. Curiously, like most of
the rest of the world he does
not check himself out, even
though there are fan sites
devoted exclusively to him.

We think he is adopting a
wise course, as the Internet is
a free-for-all field, and
anybody can speak their
mind. No sense getting upset
about stuff that you can’t
control, right?

Director Terry Gilliam is trying to proceed with the production
of The Imaginarium of Doctor Parnassus, which actor Heath Ledger
was part of, before his death on January 22 this year due to

drug overdose. The movie is reportedly an American fantasy-
adventure film. Prior to suspending the production of the movie,
Christopher Stoner and Tom Waits were co-starring with Ledger in a
story about the leader of a travelling theatre troupe, who through a
deal with the Devil, takes audience members through a magical
mirror to explore their imaginations.

Ledger’s untimely death in January led Gilliam to suspend the
production. To his benefit, Ledger’s role is based in the magical world,
and so he plans to turn Ledger’s character “Tony” into other
characters to be played by Johnny Depp, Jude Law and Collin Farrell.
Gilliam plans to use computer graphics imagery for this.

Unfortunately, the production of Michelle Williams’ starrer
Mammoth had to be put on hold following her grief. Surprising as it
may sound, technology advancement has led to the dead continuing
to work, while those still alive, take a break to mourn!

No matter how much we
try not to be prophets of
doom and leave a bad

taste in your mouths, in the
interests of truth we have to spill
the bad news. Folks, when you
have a broken computer take
care to save the data that is on
your hard drive. If the hard drive
is broken, have the computer
guy make a house call. But on no
account let the hard drive out of
sight. Or else….oh well, read on.

Edison Chen, who had acted
in The Infernal Affairs, the racy
Hong Kong cop drama later
remade as the Oscar winning The
Departed had problems with his
customised MacBook and had to
drop it off at a computer repair
shop. Nothing out of the
ordinary. What was out of the
ordinary was the data stored in
the hard drive—his “personal”
pr0n collection! The number of
pictures was 1300, and all were
pictures of various stars in the

Hong Kong entertainment
industry in “compromising”
situations. Since this is Tabloid
Tech lets be blunt: they were all
photographed having sex with
Chen. In his defense, he says the
photographs were not taken
without permission, but we’re
guessing that he did not intend
them for public distribution.

However, thanks to his
indiscreetness and carelessness
all these photos are now stored in
multiple servers, downloaded by
thousands of people and
virtually impossible to stamp out.
The actor made the mandatory
apology to all his co-stars and has
resolved to quit the Hong Kong
movie scene, introspect on the
mess he created and go
underground for some time. As
for the actresses who found
themselves unwittingly exposed
for no fault of theirs, they are all
keeping a low profile and hoping
the storm will blow over.

Crashed Career

Good Will Gaming

122 DIGIT MARCH 2008

Heath Ledger Movie To Be Salvaged

Tabloid tech_mar_08.qxd  5/13/2008  11:11 AM  Page 122




